
SIPROTEC 5
Operation

V9.50 and higher

Manual

C53000-G5040-C003-L

Preface

Table of Contents

First Steps 1
Expanding Devices 2
Fitting the Devices 3
Handling of Plug-In Modules 4
Using On-Site Operation Panel 5
Using DIGSI 5 6
Operation Using a Browser-Based User
Interface 7
Operation in the Operating State 8
Commissioning 9
Maintenance, On-the-Spot Assistance and
Test 10
Security Settings in the Device 11
Literature

Glossary

Index



ii NOTE
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Preface

Purpose of the Manual
This manual describes the operation of the device and gives information about safety, commissioning and
operation as well as checks and tests.

Target Audience
Protection system engineers, commissioning engineers, persons entrusted with the setting, testing and
maintenance of automation, selective protection and control equipment, and operational crew in electrical
installations and power plants.

Scope
This manual applies to the SIPROTEC 5 device family.

Further Documentation

[dw_product-overview_SIP5_operating-manual, 5, en_US]
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[dw_product-overview_SIP5_compact-hardware, 1, en_US]

• Device manuals
Each Device manual describes the functions and applications of a specific SIPROTEC 5 device. The printed
manual and the online help for the device have the same informational structure.

• Hardware manual
The Hardware manual describes the hardware building blocks and device combinations of the SIPROTEC 5
device family.

• Operating manual
The Operating manual describes the basic principles and procedures for operating and assembling the
devices of the SIPROTEC 5 range.

• Communication protocol manual
The Communication protocol manual contains a description of the protocols for communication within
the SIPROTEC 5 device family and to higher-level network control centers.

• Security manual
The Security manual describes the security features of the SIPROTEC 5 devices and DIGSI 5.

• Process bus manual
The process bus manual describes the functions and applications specific for process bus in SIPROTEC 5.

• Product information
The Product information includes general information about device installation, technical data, limiting
values for input and output modules, and conditions when preparing for operation. This document is
provided with each SIPROTEC 5 device.

• Engineering Guide
The Engineering Guide describes the essential steps when engineering with DIGSI 5. In addition, the
Engineering Guide shows you how to load a planned configuration to a SIPROTEC 5 device and update
the functionality of the SIPROTEC 5 device.
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• DIGSI 5 online help
The DIGSI 5 online help contains a help package for DIGSI 5 and CFC.
The help package for DIGSI 5 includes a description of the basic operation of software, the DIGSI princi-
ples and editors. The help package for CFC includes an introduction to CFC programming, basic examples
of working with CFC, and a reference chapter with all the CFC blocks available for the SIPROTEC 5 range.

• SIPROTEC 5/DIGSI 5 Tutorial
The tutorial on the DVD contains brief information about important product features, more detailed
information about the individual technical areas, as well as operating sequences with tasks based on
practical operation and a brief explanation.

• SIPROTEC 5 catalog
The SIPROTEC 5 catalog describes the system features and the devices of SIPROTEC 5.

Indication of Conformity

This product complies with the directive of the Council of the European Commun-
ities on harmonization of the laws of the Member States concerning electromag-
netic compatibility (EMC Directive 2014/30/EU), restriction on usage of hazardous
substances in electrical and electronic equipment (RoHS Directive 2011/65/EU), and
electrical equipment for use within specified voltage limits (Low Voltage Directive
2014/35/EU).
This conformity has been proved by tests performed according to the Council Directive
in accordance with the product standard EN 60255-26 (for EMC directive), the standard
EN IEC 63000 (for RoHS directive), and with the product standard EN 60255-27 (for
Low Voltage Directive) by Siemens.
The device is designed and manufactured for application in an industrial environment.
The product conforms with the international standards of IEC 60255 and the German
standard VDE 0435.

Standards
IEEE Std C 37.90
The technical data of the product is approved in accordance with UL.
For more information about the UL database, see ul.com
You can find the product with the UL File Number E194016.

IND. CONT. EQ.
69CA

Additional Support
For questions about the system, contact your Siemens sales partner.

Customer Support Center
Our Customer Support Center provides a 24-hour service.
Siemens AG
Smart Infrastructure – Protection Automation Tel.: +49 911 2155 4466
Customer Support Center E-Mail: energy.automation@siemens.com

Training Courses
Inquiries regarding individual training courses should be addressed to our Training Center:
Siemens AG
Siemens Power Academy TD Phone: +49 911 9582 7100
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Humboldtstraße 59 E-mail: poweracademy@siemens.com
90459 Nuremberg Internet: www.siemens.com/poweracademy
Germany

Notes on Safety
This document is not a complete index of all safety measures required for operation of the equipment (module
or device). However, it comprises important information that must be followed for personal safety, as well
as to avoid material damage. Information is highlighted and illustrated as follows according to the degree of
danger:

! DANGER
DANGER means that death or severe injury will result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! WARNING
WARNING means that death or severe injury may result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! CAUTION
CAUTION means that medium-severe or slight injuries can occur if the specified measures are not taken.

² Comply with all instructions, in order to avoid moderate or minor injuries.

NOTICE
NOTICE means that property damage can result if the measures specified are not taken.

² Comply with all instructions, in order to avoid property damage.

ii NOTE
Important information about the product, product handling or a certain section of the documentation
which must be given attention.

Qualified Electrical Engineering Personnel
Only qualified electrical engineering personnel may commission and operate the equipment (module, device)
described in this document. Qualified electrical engineering personnel in the sense of this document are
people who can demonstrate technical qualifications as electrical technicians. These persons may commission,
isolate, ground and label devices, systems and circuits according to the standards of safety engineering.

Proper Use
The equipment (device, module) may be used only for such applications as set out in the catalogs and the
technical description, and only in combination with third-party equipment recommended and approved by
Siemens.
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Problem-free and safe operation of the product depends on the following:

• Proper transport

• Proper storage, setup and installation

• Proper operation and maintenance
When electrical equipment is operated, hazardous voltages are inevitably present in certain parts. If proper
action is not taken, death, severe injury or property damage can result:

• The equipment must be grounded at the grounding terminal before any connections are made.

• All circuit components connected to the power supply may be subject to dangerous voltage.

• Hazardous voltages may be present in equipment even after the supply voltage has been disconnected
(capacitors can still be charged).

• Operation of equipment with exposed current-transformer circuits is prohibited. Before disconnecting the
equipment, ensure that the current-transformer circuits are short-circuited.

• The limiting values stated in the document must not be exceeded. This must also be considered during
testing and commissioning.

Selection of Used Symbols on the Device

No. Symbol Description

1 Direct current, IEC 60417, 5031

2 Alternating current, IEC 60417, 5032

3 Direct and alternating current, IEC 60417, 5033

4 Earth (ground) terminal, IEC 60417, 5017

5 Protective conductor terminal, IEC 60417, 5019

6 Caution, risk of electric shock

7 Caution, risk of danger, ISO 7000, 0434

8 Protective insulation, IEC 60417, 5172, safety class II devices

9 Guideline 2002/96/EC for electrical and electronic devices

10 Guideline for the Eurasian market

11 Mandatory conformity mark for electronics and electrotechnical products in Morocco

OpenSSL
This product includes software developed by the OpenSSL Project for use in OpenSSL Toolkit (http://
www.openssl.org/).
This product includes software written by Tim Hudson (tjh@cryptsoft.com).
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
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Unpacking, Repacking, Returning and Storing
Unpacking a Device

ii NOTE
Devices are tested prior to delivery. The test certificate is a component of the devices and can be called up
with DIGSI.
Devices are packed on site in a way that meets the requirements of standard ISO 2248.

² Check the packaging for external transport damage. Damaged packaging may indicate that the devices
inside have also sustained damage.

² Unpack devices carefully; do not use force.

² Check the devices via an incoming goods inspection to ensure they are in perfect mechanical condition.

² Check the enclosed accessories against the delivery note to make sure everything is complete.

² Keep the packaging in case the devices must be stored or transported elsewhere.

² Return damaged devices to the manufacturer, stating the defect. Use the original packaging or transport
packaging that meets the requirements of ISO standard 2248.

Repacking a Device

² If you store devices after reception control, they must be packed in appropriate storage packaging.

² If the device is to be transported, pack it in transport packaging.

² Enclose the accessories supplied and the test certificate in the package with the device.

Returning a Device

² Return devices to the manufacturer, stating the defect.

² Use the original packaging or transport packaging that meets the requirements of ISO standard 2248.

² Send damaged devices to the following address:
Siemens AG
EM DG EA-MF Returns
Rohrdamm 7
13629 Berlin
Germany

² Ensure that the devices are either shipped with the original current and voltage terminals or, alternatively
- if the wired terminals are to remain in the system - with the designated transport safety devices.

ii NOTE
If there are green single-row voltage terminals, it is irrelevant in terms of transport whether or not they are
plugged in. They do not require any alternative transport safety device.

² Protect the optical interfaces on the communication or arc protection modules against the intrusion of
dust.

² Use, for example, the protective covers provided in the delivery condition.

Storing a Device

² Only store devices on which you have carried out an incoming inspection, This action ensures that the
warranty remains valid. The incoming inspection is described in the operating manual.

1.1

First Steps
1.1 Unpacking, Repacking, Returning and Storing
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ii NOTE
SIPROTEC devices must be stored in rooms that are clean and dry. Devices or associated replacement
modules must be stored at a temperature range of -25 °C to +55 °C.
The relative humidity must be at a level where condensed water and ice are prevented from forming.

Siemens recommends that you observe a restricted storage temperature range of +10 °C to +35 °C, in order to
prevent the electrolytic capacitors used in the power supply from aging prematurely.
If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2 days. This
action will cause the electrolytic capacitors to reform on the printed circuit board assemblies again.
If devices are to be shipped elsewhere, you can reuse the transport packaging. When using different pack-
aging, you must ensure that the transport requirements according to ISO 2248 are adhered to. The storage
packing of the individual devices is not adequate for transport purposes.
The lithium batteries contained in SIPROTEC devices meet all international requirements of the hazardous
goods specifications for the various carriers (Special Provision 188 of the UN Recommendations on the
Transport of Dangerous Goods, Special Provision A45 of the IATA Dangerous Goods Regulations, and the ICAO
Technical Instructions). This action only applies to the original battery or genuine replacement batteries.

Battery disposal

NOTICE
Exercise caution when replacing the battery
Noncompliance with the specified measures means that material damage can occur.

² Batteries may only be replaced by ones of the same type or by batteries of another type recommended
by the manufacturer. Replacing with the wrong type can cause an explosion hazard. Comply with the
relevant national/international waste disposal regulations when disposing of batteries.

² Only have the lithium battery in the device replaced by skilled personnel.

ii NOTE
Only use an insulated tool for opening and closing the battery cover, as well as for removing and inserting
the battery.

² Only replace the battery with VARTA or Panasonic CR 2032 or BR 2032 batteries. If you use a different
type of battery, this can cause a fire or explosion hazard. Observe the safety notes in the manual.

! CAUTION
Caution against chemical reaction
Noncompliance with the safety notes can result in minor to medium injuries.

² The battery used in the device may cause fire or chemical burns if handled improperly. Do not
recharge it, take it apart, or subject it to a temperature in excess of 100 °C.

² Replace dead batteries immediately and keep them out of reach of children.

First Steps
1.1 Unpacking, Repacking, Returning and Storing
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Environmental Protection Hints
Disposal of Old Equipment and Batteries (Applicable only for European Union and Countries with a Recycling
System)

The disposal of our products and possible recycling of their components after decommissioning has to be
carried out by an accredited recycling company, or the products/components must be taken to applicable
collection points. Such disposal activities must comply with all local laws, guidelines and environmental
specifications of the country in which the disposal is done. For the European Union the sustainable disposal of
electronic scrap is defined in the respective regulation for "waste electrical and electronic equipment" (WEEE).

The crossed-out wheelie bin on the products, packaging and/or accompanying documents means
that used electrical and electronic products and batteries must not be mixed with normal house-
hold waste.
According to national legislation, penalties may be charged for incorrect disposal of such
waste.

By disposing of these products correctly you will help to save valuable resources and prevent any potential
negative effects on human health and the environment.

ii NOTE
Our products and batteries must not be disposed of as household waste. For disposing batteries it is
necessary to observe the local national/international directives.

Disposal of Mobile Storage Devices (e.g. USB Sticks and Memory Cards)
When disposing of/transferring mobile storage devices, using the format or delete functions only changes the
file management information and does not completely delete the data from your mobile storage device. When
disposing of or transferring a mobile storage device, Siemens strongly recommends physically destroying it
or completely deleting data from the mobile storage device by using a commercially available computer data
erasing software.

REACH/RoHS Declaration
You can find our current REACH/RoHS declarations at:
https://www.siemens.com/global/en/home/products/energy/ecotransparency/ecotransparency-down-
loads.html

ii NOTE
You can find more information about activities and programs to protect the climate at the EcoTransparency
website:
https://www.siemens.com/global/en/home/products/energy/ecotransparency.html

1.2

First Steps
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Incoming Inspection
Siemens recommends that you check devices which are not assembled.

Safety Notes

! DANGER
Danger during incoming inspection
Noncompliance with the safety notes, can result in death, severe injury or considerable material
damage.

² Comply with all given safety notes when carrying out the incoming inspection.

² Please note that hazardous voltages are present when you perform the incoming inspection.

² If you identify a defect during the incoming inspection, do not rectify it yourself. Repack the device and
return it to the manufacturer, stating the defect. Use the original packaging or transport packaging that
meets the requirements of standard ISO 2248.

Performing a Follow-Up Inspection on a Device

² Visually check for external damage as soon as you have unpacked the devices; they must not show any
signs of dents or cracks.

Checking the Rated Data and Functions

² Check the rated data and functions using the complete order designation/the product code. The device
manual contains all technical data and a description of the functions.

² Check the information provided on the rating plate too. The device features a product label sticker, which
contains the Technical data.

² Make sure that the rated data of the device properly matches the power-system data. You can find the
necessary information in the device manual.

1.3

First Steps
1.3 Incoming Inspection

SIPROTEC 5, Operation, Manual 19
C53000-G5040-C003-L, Edition 03.2023



Electrical Inspection
Device Protection

! DANGER
Danger when connecting the SIPROTEC 5 device
Noncompliance with the safety notes will result in death, severe injury, or considerable material
damage.

² The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This prevents condensed water from forming in the device.

² If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to
2 days. This will cause the electrolytic capacitors to form on the printed circuit board assemblies again.

² Perform the electrical inspection.

Activating the Battery

ii NOTE
Note the following with SIPROTEC 5 devices:
The battery is covered by a protective film, which also prevents premature discharge.
The battery compartment is located on the rear of the base module. You do not have to take the battery
out of the battery compartment in order to remove the protective film.

ii NOTE
Note the following with SIPROTEC 5 Compact devices:
The battery is covered by a protective film, which also prevents premature discharge.
The battery compartment is on the underside of the device. Take the battery out of the battery compart-
ment to remove the protective film. Do not pull the insulating film out when the battery slide is closed, as
this may damage the contacts in the battery holder.

ii NOTE
Use only insulated tools to open and close the battery cover and to remove and insert the battery.

Activate the battery for SIPROTEC 5 devices as follows:
² Pull out the battery compartment including the battery.

² Remove the protective film from the battery by simply pulling on the film tab.

² Push the battery compartment including the battery back in again.
Activate the battery for SIPROTEC 5 Compact devices as follows:
² Open the battery compartment on the bottom of the device.

² Fix the insulated tool in the film tab area. Push the battery out using the tool.

² Remove the protective film.

² Reinsert the battery.

² Close the battery compartment on the bottom of the device.

1.4

First Steps
1.4 Electrical Inspection
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Grounding a Device
All SIPROTEC 5 devices, including SIPROTEC 5 Compact devices, are protection class I equipment and must be
connected to the system ground prior to commissioning.
² Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (≥ 0.0062

in2), grounding area ≥ M4, torque: at least 1.2 Nm).

² In order to ensure the electromagnetic compatibility (EMC) of the device, connect the protective
grounding terminals of the modules to each other in series connection. Use the double protective
grounding terminals of the individual modules for this purpose.

² Connect the protective conductor of the protection device (connected modules) to the protective
grounding terminal of the installation (for example control cabinet) with a single connection to the
base module of the protection device.

Connecting a Device

² Connect all cables and lines. Use the connection diagrams in the Hardware Manual and Device Manual.

² Tighten the terminal screws to the prescribed torques.

Grounding an On-Site Operation Panel

² Join several on-site operation panels to one another with firm contact.
Siemens recommends the use of contact washers on painted metal mounting walls. If the mounting wall
is not metallic, place a metal layer, for example a layer of sheet metal, between the mounting wall and
the on-site operation panels. Then connect this sheet-metal layer to the system grounding.

Safety Notes

! DANGER
Danger during electrical inspection
Noncompliance with the safety notes will result in death, severe injury, or considerable material
damage.

² Comply with all given safety notes when carrying out the electrical inspection.

² Note that hazardous voltages are present when you perform the electrical inspection.

² During the electrical inspection, check that the device becomes ready for operation once it has been
connected to the power supply.

Performing the Electrical Inspection

² Connect the power supply.

² Activate the power supply.
After (initial) activation, there is no Device Configuration File (DCF) in the device and the device is in
fallback mode. The green and red LEDs light in fallback mode.

² Once you have loaded the DCF file into the SIPROTEC 5 device, the green RUN LED lights up continuously
and the device is ready for operation.

² If the device does not assume the normal operating state (process mode), switch off the power supply.
Disconnect the wiring and the grounding.

² Pack this device and return it to the manufacturer, stating the defect. Use transport packaging that meets
the requirements of standard ISO 2248.

First Steps
1.4 Electrical Inspection
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Flush-Mounting Devices

Basic Rules for Expanding Modular SIPROTEC 5 Devices

ii NOTE
Prepare the following tools for the device expansion:

• Phillips screwdriver size PZ1 and PZ2

• Screwdriver DIN 4 x 0.8

• During assembly, use the prescribed torques

Comply with the following basic rules when extending devices:
² Always fit the base module on the left in the 1st device row.

² Always fit the expansion modules from left to right.

² Always fit the expansion module with the key switches as the 1st module next to the base module.

² Always fit the expansion modules without LEDs last.

² Always install a power supply module PS203 on the left as the first unit in the 2nd device row.

² Note that the PS203 must always have the same rated voltage as the base module.

² In the 2nd device row, mount only input and output modules without light-emitting diodes

² Always mount the redundant PS204 power supply module at the position furthest to the right in the
corresponding row when you're looking at it from the front. If a CB202 printed circuit board assembly is
present in the row, the CB202 printed circuit board assembly must always be mounted to the right of the
PS204 printed circuit board assembly (at the outermost position).

² Note that the PS204 printed circuit board assembly must always have the same rated voltage as the base
module.

2.1

2.1.1

Expanding Devices
2.1 Flush-Mounting Devices
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Figure 2-1 Device Row of a Flush-Mounting Device

Expanding 1st Device Row

Preparation

ii NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the
corresponding extension in the Hardware and Protocols Editor.
Carry out the steps described in this chapter if you wish to expand an installed device later on with
expansion modules.

² Shut down the device.

² Use the screwdriver to carefully bend the left and right spring clips on the rear plate terminals outwards.

² Completely detach the wired current and voltage terminal blocks from the device.

² Remove all communication lines.

² Remove the plastic screw covers.

² Remove the device.

² Expand the cut-out in the control cabinet.

² Then continue with assembly.

Assembling the Devices

² Remove the bus cover from the extreme right-hand module of the device to be expanded.

2.1.2

Expanding Devices
2.1 Flush-Mounting Devices
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² Remove the plastic screw covers from the expansion module.

² Remove the right sealing strips from the base device.

² Place the expansion module on the right next to the device. Insert the 2 hinged angle clips of the
expansion module in the cut-outs of the device.

² Slip ring the expansion module in the direction of the device so that the bottom snap-in spring engages.

² Bolt the 2 on-site operation panels of the module to one another through the contact tab.

² Check that the bus connection is screwed on at the extreme right of the expansion module.

Installation and Commissioning

² Reinstall the device.

² Reinstall the plastic screw covers.

² Refasten the terminal blocks and the necessary communication lines.

² Connect the current and voltage blocks of the expansion module.

² Connect any available plug-in modules.

² Use the supplied grounding cable to connect the expansion module with the device and reconnect the
device to service ground.

² Extend the device configuration in DIGSI and load this configuration to the device.

² Resume operation of the device.

Expanding Devices
2.1 Flush-Mounting Devices
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Surface-Mounted Devices with Integrated On-Site Operation Panel

Basic Rules for Expanding Modular SIPROTEC 5 Devices

ii NOTE
Prepare the following tools for the device expansion:

• Phillips screwdriver size PZ1 and PZ2

• Screwdriver DIN 4 x 0.8

• During assembly, use the prescribed torques

Comply with the following basic rules when extending devices:

• Always fit the base module on the right in the 1st device row.

• Always fit the expansion modules from right to left.

• Always fit the on-site operation panel of the base module on the left.

• Always fit the on-site operation panels of the expansion modules from left to right.

• Always fit the on-site operation panel of the expansion module with the key switches in the 1st place
next to the on-site operation panel of the base module.

• Always fit the on-site operation panels without LEDs last.

• Join the on-site operation panels to one another with 2 mounting brackets.

• Always install a power-supply module PS203 on the right as the first unit in the 2nd device row.

• Note that the PS203 must always have the same rated voltage as the base module.

• Always mount the redundant PS204 power supply module at the position furthest to the right in the
corresponding row when you're looking at it from the front. If a CB202 printed circuit board assembly is
present in the row, the CB202 printed circuit board assembly must always be mounted to the right of the
PS204 printed circuit board assembly (at the outermost position).

• Note that the PS204 printed circuit board assembly must always have the same rated voltage as the base
module.

• In the 2nd device row, you do not need any on-site operation panels, mounting brackets, or distance
frames.

ii NOTE
When expanding a device in the 1st device row, order 2 mounting brackets that match the width of the
expanded device.

2.2

2.2.1

Expanding Devices
2.2 Surface-Mounted Devices with Integrated On-Site Operation Panel
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Figure 2-2 Device Row

(1) Distance frame
(2) Mounting bracket
(3) Distance frame on base module rotated by 180o

Expanding 1st Device Row

Preparation

ii NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the
corresponding extension in the Hardware and Protocols Editor.
Carry out the steps described in this chapter if you wish to expand an installed device later on with
expansion modules.

² Shut down the device.

² Detach all on-site operation panels from the distance frames.

² Remove the mounting brackets.

ii NOTE
If the device is an expanded device, then detach the 2 mounting brackets. You must replace these
mounting brackets with 2 new mounting brackets that match the width of the device.

² Use a screwdriver to carefully bend the left and right spring clips on the terminals outwards.

² Completely detach the wired current and voltage terminal blocks from the device.

² Remove all communication lines.

2.2.2

Expanding Devices
2.2 Surface-Mounted Devices with Integrated On-Site Operation Panel
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² Remove the device completely.

Assembling the On-Site Operation Panel into One Block

[dwaublo1-040211-01.tif, 2, --_--]

Figure 2-3 On-Site Operation Panel Fitted on Mounting Bracket

² Place the 2 mounting brackets intended for expansion in parallel to one another on a flat surface.

² Bolt the 1st (left-hand) on-site operation panel to the 2 mounting brackets. Do not firmly tighten the
screws.

² Place the 2nd on-site operation panel on the right of the 1st one and screw these panels onto the 2
mounting brackets. Do not firmly tighten the screws. Make sure that the snap-in spring is engaged!

² Bolt the 2 operation panels to one another through the contact tab. Do not firmly tighten the screws.

² Repeat the last 2 steps for the remaining operation panels. Leave all screws loose.

Assembling the Devices

² Remove the distance frame from the expansion module.

² Remove the bus cover from the extreme left-hand module.

² Remove the plastic screw covers from the extreme left-hand module and from the expansion module.

² Place the expansion module on the left next to the device. Insert the 2 hinged angle clips of the
expansion module in the cut-outs of the device.

² Swivel the expansion module in the direction of the device so that the bottom snap-in spring engages.

² Bolt the contact tab to the 2 modules.

Installation and Commissioning

² Install the distance frame intended for expansion.

² Wire and, if required, fasten the current and voltage terminal blocks.

Expanding Devices
2.2 Surface-Mounted Devices with Integrated On-Site Operation Panel
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² Fit the device back onto the wall without fastened on-site operation panels.

² Use the supplied grounding cable to connect the expansion module with the device and reconnect the
device to service ground.

² Fasten the connecting cable for the on-site operation panel on the extreme left-hand operation panel of
those on-site operation panels assembled beforehand into a block.

² Place the block of assembled operation panels on the distance frames of the device. In doing so, guide
the connecting cable for the on-site operation panel through the cut-outs of the distance frame to the
terminal of the base module.

² Fasten the connecting cable for the on-site operation panel to the base module.

² Bolt the operation panels to the distance frames and firmly tighten the screws.

² Tighten all loose screws on the contact tabs and on the mounting brackets.

² Reinstall all plastic screw covers.

² Extend the device configuration in DIGSI and load it to the device.

² Resume operation of the device.

Expanding Devices
2.2 Surface-Mounted Devices with Integrated On-Site Operation Panel

30 SIPROTEC 5, Operation, Manual
C53000-G5040-C003-L, Edition 03.2023



Surface-Mounted Devices with Detached On-Site Operation Panel

Basic Rules for Expanding Modular SIPROTEC 5 Devices

ii NOTE
Prepare the following tools for the device expansion:

• Phillips screwdriver size PZ1 and PZ2

• Screwdriver DIN 4 x 0.8

• During assembly, use the prescribed torques

Comply with the following basic rules when extending devices:

• Always fit the base module on the right in the 1st device row.

• Always fit the expansion modules from right to left.

• Always fit the on-site operation panel of the base module on the left.

• Always fit the on-site operation panels of the expansion modules from left to right.

• Always install a power-supply module PS203 on the right as the first unit in the 2nd device row.

• Note that the PS203 must always have the same rated voltage as the base module.

• Always mount the redundant PS204 power supply module at the position furthest to the left in the
corresponding row when you're looking at it from the front. If a CB202 printed circuit board assembly is
present in the row, the CB202 printed circuit board assembly must always be mounted to the left of the
PS204 printed circuit board assembly (at the outermost position).

• Note that the PS204 printed circuit board assembly must always have the same rated voltage as the base
module.

• The distance between the device and the on-site operation panel is limited to not more than 5 m by the
length of the connecting cable.

[dwauizei-040211-01.tif, 1, --_--]

Figure 2-4 Device Row

2.3

2.3.1

Expanding Devices
2.3 Surface-Mounted Devices with Detached On-Site Operation Panel
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[dw_abosop-040211-01, 1, --_--]

Figure 2-5 Detached on-site operation panel

Expanding 1st Device Row

Preparation

ii NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the
corresponding extension in the Hardware and Protocols Editor.
Carry out the steps described in this chapter if you wish to expand an installed device later on with
expansion modules.

² Shut down the device.

² Use a screwdriver to carefully bend the left and right spring clips outwards.

² Completely detach the wired current and voltage terminal blocks from the device.

² Remove all communication lines.

² If you want to extend the device, then detach it completely.

² If you want to extend the on-site operation panel, then remove the on-site operation panel from the
installation space.

2.3.2

Expanding Devices
2.3 Surface-Mounted Devices with Detached On-Site Operation Panel
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ii NOTE
The device and the on-site operation panel can be extended independently of one another. Therefore, you
need only detach those components that are to be extended.
Please note the handling guidelines shown in the following figure when connecting the on-site operation
panels.

[dw_osops, 1, --_--]

Figure 2-6 Connecting the On-site Operation Panel

(1) Vertical end faces remain parallel during the assembly process.
(2) Rear panels of the on-site operation panel during assembly on the same level.

Installing the Devices (with View to the Installation Plane)

² Remove the bus cover from the extreme left-hand module of the device to be extended.

² Remove the plastic screw covers from the extreme right-hand module and from the expansion module.

² Place the expansion module on the left next to the device. Insert the two hinged angle clips of the
expansion module in the cut-out of the device.

² Swivel the expansion module in the direction of the device so that the bottom snap-in spring engages.

² Bolt the on-site operation panels of the two modules to one another through the contact tab.

² Check that the bus connection is screwed on at the extreme left of the expansion module.

Installation and Commissioning

² Reinstall the plastic screw covers.

² Use the supplied grounding cable to connect the expansion module with the device and reconnect the
device to service ground.

² Fit the device back onto the wall.

Expanding Devices
2.3 Surface-Mounted Devices with Detached On-Site Operation Panel
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² Extend the on-site operation panel with the on-site operation panel of the expansion modules. Make sure
that the bus connection is plugged in reliably and that the snap-in springs have engaged.

² Bolt the on-site operation panels to one another through the contact tab.

² Check that the bus connection on the expansion module on the extreme right is covered.

² Connect all communication lines again.

² Expand the device configuration with DIGSI and load it into the device.

² Resume operation of the device.

Expanding Devices
2.3 Surface-Mounted Devices with Detached On-Site Operation Panel
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Flush-Mounting Devices
Drilling Patterns and Dimension Specifications for Modular Devices 

[dw_z1_1-3, 2, en_US]

Figure 3-1 Cut-out Widths and Drilling Pattern - 1/3 Device, 1st Device Row

3.1

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z1_1-2, 3, en_US]

Figure 3-2 Cut-out Widths and Drilling Pattern - 1/2 Device, 1st Device Row

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z1_2-3, 3, en_US]

Figure 3-3 Cut-out Widths and Drilling Pattern - 2/3 Device, 1st Device Row

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z1_5-6, 3, en_US]

Figure 3-4 Cut-out Widths and Drilling Pattern - 5/6 Device, 1st Device Row

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z1_1-1, 4, en_US]

Figure 3-5 Cut-out Widths and Drilling Pattern - 1/1 Device, 1st Device Row

All holes in the area of the specific device cut-out width (see Table 3-1) must comply with the dimensions in
the corresponding figures.

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z2_2-6, 3, en_US]

Figure 3-6 Cut-out Widths and Drilling Pattern - 1/3 Device, 2nd Device Row

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z2_3-6, 3, en_US]

Figure 3-7 Cut-out Widths and Drilling Pattern - 1/2 Device, 2nd Device Row

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z2_4-6, 3, en_US]

Figure 3-8 Cut-out Widths and Drilling Pattern - 2/3 Device, 2nd Device Row

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_z2_5-6, 3, en_US]

Figure 3-9 Cut-out Widths and Drilling Pattern - 5/6 Device, 2nd Device Row

[dw_z2_6-6, 4, en_US]

Figure 3-10 Cut-out Widths and Drilling Pattern - 1/1 Device, 2nd Device Row

Fitting the Devices
3.1 Flush-Mounting Devices
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[dw_first and second device row, 1, en_US]

Figure 3-11 Drilling Pattern - 1/1 Device, 1st and 2nd Device Row

Siemens recommends a hole spacing of at least 55 mm (2.17 in) between the 1st and 2nd device rows. The
maximum spacing may be about 80 mm (3.15 in) due to the length of the connecting cable. The length of the
cable is 890 mm (35.04 in) from the center of the plug to the center of the connector.

[dw_angle rail, 1, en_US]

Figure 3-12 Angle Rail for Connecting the 1st and 2nd Device Row

Table 3-1 Cut-Out Widths

Width of the Mounting Opening
1/3 device (base module) 146+2 mm (5.75+0.08)
1/2 device (base module with one expansion module) 221+2 mm (8.7+0.08)
2/3 device (base module with 2 expansion modules) 296+2 mm (11.65+0.08)

Fitting the Devices
3.1 Flush-Mounting Devices
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Width of the Mounting Opening
5/6 device (base module with 3 expansion modules) 371+2 mm (14.61+0.08)
1/1 device (base module with 4 expansion modules) 447+2 mm (17.6+0.08)

Table 3-2 Variable Housing Widths

Dimension a
Housing Widths in mm (in Inches)
(Total Width = Housing Width + 5 mm (0.2 in))

1/3 device 145 (5.71)
1/2 device 220 (8.66)
2/3 device 295 (11.61)
5/6 device 370 (14.57)
1/1 device 445 (17.52)

[dw_surface_mounting_in_SIP5Comp, 4, en_US]

Figure 3-13 Flush-Mounting Devices, Dimensions from the Side and Front Views

Fitting the Devices

Preparations

ii NOTE
You must mount the devices vertically.

3.1.1

Fitting the Devices
3.1 Flush-Mounting Devices
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ii NOTE
The installation depth for 1 device is at least 275 mm (11.83 in). This dimension includes the necessary
bending radius for the various connectors of the plug-in modules.
The M4 holes are the holes for the fastening screws of the device. The Ø 6 holes are the openings for the
fastening screws of the on-site operation panels on the device.

ii NOTE
Use a PZ2-size Phillips screwdriver.
For each module, you need 4 fastening screws with a shank diameter of 4 mm (0.16 in)

! WARNING
Danger due to device being improperly screw-fastened
Incomplete and careless screw-fastening can lead to death, severe injury, and considerable material
damage.

² Ensure that screw-fastening is complete at all intended bolting points. Tighten the screws to a torque
of 1.2 Nm.

² If no assembly opening is prepared, then cut out the required assembly opening.

² Produce the holes as shown in the drilling plan.

Fitting the Devices

² Detach the top and bottom plastic screw covers of each on-site operation panel.

² Insert the device in the installation opening. Make sure that the fastening screws of the on-site operation
panels also protrude exactly into the openings (6-mm diameter (0.24-in diameter)).

² With the M4 oval head cap screws, bolt down the device at the top and bottom at all 4 bolting points of
each module.

² Check for secure attachment.

² Fit the top and bottom plastic screw covers again.

Activating the Battery

Remove the protective film

ii NOTE
The battery is covered with a protective film to protect it from mechanical damage and against premature
discharge.
The battery need not be removed from the battery compartment for activation.

ii NOTE
Only use an insulated tool for opening and closing the battery cover, as well as for removing and inserting
the battery.

² Pull out the battery compartment.

² Remove the protective film from the battery by simply pulling on the film tab.

3.1.2

Fitting the Devices
3.1 Flush-Mounting Devices
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² Push the battery compartment back in again.

Grounding and Connecting Devices

Grounding the Devices
The SIPROTEC 5 devices are protection class I equipment must be connected with the system ground before
commissioning.

! DANGER
Danger due to device being improperly grounded
Incomplete and careless grounding leads to death, severe injury, and considerable material damage!

² The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This method prevents condensation of water in the device.

² If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2
days. This will cause the electrolytic capacitors to form on the printed circuit board assemblies again.

² Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (0.16 in2),
grounding area ≥ M4).

Connecting Devices

² Connect all cables and leads. Use the connection diagrams in the Hardware and Device manuals.

² Tighten the terminal screws to the prescribed torques.

Grounding an On-Site Operation Panel

² Join several on-site operation panels to one another with firm contact.
Siemens recommends the use of contact washers on painted metal assembly walls. If the assembly wall
is not metallic, place a metal layer, for example a metal sheet, between the assembly wall and the on-site
operation panels. Then connect this sheet to the system ground.

Tightening Torques of Fastening Screws

Tightening Torques for Terminal Screws

Type of Line Current
Terminal

Voltage Terminal with
Spring-Loaded Terminals

Voltage Terminal with
Screw Connection

Litz wire with ring-type lug 2.7 Nm No ring-type lug No ring-type lug
Stranded wires with bootlace ferrules
or pin-type lugs

2.7 Nm 1.0 Nm 0.6 Nm

Solid conductor, bare (2 mm2) 2.0 Nm 1.0 Nm –

ii NOTE
Make sure that the cables and lines of extra-low voltage circuits are laid sufficiently far away from power
network circuits.

3.1.3

3.1.4
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Torques for Other Screw Types

Screw Type Torque
M4 x 20 1.2 Nm
M4 x 8 1.2 Nm
M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 8 0.39 Nm
Collar screw, M4 x 20 0.7 Nm

Fitting the Devices
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Surface-Mounted Devices with Integrated On-Site Operation Panel
Drilling Patterns and Dimension Specifications (Modular Device) 

[dwosopin-070211-01.tif, 4, en_US]

Figure 3-14 1/3 Surface-Mounted Device with Integrated On-Site Operation Panel; Dimensions in the Side
and Front Views

ii NOTE
When mounting the surface-mounted devices, ensure that the holes are dimensioned for a screw size M6.

3.2

Fitting the Devices
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[dwbohrge-1_3.vsd, 3, en_US]

Figure 3-15 Drilling Pattern of a 1/3 Surface-Mounted Device – 1st Device Row

[dwbohrge-1_2.vsd, 3, en_US]

Figure 3-16 Drilling Pattern of a 1/2 Surface-Mounted Device – 1st Device Row
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[dwbohrge-2_3.vsd, 3, en_US]

Figure 3-17 Drilling Pattern of a 2/3 Surface-Mounted Device – 1st Device Row

[dwbohrge-5_6.vsd, 3, en_US]

Figure 3-18 Drilling Pattern of a 5/6 Surface-Mounted Device – 1st Device Row
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[dwbohrge-070211-01.tif, 4, en_US]

Figure 3-19 Drilling Pattern of a 1/1 Surface-Mounted Device – 1st Device Row

[dw_z2_bohr_1-3.vsd, 3, en_US]

Figure 3-20 Drilling Pattern of a 1/3 Surface-Mounted Device – 2nd Device Row
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[dw_z2_bohr_1-2.vsd, 3, en_US]

Figure 3-21 Drilling Pattern of a 1/2 Surface-Mounted Device – 2nd Device Row

[dw_z2_bohr_2-3.vsd, 3, en_US]

Figure 3-22 Drilling Pattern of a 2/3 Surface-Mounted Device – 2nd Device Row

Fitting the Devices
3.2 Surface-Mounted Devices with Integrated On-Site Operation Panel

54 SIPROTEC 5, Operation, Manual
C53000-G5040-C003-L, Edition 03.2023



[dw_z2_bohr_5-6.vsd, 3, en_US]

Figure 3-23 Drilling Pattern of a 5/6 Surface-Mounted Device – 2nd Device Row
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[dw_z2_bohr_1-1.vsd, 3, en_US]

Figure 3-24 Drilling Pattern of a 1/1 Surface-Mounted Device – 2nd Device Row
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Dimensions, Non-Modular Surface-Mounted Device 

[dw_console side view, 4, en_US]

Figure 3-25 Non-Modular Surface-Mounted Device with Integrated On-Site Operation Panel, Dimensions in
the Side and Front Views

Drilling Pattern, Non-Modular Surface-Mounted Device

ii NOTE
When mounting the surface-mounted devices, ensure that the holes are dimensioned for a screw size M6.

Fitting the Devices
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[dw_drilling non modular surface mounting with several consoles, 2, en_US]

Figure 3-26 Drilling Pattern for a Non-Modular Surface-Mounted Device – Several Consoles

* The 149 mm applies in the case that several mounted consoles should be mounted next to each
other.

Fitting Devices

Preparations

ii NOTE
You must mount the devices vertically.

ii NOTE
Siemens recommends detaching the on-site operation panels before fitting the device. Fit the on-site
operation panels after completing wiring and checks.

ii NOTE
Use a PZ2-size Phillips screwdriver.
For each module, you need 4 fastening screws with a shank diameter of 6 mm (0.16 in).

! DANGER
Danger due to device being improperly screw-fastened
Incomplete and careless screw fitting results in death, severe injury, or considerable material
damage!

² Ensure that screw-fastening is complete at all intended bolting points. Tighten the screws to a torque
of 1.2 Nm.

3.2.1

Fitting the Devices
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² Produce the holes as shown in the drilling plan.

Fitting Devices

² First bolt the bottom fastening screws into the mounting wall.

² Then lower the bottom mounting bracket of the device onto the bottom fastening screws.

² Align the device in the oblong holes. Ensure that screw-fastening is complete at all intended bolting
points.

² Then screw the device onto the top mounting bracket with the fastening screws.

² Then check for secure attachment of the device on the mounting wall.

Activating the Battery

Remove the protective film

ii NOTE
The battery is covered with a protective film to protect it from mechanical damage and against premature
discharge.
The battery need not be removed from the battery compartment for activation.

ii NOTE
Only use an insulated tool for opening and closing the battery cover, as well as for removing and inserting
the battery.

² Pull out the battery compartment.

² Remove the protective film from the battery by simply pulling on the film tab.

² Push the battery compartment back in again.

Grounding and Connecting Devices

Grounding Devices

! DANGER
Danger due to device being improperly grounded
Incomplete and careless grounding leads to death, severe injury, and considerable material damage!

² The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This method prevents condensation of water in the device.

² If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2
days. This will cause the electrolytic capacitors to form on the printed circuit-board assemblies again.

² Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (≥ 0.16 in2),
grounding area ≥ M4).

Connecting Devices

² Connect all cables and leads. Use the connection diagrams in the Hardware and Device manuals.

² Tighten the terminal screws to the prescribed torques.

3.2.2

3.2.3

Fitting the Devices
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Tightening Torques of Fastening Screws

Tightening Torques for Terminal Screws

Type of Line Current
Terminal

Voltage Terminal with
Spring-Loaded Terminals

Voltage Terminal with
Screw Connection

Litz wire with ring-type lug 2.7 Nm No ring-type lug No ring-type lug
Stranded wires with bootlace ferrules
or pin-type lugs

2.7 Nm 1.0 Nm 0.6 Nm

Solid conductor, bare (2 mm2) 2.0 Nm 1.0 Nm –

ii NOTE
Make sure that the cables and lines of extra-low voltage circuits are laid sufficiently far away from power
network circuits.

Torques for Other Screw Types

Screw Type Torque
M4 x 20 1.2 Nm
M4 x 8 1.2 Nm
M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 8 0.39 Nm
Collar screw, M4 x 20 0.7 Nm

3.2.4

Fitting the Devices
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Surface-Mounted Devices with Detached On-Site Operation Panel
Drilling Patterns and Dimension Specifications of the On-Site Operation Panels 

You will find more information on the drilling patterns for the devices in section Drilling Patterns and Dimen-
sion Specifications (Modular Device) , Page 50.

[dw_z1_osop_1-3, 1, en_US]

Figure 3-27 On-Site Operation Panel Drilling Pattern of the 1/3 Device

[dw_z1_osop_1-2, 1, en_US]

Figure 3-28 On-Site Operation Panel Drilling Pattern of the 1/2 Device

3.3
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[dw_z1_osop_2-3, 1, en_US]

Figure 3-29 On-Site Operation Panel Drilling Pattern of the 2/3 Device

[dw_z1_osop_5-6, 1, en_US]

Figure 3-30 On-Site Operation Panel Drilling Pattern of the 5/6 Device
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[dw_z1_osop_1-1, 1, en_US]

Figure 3-31 On-Site Operation Panel Drilling Pattern of the 1/1 Device

[dwosopab-070211-01.tif, 4, en_US]

Figure 3-32 Surface-Mounted Device with Detached On-Site Operation Panel, Dimensions in the Side and
Front Views

Refer to Table 3-2 for the variable dimension a.
The drilling patterns correspond to the figures Figure 3-15 to Figure 3-24.
The cable length for the detached operation panel is up to 5 m (196.85 in).

Fitting the Devices
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ii NOTE
Cables with a length of 5 m (196.85 in) are only specified for PCs and laptop computers with a USB2
connection. These cables are not specified for PCs and laptop computers with a USB3 connection.
Cables with a length of 2.5 m (98.43 in) are specified for USB2 and USB3 connections.

[dw_angel-bracket_without_relief-cutouts, 1, en_US]

Figure 3-33 Angle Rail with Assembly Dimensions

Fitting the Devices

Preparations

ii NOTE
You must mount the devices vertically.

ii NOTE
The distance between the installation location of the device and that of the on-site operation panel must
not exceed 5 m.
Join the on-site operation panels to one another with firm contact. Siemens recommends the use of
contact washers on painted metal mounting walls. If the mounting wall is not metallic, place a metal layer,
for example a sheet metal panel between the mounting wall and the on-site operation panel; then connect
this sheet to system ground.

ii NOTE
Use a PZ2-size Phillips screwdriver.
For each base module you need 4 fastening screws with a shank diameter of 6 mm. For each on-site
operation panel you need 4 M4 fastening screws, minimum screw length M4x8 plus contact washer
thickness.
For each on-site operation panel you also need 2 contact washers, manufacturer Böllhoff.

! DANGER
Danger due to device being improperly screw-fastened
Incomplete and careless screw fitting results in death, severe injury, or considerable material
damage!

² Ensure that screw-fastening is complete at all intended bolting points. Tighten the screws to a torque
of 1.2 Nm.

3.3.1
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² Produce the holes in the mounting wall to fit the device. The drill holes must be so large that they can
accept a screw with a shank diameter of 6 mm.

² Produce the holes in the mounting wall to fit the on-site operation panel.

² Cut a recess into the mounting wall for the connecting cable. The connecting cable links the on-site
operation panels to the device.

² Place a metallic layer such as a sheet metal panel on the mounting wall if it is not metallic.

Fitting the Device

² First bolt the bottom fastening screws into the mounting wall.

² Hook the bottom mounting bracket onto the bottom fastening screws.

² Align the device in the oblong holes.

² Screw the device onto the top mounting bracket with the fastening screws.

² Check for secure attachment of the device on the mounting wall.

Installing On-Site Operation Panels

ii NOTE
Join several on-site operation panels to one another with firm contact. Siemens recommends the use of
contact washers on painted metal mounting walls. If the mounting wall is not metallic, place a metal
layer, for example a sheet metal panel, between the mounting wall and the on-site operation panel; then
connect this sheet to system ground.

² Plug the connecting cable into the on-site operation panel of the base module.

² Guide the connecting cable through the cut-out in the mounting wall.

² Place the 2 contact washers on the top fastening holes.

² Bolt down the on-site operation panels connected to one another on the mounting wall.

² Check for secure attachment of the on-site operation panels on the mounting wall.

Activating the Battery

Remove the protective film

ii NOTE
The battery is covered with a protective film to protect it from mechanical damage and against premature
discharge.
The battery need not be removed from the battery compartment for activation.

ii NOTE
Only use an insulated tool for opening and closing the battery cover, as well as for removing and inserting
the battery.

² Pull out the battery compartment.

² Remove the protective film from the battery by simply pulling on the film tab.

² Push the battery compartment back in again.

3.3.2

Fitting the Devices
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Grounding and Connecting Devices

Grounding Devices

! DANGER
Danger due to device being improperly grounded
Incomplete and careless grounding leads to death, severe injury, and considerable material damage!

² The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This method prevents condensation of water in the device.

² If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to
2 days. This will cause the electrolytic capacitors to form on the printed circuit board assemblies again.

² Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (≥ 0.16 in2),
grounding area ≥ M4).

² Ground the detached operation panel with a solid low-impedance system grounding (cross-
section ≥ 2.5 mm2 (≥ 0.1 in2)).

Connecting Devices

² Connect all cables and leads. Use the connection diagrams in the Hardware Manual and Device Manual.

² Tighten the terminal screws to the prescribed torques.

Tightening Torques of Fastening Screws

Tightening Torques for Terminal Screws

Type of Line Current
Terminal

Voltage Terminal with
Spring-Loaded Terminals

Voltage Terminal with
Screw Connection

Litz wire with ring-type lug 2.7 Nm No ring-type lug No ring-type lug
Stranded wires with bootlace ferrules
or pin-type lugs

2.7 Nm 1.0 Nm 0.6 Nm

Solid conductor, bare (2 mm2) 2.0 Nm 1.0 Nm –

ii NOTE
Make sure that the cables and lines of extra-low voltage circuits are laid sufficiently far away from power
network circuits.

Torques for Other Screw Types

Screw Type Torque
M4 x 20 1.2 Nm
M4 x 8 1.2 Nm
M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 8 0.39 Nm
Collar screw, M4 x 20 0.7 Nm

3.3.3

3.3.4
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SIPROTEC 5 Compact
Dimensions

[dw_SIP5-compact_dimensional_drawing, 2, en_US]

Figure 3-34 Dimensions in the Different Views

Flush-Mounting Device

[dw_drilling_sourface_mounting_in_SIP5Comp, 1, en_US]

Figure 3-35 Cut-Out Widths and Drilling Pattern

3.4
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Table 3-3 Cut-Out Widths

Width of the Mounting Opening
1/6 device 71+2 mm (2.8+0.08)

[dw_surface_mounting_in_SIP5Comp, 4, en_US]

Figure 3-36 Flush-Mounting Devices, Dimensions from the Side and Front Views

Table 3-4 Variable Housing Widths

Dimension a
Housing Widths in mm (in Inches)
(Total Width: Housing Width + 4.6 mm (0.18 in))

1/6 device 70 (2.76)

Fitting the Devices
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Dimensions of Surface-Mounted Device 

[dw_console side view SIP5 Comp, 2, en_US]

Figure 3-37 Surface-Mounted Device with Integrated On-Site Operation Panel; Dimensions in the Side and
Front Views

[dw_drilling-plans_for_SIP5compact_dimensions, 1, en_US]

Figure 3-38 Drilling Pattern of a Surface-Mounted Device with Integrated On-Site Operation Panel

Fitting the Devices
3.4 SIPROTEC 5 Compact

SIPROTEC 5, Operation, Manual 69
C53000-G5040-C003-L, Edition 03.2023



Fitting the Devices

Preparations

ii NOTE
You must mount the devices vertically.

ii NOTE
The installation depth for 1 device is at least 275 mm (11.83 in). This dimension includes the necessary
bending radius for the various connectors of the plug-in modules.
The M4 holes are the holes for the fastening screws of the device. The Ø 6 holes are the openings for the
fastening screws of the on-site operation panels on the device.

ii NOTE
Use a PZ2-size Phillips screwdriver.
For each module, you need 4 fastening screws with a shank diameter of 4 mm (0.16 in)

! WARNING
Danger due to device being improperly screw-fastened
Incomplete and careless screw-fastening can lead to death, severe injury, and considerable material
damage.

² Ensure that screw-fastening is complete at all intended bolting points. Tighten the screws to a torque
of 1.2 Nm.

² If no assembly opening is prepared, then cut out the required assembly opening.

² Produce the holes as shown in the drilling plan.

Fitting the Devices

² Detach the top and bottom plastic screw covers of each on-site operation panel.

² Insert the device in the installation opening. Make sure that the fastening screws of the on-site operation
panels also protrude exactly into the openings (6-mm diameter (0.24-in diameter)).

² With the M4 oval head cap screws, bolt down the device at the top and bottom at all 4 bolting points of
each module.

² Check for secure attachment.

² Fit the top and bottom plastic screw covers again.

3.4.1
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Activating the Battery

Remove the protective film

ii NOTE
The battery is covered with a protective film to protect it from mechanical damage and against premature
discharge.
The battery compartment is located on the underside of the device. To remove the protective film, you
must take the battery out of the battery compartment. To prevent damage to the contacts in the battery
holder, do not remove the insulating film when the battery slide is closed.

ii NOTE
Only use an insulated tool for opening and closing the battery cover, as well as for removing and inserting
the battery.

² Open the battery compartment on the underside of the device.

² Position the insulated tool in the film tab section. Use the tool to push out the battery.

² Remove the protective film.

² Insert the battery again.

² Lock the battery compartment on the underside of the device.

Grounding and Connecting Devices

Grounding the Devices
The SIPROTEC 5 devices are protection class I equipment must be connected with the system ground before
commissioning.

! DANGER
Danger due to device being improperly grounded
Incomplete and careless grounding leads to death, severe injury, and considerable material damage!

² The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This method prevents condensation of water in the device.

² If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2
days. This will cause the electrolytic capacitors to form on the printed circuit board assemblies again.

² Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (0.16 in2),
grounding area ≥ M4).

Connecting Devices

² Connect all cables and leads. Use the connection diagrams in the Hardware and Device manuals.

² Tighten the terminal screws to the prescribed torques.

3.4.2

3.4.3
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Grounding an On-Site Operation Panel

² Join several on-site operation panels to one another with firm contact.
Siemens recommends the use of contact washers on painted metal assembly walls. If the assembly wall
is not metallic, place a metal layer, for example a metal sheet, between the assembly wall and the on-site
operation panels. Then connect this sheet to the system ground.

Tightening Torques of Fastening Screws

Tightening Torques for Terminal Screws

Type of Line Current
Terminal

Voltage Terminal with
Spring-Loaded Terminals

Voltage Terminal with
Screw Connection

Litz wire with ring-type lug 2.7 Nm No ring-type lug No ring-type lug
Stranded wires with bootlace ferrules
or pin-type lugs

2.7 Nm 1.0 Nm 0.6 Nm

Solid conductor, bare (2 mm2) 2.0 Nm 1.0 Nm –

ii NOTE
Make sure that the cables and lines of extra-low voltage circuits are laid sufficiently far away from power
network circuits.

Torques for Other Screw Types

Screw Type Torque
M4 x 20 1.2 Nm
M4 x 8 1.2 Nm
M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 6 0.39 Nm
Countersunk screw, M2.5 x 8 0.39 Nm
Collar screw, M4 x 20 0.7 Nm

3.4.4
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Handling of Plug-In Modules

4.1 Installation, Removal, Replacement 74
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Installation, Removal, Replacement

Fasteners

The fasteners of the plug-in modules are shown in the following figure regarding the example of an installed
module and an empty, covered slot.

[le_fxing_elements, 1, --_--]

Figure 4-1 Fasteners

(1) EMC spring contact
(2) Fastening screw
(3) Cut-out for prying out the modules
(4) Plug-in module
(5) Fastening screw
(6) Cover plate

Installation

ii NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the
corresponding extension in the Hardware and Protocols Editor.

Preparing Installation

! DANGER
Danger due to live voltage when installing the plug-in modules.

Noncompliance with the safety notes will result in death or severe injuries.

² Install plug-in modules on the electrically deactivated device only.

4.1

4.1.1

4.1.2
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! CAUTION
Exercise caution with laser beams of the optical plug-in modules.

Noncompliance with the safety notes can result in medium-severe or slight injuries.

² Do not look directly into the optical fiber terminals of the active optical plug-in modules, not even with
optical devices. The laser beams can damage the eyes.

² De-energize the device.

ii NOTE
When using optical communication modules, Laser class 1 is maintained in compliance with EN 60825-1
and EN 60825-2 when using optical fibers ≤ 62.5 μm/125 μm.
When using the ARC-CD-3FO module, Laser class 1 is maintained in compliance with EN 60825-1 and
EN 60825-2 when using 1 mm plastic optical fibers.

² In the case of a surface-mounted device with integrated on-site operation panel, remove the entire
on-site operation panel.

² Undo the fastening screw and remove the cover plate from the plug-in module position.

Installing the Plug-In Module

² Push in the plug-in module on the inner guide as far as it will go.

² Ensure that the EMC contact spring is seated correctly.

² Bolt down the plug-in module on the assembly frame to a torque of 0.4 Nm.

² Connect the lines to the terminals.

² Then check for secure attachment of the plugs.

² If necessary, fit the on-site operation panel again.

Completing Installation

² Resume operation of the device.

Removing

Accessories

ii NOTE
Seal an unused plug-in module position with a cover plate.

² Order the module cover plate set of parts to cover the unused plug-in module position.

4.1.3
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Preparing Removal

! DANGER
Risk of live voltage when removing the plug-in modules.

Noncompliance with the safety notes will result death or severe injuries.

² Remove plug-in modules on the electrically deactivated device only.

! CAUTION
Exercise caution with laser beams of the optical plug-in modules.

Noncompliance with the safety notes can result in medium-severe or slight injuries.

² Do not look directly into the optical fiber terminals of the active optical plug-in modules, not even with
optical devices. The laser beams can damage the eyes.

² De-energize the device.

ii NOTE
Laser class 1 is adhered to in compliance with EN 60825-1 and EN 60825-2, in the case of
≤ 62.5 μm/125 μm optical fibers.

² In the case of a surface mounting device with integrated on-site operation panel, remove the on-site
operation panel before the base module.

Removing the Plug-In Module

² Remove all connecting lines.

² Undo the fastening screw with which the plug-in module is fixed on the device.

² Insert a screwdriver (DIN 4 x 0.8) in the cut-out underneath the oblong hole.

² Carefully pull out the plug-in module.

Fastening the Cover Plate

² Fasten the cover plate with the fixing screw to a torque of 0.4 Nm. The fixing screw is included in the set
of parts.

Completing Removal

² In the case of a surface mounting device with integrated local operation panel, fit the on-site operation
panel of the base module again.

² Resume operation of the device.

Handling of Plug-In Modules
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Replacement

Preparing for Replacement

! DANGER
Danger due to live voltage when replacing the plug-in modules.

Noncompliance with the safety notes will result in death or severe injuries.

² Install plug-in modules on the electrically deactivated device only.

! CAUTION
Exercise caution with laser beams of the optical plug-in modules.

Noncompliance with the safety notes can result in slight to medium injuries.

² Do not look directly into the optical fiber terminals of the active optical plug-in modules, not even with
optical devices. The laser beams can damage the eyes.

² De-energize the device.

ii NOTE
Laser class 1 is adhered to in compliance with EN 60825-1 and EN 60825-2, in the case of
≤ 62.5 μm/125 μm optical fibers.
When using the ARC-CD-3FO module, Laser class 1 is maintained in compliance with EN 60825-1 and
EN 60825-2 when using 1-mm plastic optical fiber.

² In the case of a surface-mounted device with integrated on-site operation panel, remove the on-site
operation panel before the base module.

² Remove all connecting lines.

² Undo the fastening screw with which the plug-in module is fixed on the device.

² Insert a screwdriver (DIN 4 x 0.8) in the cut-out underneath the elongated hole in the mounting frame
and disengage the plug-in module.

² Carefully pull out the plug-in module.

Fastening the Plug-In Module

² Push in the new plug-in module on the inner guide of the plug-in module position until it moves no
further.

² Bolt down the plug-in module on the mounting frame to a torque of 0.4 Nm.

² Connect the lines to the terminals.

² Then check for secure attachment of the plugs.

² If necessary, fit the on-site operation panel again.

Completing Replacement

² Place the device is service again and perform a firmware update of the communication modules.

4.1.4

Handling of Plug-In Modules
4.1 Installation, Removal, Replacement
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ii NOTE
If you have not cabled the optical fiber plug-in modules, then seal the terminals with protective covers. This
prevents soiling of the terminals.

Handling of Plug-In Modules
4.1 Installation, Removal, Replacement
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General Information
All SIPROTEC 5 devices can be operated via the DIGSI 5 interface of your PC and via the on-site operation
panel. This is available optionally as an integrated and detached on-site operation panel. The on-site operation
panel is characterized by a flat, compact design.

Variants
The on-site operation panel is composed of different modules depending on the hardware configuration of
the device. Operation is via the membrane keypad and the key switches. LEDs and displays in 3 different sizes
are available as elements of the display.

[dwosopva-040211-01.tif, 2, en_US]

Figure 5-1 Design Variants of Modular SIPROTEC 5 Devices

[dwosopvacc-090221, 1, --_--]

Figure 5-2 Design Variant of SIPROTEC 5 Compact Devices

Operating Concept
The operating concept allows you to do the following on-site operator control actions:

• Navigation in the menu tree

• Modification of settings

• Resetting saved information

• Showing default and control displays, measured values and logs

• Executing switching operations

• Initiating configured actions via function keys

5.1
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• Executing test and diagnostic functions

• Status display with LED
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Overview of Operator Controls and Display Elements
On-Site Operation Panel of the Base and 1/3 Module

[le_base_module, 3, --_--]

Figure 5-3 Basic 1/3 Module in Standard Design, US Design (a), China Design (b), and for 7xx81 (c)

(1) Operating state display
(2) Display in 2 variants
(3) Keypad with navigation keys
(4) Softkey
(5) Keypad with numerical keys and shiftable function keys
(6) Keypad of control keys
(7) USB-port cover
(8) Labeling strips

5.2
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(9) Reset and LED test key
(10) 16 2-colored LEDs

On-Site Operation Panel for a SIPROTEC 5 Compact Device

[le_sip5 compcl-090221, 1, --_--]

Figure 5-4 SIPROTEC 5 Compact

(1) Operating state display
(2) Display
(3) Keypad with navigation keys
(4) Softkey
(5) Keypad with numerical keys and shiftable function keys
(6) Keypad of control keys
(7) USB-port cover
(8) Reset and LED test key
(9) 8 2-colored LEDs

Operation and Display Elements
The following table gives you a detailed explanation of the function of the operator and display elements.
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Table 5-1 Overview of Operator Controls and Display Elements

Operator control/display
element

Function

Display

Small display
Resolution: 192 x 128 pixels
Display: Alphanumeric characters

Large graphical display
Resolution: 240 x 320 pixels
Display: Alphanumeric characters as well as graphical display of default and
control displays.

Graphic Display for SIPROTEC 5 Compact
Resolution: 240 x 320 pixels
Display: Alphanumeric characters as well as the graphical display for control
displays.
Display of readiness for operation

Green LED (Run)
The device is switched on. The presence of the external auxiliary voltage is
indicated to you.

Red LED (Error)
The device is not ready to run or a failure is present. The life contact is
open. After successful startup of the device, the LED goes out, indicating to
you that the device is ready for operation.
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Operator control/display
element

Function

Navigation keys
By pressing or holding down the navigation keys, you can navigate in the
menus, lists and the graphical images (default display, control display).

Menus and lists (press key):

• Top
– Display entry above

• Bottom
– Display entry below

• Right
– Display tier below

• Left
– Display tier above

Menus and lists (hold key):

• Top
– Move forward by one display length

• Bottom
– Backward by a display length

• Right
– Display tier below

• Left
– Back to the default display

Control displays (press/hold key):
Control displays are available only on the large display. Navigation between
pages and switching objects is done according to the sequences defined in
the DIGSI 5 display editor.

• Top
– To the previous switching object

• Bottom
– To the next switching object

• Right
– To the next page

• Left
– To the previous page

Default displays (press/hold key):
Navigation between the default displays (pages) is done according to the
sequences defined in the DIGSI 5 display editor.

• Right
– To the next page
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Operator control/display
element

Function

• Left
– To the previous page (sequence as laid down in DIGSI 5)

Navigational aid
The footer of the display shows you the authorized navigation directions
depending on current display level.
Selection dialogs:
In selection dialogs, you are offered selection options one below the other.
Example parameter Mode (Off/On/Test).

• Top
– Select top entry

Automatic line break from the first to the last entry
• Bottom

– Select bottom entry
Automatic line break from the last to the first entry

Numerical input dialog:
In a numeric command prompt (for example, confirmation ID), the cursor
appears right-aligned.

• Left
– Backspace key which puts the cursor back by one position. You

must reenter all skipped places by using the numeric keys.
Contrast setting:
The contrast is adjusted using the navigation keys only.

• Left and right simultaneously
– Jump to the Contrast menu

• Right
– More contrast

• Left
– Less contrast

• Top and bottom simultaneously
– Restoring factory setting

Softkeys
The softkeys are located on the left and right below the display. They are
used to confirm command prompts in the display. Context-sensitive actions
can always be triggered with the softkeys.
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Operator control/display
element

Function

Numerical keys and convertible function keys
This keypad is used for the input of numeric values (with or without
decimal point). You can activate actions of function keys using these keys.
The keys <1> to <9> are double assigned for number entry and the func-
tionality of function keys. To activate the function keys, press the <Fn> key
(<F1> to <F9> in blue font).

Numerical keys
These keys are used to input values and navigate in menus. According
to the numbering on the right display edge, you can jump directly into
submenus or carry out settings.

Function Keys <F1> to <F9>
You can perform configured actions with DIGSI 5 using the function keys.
For standard actions (for example, reading of the operational log on site),
this means a simplification. The following configurations for the function
keys are possible:

• Jump to a specific menu
• Jump to a specific log
• Activation of a binary input indication (for example, start fault record,

test binary inputs)
• An adjustable function key mode is offered by the Toggle (edge-trig-

gered activation and termination) and Pulse (with activation time)
modes and the ON and OFF mode.
Hint on the Toggle function key mode:
The default setting of the value of information in startup is OFF, each
key press switches between the states ON and OFF.
When routing to switching objects (information type SPC or DPC), the
current switch position is not taken into account. This means that a
toggle command is not executed if the switching object is already in
this state.

• <F9> cannot be configured and is always assigned to switching
between languages

Activating function keys:
There are several methods available to you to activate function keys

• <Fn> + NUM LOCK key (simultaneously)
Example: <F1> = <Fn> key + <1> key

• <Fn> key alone → jump to the function key menu, selection of
function key via navigation keys and confirmation with OK or directly
by numeric input
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Operator control/display
element

Function

Function Keys Menu
The configured assignment of function keys is visible in the function key
menu. The assignment of function keys <F1> to <F8> is defined in DIGSI
5. They have different defaults depending on the application template. A
default assignment exists for:

• <F9>
Language change: Jump to the selection menu for languages
<F9> cannot be configured via DIGSI 5

Control key for activating standard control display
If no control display is available (not configured or device with small
display), you are taken directly to the standard default display.
If it has not already been selected, and depending on device configuration,
pressing the <CTRL> key jumps directly to:

• Large Display → Default display
• Large display/at least one control display → Standardcontrol display
• Small Display → Default display
Control key for switching on a selected switching object
Select the switching object either in the Control menu or in the control
display (only in devices with large display).
Control key for switching off a selected switching object
Select the switching object either in the Control menu or in the control
display (only in devices with large display).
USB ports
There are 2 USB ports with a plastic cover available to you:

• Top USB port (host)
Connector for a DIGSI PC

• Bottom USB port
Reserved for the future applications

16 parameterizable LEDs

• dual-colored configurable (red and green)

8 parametrizable LEDs for SIPROTEC 5 Compact

• dual-colored configurable (red and green)

Key for releasing saved displays and contacts
With this key, you can reset stored information that is configured on the
LEDs, on the display or on output contacts. The initial state is then restored.
When the key is pressed, all LEDs are activated simultaneously, allowing
you to test the LEDs.

ii NOTE
Note that terminating the contacts of saved output indications can lead to reactions in the device environ-
ment.
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On-site Operation Panel of the Expansion Modules 

[dwerwmod-040211-01.tif, 2, --_--]

Figure 5-5 Expansion Module

(1) 16 1-colored LEDs
(2) Labeling strips
(3) 2 key switches
(4) 8 1-colored LEDs
(5) 8 push buttons

The following table gives you a detailed explanation of the function of the operator and display elements.
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Operator control/display element Meaning
16 parameterizable LEDs

• 1-colored (red)

8 parameterizable LEDs

• 1-colored (red)

Keypad

• Keypad with programmable function keys to perform
actions quickly. Next to the keypad, there are labeling
strips for user-defined labels.

Besides the base module, you can fit an expansion module with key switches. The following table explains the
meanings of the switch positions.
Operator control/display element Meaning

Key switch for on-site switching authority

• Local position
Switching commands for configured operating equipment
are possible only on site with the control keys or in the
control menu. You cannot execute switching commands
remotely (or from DIGSI).

• Remote position
Switching commands for configured equipment are
possible on site as well as remotely.

In devices with an expansion module with key switches the
corresponding options are static in the control menu.
Key switch for on-site switching mode

• OFF position
Unlocked switching of configured equipment allowed

• Standard position
Switching of configured equipment only with the designed
interlocking conditions

In devices with an expansion module with key switches the
corresponding options are static in the control menu.
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Displays for Indication and Control
Displays

Displays for indication and control offer you the possibility of quickly obtaining an overview of important
operating modes. You can configure a total of up to 10 displays in DIGSI 5 using the Display Editor. The
following contents are available here:

• Dynamically updated measured values

• Status of indications

• Switch positions of switching objects

• Texts

• Graphical elements

ii NOTE
The displays and controls are displays created in DIGSI 5.

Default Displays
In the idle state, that is, provided there is no fault, the display with DIGSI 5 can show configurable operating
information (for example, operational measured values). If preconfigured in DIGSI 5, display images can be
suppressed by spontaneous displays in the event of a fault.
A device ready for operation will show you the following display image after booting. This presupposes
you have not parameterized a display image with DIGSI 5. The standard display image (default display) is
parameterized and defined in DIGSI 5. If a parameterized and defined display image exists, it is displayed after
booting.

[scligrdi-080413-01.tif, 1, en_US]

Figure 5-6 Standard Display Diagram for SIPROTEC 5

5.3
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[scligrdicc-050221, 1, --_--]

Figure 5-7 Standard Display Diagram for SIPROTEC 5 Compact

You reach the standard display diagram at any time (exception: in case of fault) by holding down the left
navigation key.
If several display images are available, you can select them in order of parameterized sequence by pressing the
right and the left navigation keys.

Control Displays
In devices with large graphic display, entire control displays can also be graphically depicted. The control
displays can graphically and dynamically update the switch position of switching objects. In addition, control
displays offer you the possibility of selecting individual switching objects and activating them according to
switching authority and switching mode.

[scabzstb-220221, 1, en_US]

Figure 5-8 Control Display for SIPROTEC 5

[scdisplaycc-220221, 1, en_US]

Figure 5-9 Control Display for SIPROTEC 5 Compact
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A ready-to-run device with large graphic display shows you the control display defined as the standard after
booting. By pressing and holding down the left navigation key, you get to the control display defined as
standard. By pressing the control key, you get to the control mode of the currently displayed control display.

ii NOTE
The switching device in control mode is selected by pressing the following navigation keys:

• Top

• Bottom
You can leave control mode via the softkey Exit. If no keys are pressed for 15 minutes, the default display is
automatically activated and control mode is reset.

If there are multiple displays, you can use the left and right navigation buttons to toggle between the displays.
If the device was previously in control mode by pressing the CTRL key, this mode is maintained so that you can
also activate a 2nd and another control display. Control mode is reset after a switching procedure or after a
period of 15 minutes without a switching operation.
For this see the description of the navigation keys in Table 5-1.
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Structure of the Menu
The menu structure for SIPROTEC 5 and SIPROTEC 5 Compact devices are described below by way of example.

[scmnuebr-030914-01, 2, en_US]

Figure 5-10 Example Main Menu

(1) Title bar with name of menu
(2) Position display and total number of available menu items
(3) List of menu items with numbering on the right edge (shortcut)
(4) Base bar with the display of permissible navigation directions and assignment of softkeys
(5) The current position in the menu is marked with brighter font on a dark background.

5.4
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Menu Tree
The menu tree consists of the main menu and several levels of submenus. To navigate in the menu use the
keys on the operation panel of the base module.

Main Menu

The main menu structure is firmly set and is not changeable. The submenus
depend on the hardware configuration and the configuration of functions.

Logs Menu

In the Logs menu, the available logs recording events in the operating state
of the device are offered.
You will find information about reading and deleting logs in chapter
8.4.1 General.

Measurements Menu

In the Measurements menu, you can display various measured values.
Assignment to existing function groups (for example, line 1) is done in
corresponding submenus.

Control Menu

ii NOTE
The Switching mode and Switching authority submenus are not offered if the device has key switches to
the on-site control.

The Control menu offers all means for on-site control. Access to individual
equipment (for example, circuit breakers) and the settings with respect to
interlocking mechanisms, switching authority and switching mode is via
submenus.
You will find information about controlling equipment and resetting saved
binary outputs and LEDs in chapter 8.4.1 General.

Settings Menu
The Settings menu is used for changing and adapting protection parameters in the device. The menu follows
a usability (for example, request for acceptance after leaving certain menu levels).

ii NOTE
All visible settings are assigned to a certain adjustable settings group. You can view the number of settings
groups and set the activation of one of the settings groups in the General submenu.

5.5
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The settings are grouped in corresponding submenus according to their
assignment to existing function groups (for example, line 1).
You will find information about viewing and changing settings in chapter
8.4.1 General.

Binary I/O Menu

Selecting the Binary I/O menu provides you with the option to display the
routing to the binary inputs, binary outputs and signals.
You can find more information in chapter 5.8 Display of Routings and
Status.

Communication Menu
The Communication menu is used for changing and adapting communication settings for the mainboard and
the communication modules in the device. The menu follows a usability (for example, request for acceptance
after leaving certain menu levels).

ii NOTE
Enter settings for communication modules only through DIGSI 5.

The Communication menu notifies you about the status of configured
communication modules (module type, slot, port and IP address). Further-
more, you can, for example, also change the IP address of your device.

Device Functions Menu

Via the Device functions menu, you can set the operating modes of the
device or of individual functions (for example, application mode), initiate
resetting of stored LEDs and binary outputs, change passwords and make
regional settings (date and time synchronization, display formats).

Test & Diagnosis Menu

The Test & Diagnosis menu offers you support during commissioning and
testing. If you wish to test systems and equipment on site, you can read all
necessary information from the corresponding submenus and start actions
such as device reset.
You can find more information in chapter 10.5 Test and Diagnostics.
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Notification Windows and Dialogs
Notification Windows

The notification windows appear briefly in the base bar to give you important information during on-site
operation and close automatically. For example, they contain the following information:

[scmitfen-080413-01.tif, 1, en_US]

Figure 5-11 Examples of Notification Windows

Dialogs
Dialogs are interactive notification windows in the base bar. In the dialogs, you are prompted to actively carry
out actions. A dialog consists of the following elements:

• Dialog designation

• 2 softkeys (bottom left and right)

• Text information with interactive text box or list boxes
You confirm the context-dependent command prompts offered here by pressing the softkeys below the
prompts.

[scdialpa-080413-01.tif, 1, en_US]

Figure 5-12 Dialog for Entering the Confirmation ID

[scdiawrt-080413-01.tif, 1, en_US]

Figure 5-13 Dialog for Entering a Value

If a command prompt is shown in the dialog, then you can activate the functions in the following list by
pressing the softkeys below each function.
Softkey
Left

Function Softkey
Right

Function

Delete Delete log Enter Confirm value
ESC Cancel current action Ok Confirm action
Logout Log out Login Log in
Start/Test Start an action Menu Main menu
Switch Switch equipment Change Change value

5.6
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ii NOTE
If you do not confirm the dialog with a softkey, the action you wish to achieve is canceled after a previously
set time. The prior state is restored.
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Displaying Device Mode
Not Initialized Device (As-Delivered Condition)

SIPROTEC 5 devices are not initialized in the as-delivered condition. If a non-initialized device is connected to
the auxiliary voltage and started, then the following information is shown on the display:

• Device variant

• Firmware version

• Serial number

• Prompt Initialize device

ii NOTE
You may only initialize the device via DIGSI 5 and only then via the USB connection of your SIPROTEC 5
device.

Refer to chapter 9 Commissioning for more information on initializing and commissioning.

Initialized Device
The device can be in the following modes:

• Commissioning mode

• Simulation mode

• Process mode

• Fallback mode
In normal operation (process mode), the device is presented as described in chapter 5.4 Structure of the Menu

ii NOTE
The device can change the mode during commissioning, when in application mode or in the event of
a device failure. The mode deviating from normal operation is shown respectively in the title bar of the
device display. The name of the mode is shown flashing in the top line of the device display (except in
fallback and process mode):

• Commissioning mode

• Simulation mode
Take note of the information about these modes in chapter 9 Commissioning and chapter 10 Maintenance,
On-the-Spot Assistance and Test.

Commissioning Mode
The commissioning mode of the SIPROTEC 5 device allows you to check the existing wiring without affecting
or blocking the protection functions or other functions of the device. You can select the commissioning mode
manually.
You can find more information in Chapter 9.2.2 Testing Current and Voltage Inputs.
In commissioning mode, you can also check the communication with systems control technology. You can
generate test signals with the communication test in DIGSI by setting signals to be transmitted systematically
in the transmitter and checking their receipt.
You can find more information in chapter 9.4.3 Testing Interfaces in the Compound System.

Simulation Mode 
In the simulation mode of the device, you can check the correct setting of protection functions and the
routing of signals. You can perform simple checks without wiring or using DIGSI. To do so, connect the

5.7
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device to DIGSI and generate test sequences. You can perform the tests on the device without external test
equipment. The DIGSI test sequences simulate the change of values at the inputs to the device.
You can also feed in the test signals using a digital test equipment. Digital test equipment offers you multiple
test programs and test sequences.

Process Mode
The process mode is the normal operation of the device.
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Display of Routings and Status
You can route logic information from the SIPROTEC 5 device to binary inputs, binary outputs and LEDs. The
menu item Binary IO of the device lets you display the routing of the logical signals and their status.
In order to display the routings in the SIPROTEC 5 device, proceed as follows:

• In order to access the Binary IO from the main menu, use the navigation keys of the on-site operation
panel:
Main menu → Binary IO

• Use the navigation keys of the on-site operation panel to navigate within the displayed list and select one
of the 3 following menu entries:
– Binary inputs
– Binary outputs
– LEDs

[scbinipt4-260814-01, 1, en_US]

Figure 5-14 Binary IO Menu Item

The following examples show how to proceed when reading the on-site operation panel and how to set the
DIGSI for the binary input in the information routing.

• Select the menu item Binary inputs.
All available binary inputs of the SIPROTEC 5 device will be displayed. Furthermore, following the equal
sign, the current status of the binary input is displayed (see Figure 5-15).

The following table shows the meaning of the status of the individual menu entries Binary inputs, Binary
outputs, and LEDs.
Menu item Status Meaning
Binary input X Input is active

– Input is not active
Binary output X Output is active (contact is closed)

– Output is not active (contact is open)
LED X LED is switched on

– LED is switched off

The status of the respective binary inputs, binary outputs or the LEDs is updated automatically by the actual
state in the device.

5.8
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[scbinipt5-260814-01, 1, en_US]

Figure 5-15 List of Binary Inputs

• Use the navigation keys to select the binary input, for example Binary input 1.1.
All signals routed to binary input 1.1 are displayed as a list (see Figure 5-17).

Example of a Signal

• Go to the information routing in DIGSI 5 and select the properties H or L for the input >Ext. trip
initiation off.

This status will also be displayed on the on-site operation panel of the SIPROTEC 5 device. Figure 5-16 and
Figure 5-17 shows you the routing of signal >Ext. trip initiation, for stage 1.
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[scranma1-260814-01, 1, en_US]

Figure 5-16 Entry in Information Routing

Figure 5-17 shows that [L] active without voltage for signal >Ext. trip initiation was para-
meterized. In the Line function group, the Overvoltage protection (ANSI 59) is also operated. In addition, the
binary input 1.1 can also block this protection function. The blocking function will become active with [H]
active with voltage.

[scbinipt1-260814-01, 1, en_US]

Figure 5-17 Status of Binary Input 1.1
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Example of a Circuit Breaker
A circuit breaker can have the status open or closed. Figure 5-18 displays the various properties of the circuit
breaker in the information routing of DIGSI 5.

[scranma2-260814-01, 1, en_US]

Figure 5-18 Properties of the Circuit Breaker

The following figure shows an example of the routing of the circuit-breaker switch position. Here, the binary
input 1.1 shows the closed circuit-breaker switch position 1. [GH] indicates that the voltage on binary input
1.1 is active and signals a closed circuit breaker.

[scbinipt2-260814-01, 1, en_US]

Figure 5-19 Circuit-Breaker Status on the On-Site Operation Panel
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Example of a Transformer Tap Changer
You can also use a binary input to display the tap position of the transformer tap changer. In this case, you
must set the X (routed) property in the DIGSI 5 Information routing (see figure below). X (routed) means that
the binary input was routed.

[scranma3-260814-01, 1, en_US]

Figure 5-20 Example of Transformer Tap Changer 1

The figure below shows that binary input 1.1 displays the tap position of transformer tap changer 1.

[scbinipt3-260814-01, 1, en_US]

Figure 5-21 Setting of Transformer Tap Changer 1
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General
DIGSI 5 is the engineering and operating tool for all SIPROTEC 5 devices. With DIGSI 5, you create system
topologies, configure hardware and communication networks and perform many other tasks.
You carry out all engineering tasks offline from your PC without needing a SIPROTEC 5 device. You transfer all
data online to the device later – for example, directly via a communication network or the USB interface. For
communication between DIGSI 5 and the SIPROTEC 5 device, secure TCP-IP connections are used.
Operation of DIGSI in version 5 is even more user-friendly. Project tree, editors, libraries and property window
are integrated smoothly into a common interface. You can adjust this interface to your operation.

Project, Project View and Project Navigation
After starting DIGSI 5; you are shown the project view. It is initially empty and fills up with content as soon as
you create a new project or open an existing one.

[scproans-110413-01.tif, 1, en_US]

Figure 6-1 Example of a Project View

DIGSI 5 manages all components of a system and all associated data depending on the project. The following
values are summarized under one project name (extract):

• Topology

• Devices

• Setting values

• Communication settings

• Process data
That means you must open a project file and thus have all data available. Vice versa you save all changes of
any type with only one mouse click.
On the interface you see a project with symbols that are integrated into a hierarchical project structure. These
symbols represent:

6.1
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• Individual devices

• Editors

• Setting sheets

• Tables

• Actions

• Folder
You have access to all data and tools via the individual symbols. A double-click is enough and the symbols will
show setting values of protection functions, start actions such as loading of parameter values or open one of
the editors.
DIGSI 5 is available in 3 variants. Please refer to the order catalog and the DIGSI 5 online help for the exact
functional scope. DIGSI 5 Premium offers, among others, the following possibilities:

• Managing all SIPROTEC 5 devices of a system in a project

• Defining the primary topology in a Single-Line Editor

• Simple setting of protection settings and control of setting values via zone diagrams

• Creation and testing of logic symbols in CFC plans

• Creation of device displays for the different device display variants

• Control of devices and management of process data

• Communication with one or more devices via direct communication connections

• Testing of parameterization of a protection device using the DIGSI 5 Test Suite

Using DIGSI 5
6.1 General
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Operator Control Actions in the Offline and Online Area
You can execute operator control actions in the offline configurations or online on the device.

ii NOTE
To avoid unintentional changes and switching operations during operation, some operator control actions
must be acknowledged with a confirmation ID.
Protect access to your protection devices using a secure connection password. This will prevent undesirable
changes by third parties.

Offline Area (Project View)
The offline configurations indicated offline in a project include all data to be edited of a protection device
on the engineering PC. There is no connection to a physically existing device. You can execute the following
actions in the offline area:

• Creating a topology as a single-line diagram

• Adding SIPROTEC devices to the topology

• Configuring hardware of a SIPROTEC device

• Defining functional scope of a SIPROTEC device

• Entering individual function settings and displaying characteristic curves graphically

• Routing information

• Editing display diagrams

• Designing logic functions such as interlocking mechanisms

• Configuring the communication network and setting communication parameters

• Displaying save measured values and messages

• Displaying saved fault records and evaluating them with SIGRA

• Exporting and printing data

Devices Available Online (Online Mode)
In online mode there is a connection between a PC and a device. In this mode you can carry out the following
actions:

• Transferring setting values from the PC to the SIPROTEC device

• Transferring setting values from the SIPROTEC device to the PC and saving in files

• Transferring indications, measured values and fault records from the SIPROTEC device to the PC and
saving in files

• Setting limiting values

• Executing test functions

• Controlling equipment, placing markers and canceling blocks

• Executing initial start or restart of the SIPROTEC device

• Setting date and time

• Changing confirmation IDs and passwords

• Adding devices to projects

• Complete processing of devices

6.2
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ii NOTE
If you change setting values or routings in online devices, you must activate them in the device. This
ensures consistent acceptance of data.

Using DIGSI 5
6.2 Operator Control Actions in the Offline and Online Area
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Initializing a Device

ii NOTE
Initialization is possible, for example, via the USB interface or port J of the device.

ii NOTE
The physical connection between PC and SIPROTEC 5 device may be done only 1 to 1. If your PC has several
free USB interfaces, you can connect only one single SIPROTEC 5 device. Otherwise, no connection to the
devices is established. If you set up a hub between PC and the SIPROTEC 5 devices, no connection to the
devices is established either.

Connect the top USB port on the front panel of the on-site operation panel of the base module of SIPROTEC 5
devices to the engineering PC using a suitable USB cable. If you have connected the protection device to your
PC, you can initialize the device with the help of DIGSI 5.

• Select the relevant offline configuration in a DIGSI 5 project by selecting the device name.

• Open the context menu by right-clicking.

• Select Initialize Device.

• The offline configuration is thereby transferred to the device and the offline configuration in the DIGSI 5
project connected via the serial number of the device.

Check whether there is a connection between your DIGSI 5 project and your device. If you wish to compare
the serial number in the editor and the device information with the label of the device, proceed as follows:
² Double-click in the project tree the Device information tab under the device. You will find the serial

number in the General section.

6.3
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Transferring device data from the PC to the device

ii NOTE
If the protective devices are connected to the engineering PC, the transfer of device data to one or more
devices is possible. For this purpose, you must initialize the devices once with DIGSI 5.

If you would like to transfer device data from the PC to the device, then connect the device to the PC. You can
use the following terminals for this purpose:

• USB port on the on-site operation panel of the base module

• Any Ethernet interfaces of the device

² Check whether there is a connection between your DIGSI 5 project and your device.

² Compare the serial number in the editor and the device information to the label of the device.

² To do this, double-click in the project tree on the Device Information menu item under the device. You
will find the serial number in the General section.

Establishing connection via USB

² Connect the top USB port on the front of the on-site operation panel of the base module of
SIPROTEC 5 devices to the engineering PC using a suitable USB cable.

² In the project tree of your DIGSI 5 project, double-click on the Load Configuration to the Device menu
item in the corresponding offline configuration of the device.

² Enter the confirmation ID for the user.
DIGSI 5 recognizes automatically that the device is connected via USB and the loading of configuration from
the DIGSI 5 project to the device is initiated.

Establishing connection via Ethernet

[scipadrs-080413-01.tif, 1, en_US]

Figure 6-2 Setting the IP address

² Connect, for example, the Ethernet port J on the rear of the SIPROTEC 5 base module to the engineering
PC using a suitable Ethernet cable.

² In the project tree of your DIGSI 5 project, double-click on the Devices and Networks menu item.

² In the network view you will find all devices of your project with the offline configurations. Select the
device to which you would like to connect and click on the green-edged field of the displayed device (see
Figure 6-2).

² Enter the IP address, subnet mask and optionally the IP address of a router (standard gateway).

² In the project tree of your DIGSI 5 project, double-click on the Load configuration in devices menu item.
Execute this in the corresponding offline configuration of the device.

6.4
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DIGSI 5 recognizes automatically that the device is connected via Ethernet. The loading of the configuration
from the DIGSI 5 project to the device is then initiated.

ii NOTE
If you wish to use an Ethernet interface port other than port J, go to Device Information to select the
interface by which DIGSI 5 should communicate with your SIPROTEC 5 device.

Alternatively, you can select the following path for the setting of the Ethernet address.

[scipruec-030311-01.tif, 1, en_US]

Figure 6-3 Rear panel of a SIPROTEC 5 device

[sciprueccc-090221, 1, --_--]

Figure 6-4 Rear Panel of a SIPROTEC 5 Compact Device

² Connect, for example, the Ethernet port J on the rear of the SIPROTEC 5 base module to the engineering
PC using a suitable Ethernet cable.

² In the project tree of your DIGSI 5 project, double-click on the Devices and Networks menu item.

² You will find all devices of your project with the offline configurations in the Device View tab. Select the
device with which you would like to connect and click on the Ethernet port of the displayed device (see
Figure 6-3).

² Enter the IP address, subnet mask and optionally the IP address of a router (standard gateway).

² In the project tree of your DIGSI 5 project, double-click on the Load configuration in devices menu item.
Execute this in the corresponding offline configuration of the device.

DIGSI 5 recognizes automatically that the device is connected via Ethernet. The loading of the configuration
from the DIGSI 5 project to the device is then initiated.

ii NOTE
If you wish to use an Ethernet interface port other than port J, go to Device Information to select the
interface by which DIGSI 5 should communicate with your SIPROTEC 5 device.

Using DIGSI 5
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Changing Data on the Online Device
Always execute changes in the project tree of the selected device and load the changes to the device. Proceed
as follows:
² In your project, click the node of the selected device.

² Execute the desired changes, for example, in the settings.

² Select the device again and right-click the device.

² In the menu, select the item Load configuration to device.
DIGSI transfers the changed configuration data to the device. After a successful transfer, the device restarts.

6.5
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Retrieving Fault Records and Log Contents
Proceed in online mode as described in chapter 6.4 Transferring device data from the PC to the device. Load
the parameterization and read process data from the device.
² Link the matching offline configuration in your project to your online device.

² To do this, drag the online device in the project tree onto the matching offline configuration via Drag &
Drop.

You will recognize the connection by the change in name of the online device, which has now assumed the
name of the offline configuration with the remark assigned in brackets.
² Open the display of the logs by double-clicking in the tree the Indications node.

² To open the log content, click in the toolbar of the Operational log or Fault log on Read log entries.

² To display the fault records available in the device, open the node of the logs and click the Read records
button.

When reading fault records, fault indications are automatically retrieved as well and become available to you.
The log content as well as fault records are thus saved simultaneously as well in the linked offline configura-
tion. You can also archive all entries as files which you can further edit in Microsoft Excel for example.

6.6
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General
Apart from the use of an engineering tool such as DIGSI 5 or SICAM TOOLBOX II for configuration and
maintenance, SIPROTEC 5 devices provide a Web front end that can be used with a standard Web browser.
The browser-based user interface is a comprehensive commissioning and monitoring tool that provides an
easy-to-understand display of the most important measured data. You can operate the device remotely or
locally using the browser-based user interface and a Web browser.
Apart from the use of an engineering tool such as DIGSI 5 for configuration and maintenance, SIPROTEC
5 Compact provides a Web front end that can be used with a standard Web browser. The browser-based
user interface is a comprehensive commissioning and monitoring tool that provides an easy-to-understand
display of the most important measured data. You can operate the device remotely or locally using the
browser-based user interface and a Web browser.
The browser-based user interface can be used via a communication network:

• During commissioning
– Checking and adjusting the values of a specific setting
– Comparing the values of 2 or more devices
– Checking a setting value against a user-defined setting to verify whether the setting value differs

from the default value specified by Siemens

• During an inspection
– Querying a value in order to adjust a test case, for example to preset the tripping current
– Viewing all types of measured values, for example functional measured values and derived values

such as the minimum/maximum and mean values
– Displaying the deviation of the expected measured-value quality.

• While operating the device
The browser-based user interface is especially optimized for the protection system and provides comprehen-
sive support during testing and commissioning from the PC or laptop computer.
All relevant device information and setting options are displayed graphically on the screen.

7.1

Operation Using a Browser-Based User Interface
7.1 General
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Operation
If you are familiar with the structure of the settings in DIGSI 5 and on-site operation, you can navigate through
the same structure (for example you can use the browser-based user interface to navigate function groups,
function blocks, and the diagram on the on-site operation panel).
The PC that you wish to use to operate the SIPROTEC 5 device must be connected to the device via a network
cable. The PC and the SIPROTEC 5 device must be switched on.
Before you operate the device using a Web browser, you first have to check the security settings. The security
settings allow you to restrict the access rights for Web access (RJ45 and Ethernet communication module).
You can define the security settings in DIGSI in the project tree under Security → Network access security.
You can assign the following access rights:

• No access:
This interface does not allow access to the device.

• Read-only access:
This interface allows access to the device for reading purposes only.

• Read/write access (default setting)
This interface allows read/write access to the device.

To operate the device via the browser-based user interface, proceed as follows:

• Connect the SIPROTEC 5 device (for example RJ45 port) to your PC using a network cable.

ii NOTE
If the device has an Ethernet communication module, you can also use ports E, F, N, or P (for SIPROTEC 5
Compact: port F) or you can access the device via the USB interface.

ii NOTE
To access the device via the USB interface, use the following IP address: 192.168.2.1.

In order to access the device via the integrated RJ45 port, define the following setting under Network access
security in DIGSI:

[sc_webaccess, 2, en_US]

Figure 7-1 Security Setting in DIGSI

ii NOTE
Note the IP address and the port number of the interface used for communication between the PC and
the browser-based user interface. Make sure that the 12-digit IP address for the Web browser has been
correctly set using the format ***.***.***.*** via DIGSI.

ii NOTE
When selecting the web browser, note that Internet Explorer is not supported.

• Launch the Web browser on your PC.

• Enter the IP address of the device in the address line of the Web browser, followed by the port number
4443, for example https://172.16.60.60:4443, and confirm the entry using the ENTER key.

7.2
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ii NOTE
You may operate the SIPROTEC 5 device using DIGSI 5 and using the browser-based user interface in
parallel.

ii NOTE
Some Web browsers may have problems connecting to the specified IP address of the device; in this case,
delete the associated certificate in the Web browser.

Depending on the security configuration of the SIPROTEC 5 device, the following log-in dialogs are available:

• Variant 1:
If you allocated a connection password in DIGSI 5 under Operational Safety and Access Control, the
log-in dialog will start with the noneditable user name SIPROTEC 5. You must enter the connection
password configured in DIGSI as the password.

• Variant 2:
If you have configured the role-based access control (RBAC) in DIGSI 5 under Operational Safety and
Access Control, the log-in dialog will start by querying the user name and password that you configured
on the RADIUS server.

• Variant 3:
If you have configured neither the role-based access control nor the connection password, the log-in
dialog will start with the noneditable user name SIPROTEC 5. The text box for the password must remain
empty.

Once the Web browser is successfully connected to the device, the following log-in dialog (for Variant 2) will
appear, for example:

[sc_web_monitor, 1, en_US]

Figure 7-2 Log-in Dialog for the Browser-Based User Interface

• Enter the user name in the text box User name.

• Click on the text box Password and enter the password.

• Select a language.

ii NOTE
If role-based access control (RBAC) is active, access is possible only after a successful user name and
password authentication check.
You will find more information on this in the Security Manual.
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ii NOTE
The language selection depends on the language set for the user interface of the device.

• Click on the button with the checkmark.

[scwebmonitor_enter, 1, --_--]

Figure 7-3 Confirmation Button

Following successful login, the following buttons are available:

[scwebmonitor1, 6, en_US]

Figure 7-4 Buttons for the Browser-Based User Interface

You can view the corresponding sections, or you can edit them by clicking on the individual buttons.

Timeout

ii NOTE
If you do not perform any action on the browser-based user interface within a defined time range, the
Web browser disconnects from the device.

The following messages appear:

[sc_web_monitor_session_timeout, 1, en_US]

Figure 7-5 Time-Out
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After a certain time has elapsed, you must log on to the device again using the Web browser (see Figure 7-5).

Confirmation ID
You can activate the confirmation ID for editing device settings in DIGSI 5 under Operations safety and
access control. This will be queried once, before the first changes are made to the device settings in the
browser-based user interface.

[scaccesscontr, 1, en_US]

Figure 7-6 Activation of the Confirmation IDs

If you have activated the confirmation ID, the following dialog appears after having changed a setting:

[scconfid, 1, --_--]

Figure 7-7 Query for the Confirmation IDs

After entering the confirmation ID, the change is made to the setting.

Other Buttons

Table 7-1 Overview of Buttons

Button Meaning
Use the Menu button to log off or restart the device.

Use this button to adopt the changed parameter and save on the device.

Use this button to refresh the displayed page.

If you change device settings, read out fault records, and execute other write
accesses via the Web browser, you can check the result using this button. You
can leave the displayed list by clicking this button again.
Use these buttons to filter the displayed list or to delete the entire list.

Use this button to control an LED reset.

Operation Using a Browser-Based User Interface
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Button Meaning
Use this button to access the home screen and the list box.

Use this button to start generating a fault record.

Use this button to start an export (such as for an operational indication).

Use this button to pause data transmission.

Use these buttons to switch the measured values and statistical values to
primary, secondary, or percentage values.
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Restart the Device
You can also restart a connected device using the browser-based user interface, as required.

• Log on as a standard user:
– Click the Menu button in the top left corner of the screen. The following menu opens:

[sc_reset_dev, 1, en_US]

Figure 7-8 Device Reset
– Click Restart device.
– Confirm the dialog with the Check mark.

[sc_confirm_reset, 1, en_US]

Figure 7-9 Confirm Restart
– Enter the confirmation ID.

[scconfid, 1, --_--]

The device is restarted as soon as the confirmation ID is validated.
The device restart can take up to 2 min.

[sc_reset_action, 1, en_US]

Figure 7-10 Reset Process
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The restart of the device is completed with the following message:

[sc_reset_fin, 1, en_US]

Figure 7-11 Successful Restart

• Log on with Role-Based Access Control (RBAC).
– Log on to the device using the RBAC user data.
– Click Menu in the top left corner of the screen.
– Click Restart device.
– Confirm the dialog with Yes.

If you have authorization to restart the device, the device is restarted. Note: In this case, no
confirmation ID is queried.

– If you do not have any access rights (for example Viewer role), the following error message is
displayed:

[sc_reset_dev_no, 1, en_US]

Figure 7-12 Error Message

Structure of the User Interface
You can navigate via the displayed buttons or via the list box, as required.
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Using the buttons or the list box, you can change the settings of the connected device, check them, or call up
and export information.

[scnaviwebmon, 5, en_US]

Figure 7-13 Overview of Buttons

(1) Open the list box
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Buttons

General

The buttons and submenus of the browser-based user interface are described using the example of a
transformer protection device.

ii NOTE
Depending on the device variant, different buttons and submenus are available for the browser-based
user interface.

Device

[scwebmonitorGK, 2, en_US]

Figure 7-14 SIPROTEC 5 Button

Device information such as the product code, MLFB number, the firmware version of the device, or the current
operating mode of the device are displayed using the SIPROTEC 5 button.

[scwebmonitor2, 3, en_US]

Figure 7-15 Device Information

Engineering

2 buttons are available:

7.3

7.3.1

7.3.2

7.3.3
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[scwebmonitorEK, 2, en_US]

Figure 7-16 Buttons for Engineering

Settings:
The favorite settings and an overview of the function groups are displayed using the Settings button.

[sccaracterui3o, 1, en_US]

Figure 7-17 Settings Buttons

Favorite settings:
Use the Favorite settings button to view the favorite settings in the browser-based user interface. Use the
Favorite settings in DIGSI 5 to avoid having to navigate through many protection functions to update a
parameter.
Upload the frequently used parameters in DIGSI 5 that you define as favorites to the device as a configuration.

[sccaracterui9, 1, en_US]

Figure 7-18 Favorite Settings in DIGSI 5
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You can display the parameter settings using the browser-based user interface under the Favorite settings
button.

[sccaracterui10vv, 1, en_US]

Figure 7-19 Button for Favorite Settings

[sccaracterui11, 1, en_US]

Figure 7-20 Favorite Settings on the Browser-Based User Interface

Function Groups:
If you want to display, edit and save parameters or characteristic curves of a function group in the device via
the browser-based user interface, proceed as follows:

Open the button of the function group with characteristic curves – for example, Line 1.

[sccaracterui3, 1, en_US]

Figure 7-21 Buttons of the Function Groups
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Select the button of the function whose parameters or characteristic curves you want to display (example:
OC-3ph-B1).

[sccaracterui4, 1, en_US]

Figure 7-22 Button of the Function

When you click the button, the parameters and characteristic curves are loaded.

[sccaracterui5, 1, en_US]

Figure 7-23 Loading the Settings

Change the parameters or get yourself acquainted with the parameters and the function characteristics.

[sccaracterui6, 1, en_US]

Figure 7-24 Overview of Function Parameters
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Show or hide each function characteristic by clicking on the appropriate legend name (4). Determine the
operating points of the characteristic curves (2) online.

[lecaracterui12vv, 1, en_US]

Figure 7-25 Function Characteristics and Online Operating Points

1) Protection function name
2) Online operating points
3) Legend for online operating points
4) Legend names of the characteristic curves
5) Tooltip

Use the scroll wheel to zoom in or out the characteristic curves in the view.

[lecaracterui14vv, 1, en_US]

Figure 7-26 Zooming in the View

The current and voltage values fed into the device in real time are displayed as operating point curves via the
offline characteristic curves. They are dynamically updated based on the values fed in real time. You can show
or hide any online operating point by activating or deactivating online legends.
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ii NOTE
To update dynamically in real time, the user must reload the page.
Limitation V09.50: 21 distance protection online operating points are not visible. The user cannot see the
user curves.

Date & Time:
You can use the Date & Time button to adjust the date and time of the device via the browser-based user
interface.

[scwebmondati, 1, en_US]

Figure 7-27 Setting the Date and Time

Controlling

[scwebmonitorSK, 1, en_US]

Figure 7-28 Button for acquisition blocking

7.3.4
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Pressing the Acquisition blocking button opens the following menu, depending on the functions incorpo-
rated in your SIPROTEC 5 device:

[scmenuacquisition, 1, en_US]

Figure 7-29 Acquisition blocking buttons
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Clicking the All acquisition blocked signals button, displays the status of all blocked signals of the SIPROTEC
5 device.

[scacquisimanall, 1, en_US]

Figure 7-30 Button to display the blocked signals

If you want to block or manually update signals, select the button corresponding to the function (see
Figure 7-31). The displayed buttons allow you to select the Tracking or setting of the Acquisition blocking.
Before modified settings or the activation of control commands is accepted, there will be additional requests
to enter the confirmation ID. A change to the setting becomes effective immediately.
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This is shown in the following figure, using the circuit breaker 1 button as an example.

[scacquisimanupd_cb, 1, en_US]

Figure 7-31 Setting Acquisition Blocking and Manual Updating
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If you route the Acq.blocking active signal to, for example, log U1 in the DIGSI information routing of
the SIPROTEC 5 device, the signal is set as follows:

[scacquisipara, 1, en_US]

Figure 7-32 Information Routing

If the number of blocked signals changes from 0 to >0, the Acq.blocking active signal is set to
incoming.
If the number of blocked signals changes from >0 to 0, the Acq.blocking active signal is set to
outgoing.

[scacquisilog, 1, en_US]

Figure 7-33 Content of the routed log

For further information, see 8.9.7 Acquisition Blocking and Manual Updating.

Monitoring

[scwebmonitorUK, 3, en_US]

Figure 7-34 Monitoring Buttons
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3 buttons are available:

• Display Pages:
The device’s current single-line diagram that you have configured in DIGSI under Display Pages is
displayed via the Display Pages button. You can select the pages individually, as on the SIPROTEC 5
device. The displayed values are constantly updated and cannot be changed. Alarms, which are classified
as acknowledgeable alarms, are shown in the right hand side section of the display.

[scwebmonsilidi, 2, en_US]

Figure 7-35 Diagram and Alarm Presentation

Alarms:
You can classify user-defined signals and SPS signals as well as ENS type failure indications from the
Alarm handling and Device function blocks as an alarm within the information routing. You can select
a status as an alarm via the properties of the user-defined signal or SPS signal. The following Alarm
classifications are available:
– Warning
– Alarm
– Acknowledgeable alarm

[scwebmonalarmclass, 1, en_US]

Figure 7-36 Alarm Classification and Position in DIGSI 5

Via Position you can set the position of the alarm within the alarm log and in the list on the display
page. If several alarms use the same position value, then the sequence within the information routing
determines their position in relation to one another.
The color differentiation of the example alarm indications is shown in the following list:
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– → Blue: The alarm is inactive.

[scalarm_button1, 1, en_US]

– → Red with check: The alarm is active and has not been acknowledged.

[scalarm_button4, 1, en_US]

– → Red: The alarm is active and has already been acknowledged.

[scalarm_button3, 1, en_US]

– → Gray: The alarm is invalid.

[scalarm_button2, 1, en_US]

– → Green: The alarm was active previously, is inactive and has not been acknowledged.

[scalarm_button5, 1, en_US]

For further information, refer to 7.3.9 Diagnostics.

• Logs:
The log is displayed using the Logs button. You can view the content by clicking on the desired log
and can download it in CSV format. You will find more information about the process using examples in
7.4.1 General. Depending on the device, the following logs are available:

[scwebmonitor3, 3, en_US]

Figure 7-37 Menu of the Logs
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• Runtime data:
The state of all signals is displayed using the Runtime data button. The following runtime data may be
viewed, depending on the device:

[scwebmonitorRD, 1, en_US]

Figure 7-38 Runtime Data Menu
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The following figure shows an example of the state and quality of inputs and outputs under the
General button:

[sclaufzeitzustqual, 1, en_US]

Figure 7-39 State and Quality of Inputs and Outputs

Measured Values

[scwebmonitorMK, 2, en_US]

Figure 7-40 Measurements Buttons
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3 buttons are available:

• Operational values:
An overview of the function groups is displayed using the Operational values button. The measured
values can be displayed by clicking on the desired function group. For a detailed description, with
examples, refer to 7.4.1 General.

[scwebmonitor15, 2, en_US]

Figure 7-41 Example of Operational Values
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• Function values:
An overview of the function groups can be displayed using the Function values button.
The functional measured values can be displayed by clicking on the desired function group (see
Figure 7-42).

[scwebmonitor16, 2, en_US]

Figure 7-42 Example of Functional Measured Values
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• Statistics:
An overview of the function groups providing statistical values is displayed using the Statistics button.
Statistical values, for example device operating hours, can be displayed by clicking on the desired func-
tion group (see figure below).

[scwebmonitor18, 2, en_US]

Figure 7-43 Statistics

Terminal Assignment

[scwebmonitorKK, 2, en_US]

Figure 7-44 Terminal Assignment Buttons
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3 buttons are available:

• Binary inputs:
An overview of the connected binary inputs is displayed using the Binary inputs button. You can display
the assignment of the binary inputs for this module by clicking a button in the left section (for example
base module). For a detailed description with examples refer to 7.4.1 General.

[scwebmonitor10BI, 1, en_US]

Figure 7-45 Assignment of Binary Inputs

• Binary outputs:
An overview of the connected binary outputs is displayed using the Binary outputs button. You can
display the assignment of the binary outputs for this module by clicking a button in the left section (for
example base module).

[scwebmonitor10BO, 1, en_US]

Figure 7-46 Assignment of Binary Outputs
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• LEDs:
An overview of the connected LEDs is displayed using the LEDs button. You can display the assignment
of the LEDs for this module by clicking a button in the left section (for example base module).

[scwebmonitor10LED, 1, en_US]

Figure 7-47 Assignment of LEDs:

Recording

[scwebmonitorSS, 1, en_US]

Figure 7-48 Fault-Recorder Button

The Fault recorder button can be used to call up the fault records of the standard recorder. Additional
datasets are available for the 7KE85 fault recorder (Figure 7-49). For a detailed explanation using examples
see 7.4.1 General. 

[sc_faultrec-ke, 1, en_US]

Figure 7-49 Additional Buttons on the 7KE85

7.3.8
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If necessary, you can export the datasets in COMTRADE format, and the extended datasets as native,
COMTRADE and PQDIF formats.

[dwfaultreclist_220630, 1, en_US]

Figure 7-50 Example of a Fault-Record List

(1) Display a fault record
(2) Trip a fault record
(3) Download a fault record
(4) Delete a fault record
(5) Activate instant filter
(6) Reset the instant filter
(7) Reset the sorting
(8) Optimize the column width

• Display a fault record
– Click Display a fault record, in order to visualize the fault record in a graphic form. The associated

metadata will also be displayed. You can select any fault records you wish.

• Trip a fault record
– Click Trip a fault record, to start the recordings of the fault records.

• Download a fault record
– Click Download a fault record, to download and save the fault records in the Download folder. You

can select any fault records you wish.

• Delete a fault record
– Click Delete a fault record, to delete the fault record in the device and to change the current

session to the Downloaded status. You can select any fault records you wish.

• Activate instant filter
– Select a value or a text in the fault-record list.
– Click Activate instant filter.

The fault record list filtered according to the selection will be displayed.

• Reset the instant filter
– Click Reset the instant filter, to switch off the instant filter again and to restore the original

fault-record list.

• Reset the sorting
– You can carry out any sorting in the fault-record list. Click Reset the sorting, to reset the entire

sorting in one of the columns.
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• Optimize the column width
– Click Optimize the column width, to optimize the column width according to the text size.

Display area
The buttons of the fault-record graphic are displayed in the following figure:

[dwfaultrecdiagr_220627, 1, en_US]

Figure 7-51 Example diagram of a fault record

(1) Primary values in the graphic
(2) Secondary values in the graphic
(3) Slider zoom control – zoom in/zoom out for the selected area
(4) Zoom for the selected section
(5) Display the values if the mouse pointer moves over the diagram
(6) Reset to standard zoom
(7) Meta data – Information on the fault record

Diagnostics

[scwebmonitorDI, 3, en_US]

Figure 7-52 Diagnosis Buttons

7.3.9
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3 buttons are available:

• Alarms:
The Alarms button displays the possible device warnings, alarms and acknowledgeable alarms in one
table: 

[scAlarmAndWarningList, 2, en_US]

Figure 7-53 Alarm List

You will find more information on this under 7.3.5 Monitoring.

• Function modes:
The Function modes button displays the functions that are inactive or switched to application mode,
depending on the device:

[scInactiveFunctionsList, 2, en_US]

Figure 7-54 List of functions
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• DiagLogs:
You can display the device-diagnosis logs by using the DiagLogs button:

[scdevdialog, 2, en_US]

Figure 7-55 Device-Diagnosis Log

Administration

[scwebmonitorVW, 3, en_US]

Figure 7-56 Certificate Buttons

ii NOTE
You can find more information on this in chapter 6 of the security manual (C53000-H5040-C081).

If you want to administer a certificate, you can switch to the certificate management by clicking on the
Certificates button. 

[scwebmonitorZV, 1, en_US]

Figure 7-57 Certificate Management Buttons
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3 buttons are available:

• Certificates in use:
By clicking on the Certificates in use button, you can check which communication area a certificate
is being used for. In this case, you also have the option of loading another certificate into the device
or deleting an existing one.

[scwebmonitorZE, 1, en_US]

Figure 7-58 Selecting a Certificate

(1) Loading a certificate into the device
(2) Current certificate data, for example DIGSI: Integrated port J
(3) Deleting the certificate

• Certificate authorities
By clicking on the Certificate authorities button, you can display the imported certificates that you have
loaded into the device.

[scwebmonitorZS, 1, en_US]

Figure 7-59 Certificate Authorities

• Requested certificates
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By clicking on the Requested certificates button, you can display the certificate currently being
used in the device for example DIGSI: Integrated port J, and then export it.

[scwebmonitorZA, 1, en_US]

Figure 7-60 Requested Certificates

(1) Current certificate, for example DIGSI: Integrated port J
(2) Exporting the certificate

Service

[scwebmonitorSV, 2, en_US]

Figure 7-61 Support Button

If the device has a technical problem, you can use the Support button to generate a dataset. This dataset
contains only data from the internal device error memories and no configuration data. If necessary, you can
provide the dataset to the Customer Support Center. 

[scsupportservice, 1, en_US]

Figure 7-62 Support Data
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Examples

General

To illustrate working with the browser-based user interface, the procedure is shown using the following 2
examples:

• Reading and exporting operational indications from the device

• Changing the settings of a function group and saving them in the device
There must be a communication connection between the PC and the device. You can find more information
about device login in chapter 7.2 Operation.

Example 1: Reading Out Operational Indications

The operational log of the device can be read out and subsequently exported via the browser-based user
interface.
² Using a Web browser, log on to the device.

² Select the Logs button from the Monitoring menu.

[scwebmonitorUK, 3, en_US]

Figure 7-63 Logs Button

² Select the Operational log button or the Operational log item in the list box.

[scwebmonitor11, 2, en_US]

Figure 7-64 Reading the Operational Log
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The operational indications of the device are shown in a table.

[scwebmonitor4, 3, en_US]

Figure 7-65 Operational Indications

² To export the content of the log, select the following button:

[scwmbutton12_solo, 1, --_--]

Figure 7-66 Data Set Export

² Confirm the write operation by clicking on the tick.

[scexport3, 1, en_US]

Figure 7-67 Confirmation Dialog

² Start to export the log content by clicking on the Start download link.
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[scexport1, 1, en_US]

Figure 7-68 Export of the Log Content

² In the following dialog, select whether you wish to open or save the exported data.
Once you have saved, the content of the log will be available to you outside the device.

Example 2: Changing Settings

In this example, the vector group number in the function group Transformer page is changed using the
browser-based user interface.
² Log on to the device via a Web browser.

² In the Engineering menu, select the Settings button.

[scwebmonitorEK, 2, en_US]

Figure 7-69 Settings Button

² Click the buttons Transformer side 1 → General → Side data one after the other.

ii NOTE
You can also select the individual menu items via the list box.

[sctransf4_kompl, 1, en_US]

Figure 7-70 Function-Group Buttons

² In the selection dialog, select the new vector-group number.

7.4.3

Operation Using a Browser-Based User Interface
7.4 Examples

154 SIPROTEC 5, Operation, Manual
C53000-G5040-C003-L, Edition 03.2023



[scseitenda, 1, en_US]

Figure 7-71 Changing the Vector-Group Number

If you have activated the entry of a confirmation ID, proceed as follows:
² Enter the confirmation ID in the dialog.

[scconfid, 1, --_--]

Figure 7-72 Confirmation ID Dialog

² Confirm the entry by clicking the tick.

² Then, transmit the change to the device by clicking the tick in the upper menu area.

[scapplychange, 1, --_--]

Figure 7-73 Apply Changes

The change is applied and saved in the device.
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Overview
This chapter describes the handling of a SIPROTEC 5 device in the operating state. It contains the following
information:

• Reading information from the device

• Affecting the functions of the device in the operating state

• Controlling your system via the device
More detailed information about the function of the device is not needed. You must with be familiar with the
principles of operation according to chapter 5 Using On-Site Operation Panel and chapter 6 Using DIGSI 5.
Take note that the examples shown are general examples and in terms of wording and detail can vary on
the given device depending on variant and configured functional scope. Please refer to the respective device
manual for the process data that your device can process.

8.1

Operation in the Operating State
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Safety Notes and Access Rights

Safety Notes

Authorized Operational Crew

! DANGER
Danger due to inadmissible or improper operator control actions
Noncompliance with the safety notes will result in death or severe injuries.

² Only personnel who are skilled electricians with precise knowledge of the system may operate devices
during operation.

² Please carry out all operator control actions in the indicated sequence.

ii NOTE
Operator control actions are password-protected (see chapter 11 Security Settings in the Device). This
ensures that only operational crew members with access rights can use the device during operation.

8.2

8.2.1
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Operation Options

General

The device is operated via a DIGSI 5 PC or directly on the on-site operation panel. You have the following
operating options during operation:

• Readout of indications

• Readout, backup and deletion of logs and records

• Setting and resetting event counters

• Changing device settings such as date, time, display contrast (only on site on the device) and interface
language

• Changing passwords (only with DIGSI 5)

• Changing function parameters and switchover of settings groups

• Switching operating modes (for example, application mode)

• Controlling equipment

ii NOTE

DIGSI 5 Communication
Operation using a DIGSI 5 PC requires a functioning communication connection from the DIGSI 5 PC to the
device. For this purpose, you can use the USB interface of the on-site operation panel, the integrated or
other Ethernet interfaces.

ii NOTE

Prevention of Operating Errors

• Changes to device settings and the deletion of process data can be saved by entering confirmation
IDs. If no action takes place within certain times (device: 3 minutes, DIGSI 5: 10 minutes), an open
confirmation query is automatically terminated. Every action carried out within these times restarts
the time. After a confirmation query has ended you must confirm changes in device settings again by
entering confirmation IDs.

• Before modified settings or the activation of control commands is accepted, there will be additional
requests to enter the confirmation ID. You acknowledge these requests directly on the on-site opera-
tion panel by pressing the softkey buttons. You confirm the interactive dialog in DIGSI 5 by mouse
click.

Online Operation Using DIGSI 5

During online operation, you establish a direct connection to the device to be operated. You use this method
for:

• Commissioning

• Test and diagnostics

• Changing settings in the operating state
Online operation with DIGSI 5 is beneficial in these operating modes because you do not first have to create a
device in a project. As soon as you have created the corresponding device in a project, however, only operate
the device from there. Your settings are then saved on your PC and are available for offline configuration and
parameterization tasks.

8.3

8.3.1

8.3.2
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Procedure

² First identify all devices reachable via the PC communication interfaces. You can identify your device via
the DIGSI 5 project tree.

² Establish a connection to a selected device.

² If needed, you can assign a selected device to an existing project.

Device Identification via the DIGSI 5 Project Tree

² Select the utilized PC interface from Online access (a).

² Click the Update accessible devices button (b).
The accessible devices are displayed (c).

[scgerinf-090718, 1, en_US]

Figure 8-1 Device Identification via the DIGSI 5 Project Tree

Establishing a Connection to Selected Devices 
After device identification, the accessible devices are displayed in the project tree under the respective
communication interfaces of the PC.
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You can now establish a connection to the devices.

[scwalger-090718, 1, en_US]

Figure 8-2 Device Identification via the DIGSI 5 Project Tree

² Under Online access → Interface, open the desired device (a).
The basic information is displayed below the device.
You can find the following tabs in the menu item Device Information:

• Device information

• Resource consumption

• Log for device diagnosis and security

• Time Information

• Diagnostic information

² Click Refresh device data to read the parameter set and the process data of the device. The device data
is loaded and the view completed.

You can fully operate and set the connected devices under Online access in the DIGSI 5 project tree.

Adding a Selected Device to a Project
You can accept devices identified online into an existing project. The devices are also available for possible
offline operation. You can take over the devices in 2 different ways:
² Use Drag & Drop to assign the online device to the corresponding device created in a project.

ii NOTE
Make sure that the created device corresponds to the device identified online. Otherwise, it is not taken
over into the project.

² If you have not done so yet, add the online device to the opened project (see following figure) via the
context menu (right mouse click).
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[scprohin-080916-01, 1, en_US]

Figure 8-3 Adding a Selected Device Configuration to a Project

Offline Operation Using DIGSI 5

Offline operation offers you the ability to carry out complete configurations and extensive parameterization of
a device. Once you have finished all settings, you can load the configuration from the DIGSI 5 PC to the device.
If the loading operation was successful, the device restarts automatically.

Typical applications of offline configuration

² Creating a configuration by selecting a suitable application template and subsequently adjusting the
settings to the individual conditions

² Reusing a standardized configuration in multiple devices

² Extensive changes in configurations and setting parameters

ii NOTE
For a device to be editable offline, you must first have created it in a project. After successful loading of the
configuration, the device restarts automatically.

Procedure

² From the project tree, select the project containing the device to be operated.

² Select the respective device within the project.

² Open the device in the project tree.

² You can now carry out configurations and settings in offline mode.
All the corresponding submenus are listed in the project tree under the device name.

8.3.3
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[scproans-110413-01.tif, 1, en_US]

Figure 8-4 Offline operation of the device

² To establish a connection to the device, right-click the device and from the context menu that appears
select Assign device (Figure 8-5 a).

² Select Load configuration to device (Figure 8-5 by right-clicking from the context menu that appears b)
and enter the confirmation ID.

The configuration is transferred and the device restarts automatically after successful transmission.

[scgerzu-070916-01, 1, en_US]

Figure 8-5 Connecting to the Device and Loading the Configuration in Offline Mode
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Using the On-Site Operation Panel

You can operate the device directly on the on-site operation panel even without a DIGSI 5 PC. A numerical
keypad, navigation and function keys are available to you for this purpose. You have the option between a
small or large display.
LEDs allow the display of binary output signals. Key switches offer you optional additional safety for switching
operations. You will find detailed descriptions of components of the on-site operation panel and of navigation
in the device menu tree in chapter 5 Using On-Site Operation Panel.

8.3.4
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Indications

General

During operation, indications deliver information about operational states. These include:

• Measured data

• Power-system data

• Device supervisions

• Device functions

• Function procedures during testing and commissioning of the device
In addition, indications give an overview of important fault events after a failure in the system. All indications
are furnished with a time stamp at the time of their occurrence.
Indications are saved in logs inside the device and are available for later analyses. The following number of
indications are saved at least in the respective buffer (depending on the scope of the indications):

• Operational log 2000 indications

• Fault log 1000 indications

• Switching-device log 2000 indications

• Ground-fault log 100 indications

• User-defined log 200 indications

• Motor-starting log 200 indications
If the maximum capacity of the user-defined log or of the operational log is exhausted, the newest entries
overwrite the oldest entries. If the maximum capacity of the fault log or of the ground-fault log is reached,
the number of the last fault is output via the signal Fault recording buffer is full. You can route this signal
in the information routing. If indications in the information routing of DIGSI 5 are routed to a log, then they
are also saved. During a supply-voltage failure, recorded data are securely held by means of battery buffering
or storage in the flash memory. You can read and analyze the log from the device with DIGSI 5. The device
display and navigation using keys allow you to read and analyze the logs on site.
Indications can be output spontaneously via the communication interfaces of the device and through external
request via general interrogation. In DIGSI 5, indications can be tracked spontaneously duringonline mode
in a special indication window. Indications can be made accessible to higher-level control systems through
mapping on various communication protocols.

ii NOTE
All indications are assigned to certain device functions. The text of each indication contains the corre-
sponding function designation. You can find explanations of the meaning of indications in the corre-
sponding device functions. However, you can also define indications yourself and group them into your
own function blocks. These can be set by binary inputs or CFC logic.

Reading Indications
To read the indications of your SIPROTEC 5 device you can use the on-site operation panel of the device or a PC
on which you have installed DIGSI 5. The subsequent section describes the general procedure.

Reading Indications on the On-Site Operation Panel

Procedure
The menus of the logs begin with a header and 2 numbers at the top right corner of the display. The number
after the slash signifies the number of indications that are available. The number before the slash indicates

8.4

8.4.1

8.4.2
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how many indications have just been selected or shown. The end of the indication list is closed with the entry
***END***.

[sc_oprlog, 1, en_US]

Figure 8-6 On-Site Display of an Indication List (Example: Operational Indications)

Menu Path Log
Main menu → Indications → Operational log

Fault log
Switch. device log
Ground-fault log
Setting-history log
User log 1
User log 2
Motor-starting log
Com supervision log

Main Menu → Test & Diagnosis → Log → Device diagnosis
Security log
Communication log

To reach the desired log from the main menu, use the navigation keys of the on-site operation panel.
² Navigate inside the log using the navigation keys (top/bottom). You will find the most current indication

at the top of the list. The selected indication is shown with a dark background.
Which indications can be shown in the selected log depends on the assignments in the DIGSI 5 information
routing matrix or is predefined. Every indication contains date, time, and its state as additional information.
You will find information about this in chapter 8.5.1 General.
In some logs, you are given the option of deleting the entire indication list by softkey in the footer of the
display. To learn more about this, read chapter 8.5.13 Saving and Deleting the Logs.

ii NOTE
No password entry is necessary to read indications from the device.
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Reading Indications from the PC with DIGSI 5

Procedure

Menu Path (Project) Log
Project → Device → Process data → Log → Operational log

Fault log
Switch. device log
Ground-fault log
Setting-history log
User log 1
User log 2
Motor-starting log
Com supervision log

Online access → Device → Device information →
Logs tab →

Device-diagnosis log
Security indications

Online access → Device → Test suite → Communica-
tion module → Hardware1

Communication log

To read the indications with DIGSI 5 your PC must be connected via the USB user interface of the on-site
operation panel or via an Ethernet interface of the device. You can establish a direct connection to your PC
via the Ethernet interfaces. It is also possible to access all connected SIPROTEC 5 devices via a data network
from your DIGSI 5 PC.
² You reach the desired logs of the SIPROTEC 5 device using the project-tree window. If you have not

created the device within a project, you can also do this via the Online access menu item.
After selecting the desired log, you are shown the last state of the log loaded from the device. To update, it is
necessary to synchronize with the log in the device.
² Synchronize the log. For this purpose, click the appropriate button in the headline of the log (see the

ground-fault indications example in Figure 8-7 a)).

[sc_grflmd, 1, en_US]

Figure 8-7 DIGSI 5 Display of an Indication List (Example of Ground-Fault Log)

8.4.3

1 There may potentially be several communication modules to select from
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You will find additional information about deleting and saving logs in chapter 8.5.13 Saving and Deleting the
Logs.
Which indications can be shown in the selected log depends on the assignments in the DIGSI 5 information
routing matrix or is predefined. You will find information about this in chapter 8.5.1 General.

Setting Relative Time Reference

² Reference the display of log entries, if needed, to the real time of a specific entry. In this way, you
determine a relative time for all other indications. The real-time stamps of events remain unaffected.

Displaying Indications

Displayed indications are supplemented in DIGSI 5 and on the on-site operation panel with the following
information:

Table 8-1 Overview of Additional Information

Indications in DIGSI 5 Information Device Display Information
Log for operational indications and
log for user-defined and switching-
device indications

Time stamp (date and time),
Relative time,
Entry number,
Function structure,
Name,
Value,
Quality,
Cause,
Number

Time stamp (date and time),
Function structure,
Name,
Value

Log for fault indications Time stamp (date and time),
Relative time,
Fault number,
Entry number,
Function structure,
Name,
Value,
Quality,
Cause,
Number

Time stamp (date and time),
Fault number,
Value

Log for motor-starting indications Time stamp (date and time),
Motor-starting time,
Starting current,
Starting voltage,
Starting duration

Time stamp (date and time),
Function structure,
Name,
Value

8.4.4
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Indications in DIGSI 5 Information Device Display Information
Log for ground-fault indications Time stamp (date and time),

Relative time,
Fault number,
Entry number,
Function structure,
Name,
Value,
Indication number,
Quality,
Cause,
Number

Time stamp (date and time),
Fault number,
Value

Log for parameter changes Time stamp (date and time),
Relative time,
Entry number,
Function structure,
Name,
Value,
Quality,
Cause,
Number

Time stamp (date and time),
Function structure,
Name,
Value

Spontaneous indication window
(DIGSI 5)

Time stamp (date and time),
Relative time,
Indication,
Value,
Quality,
Additional Information

Time stamp (date and time),
Fault number,
Value

Log for safety indications2 Time stamp (date and time),
Indication number,
Indication

Time stamp (date and time),
Indication

Log for device-diagnostic indica-
tions2

Time stamp (date and time),
Indication number,
Indication

Time stamp (date and time),
Indication

Log for communication indications2 Time stamp (date and time),
Indication number,
Indication

Time stamp (date and time),
Indication

Log for communication supervision
(GOOSE)

Time stamp (date and time),
Relative time,
Entry number,
Function structure,
Name,
Value,
Quality,
Cause,
Number

Time stamp (date and time),
Function structure,
Name,
Value

2 Only online access
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Overview of Displayed Quality Attributes
If values are shown on the device display or in DIGSI, the following quality attributes are different for
measured values and metered values.

Table 8-2 Measured Values

IEC 61850 Device Display/
DIGSI

Description
Detail Quality Validity

Good Invalid Questionable
– X Value The measured value is valid.
Failure X Fault The device is defective. Contact

Support.
Inaccurate X --- The measured value was not

calculated (for example, the
angle between current and
voltage if 1 of the 2 variables is
missing).

Bad Reference X ≈ Value The measured value can be inac-
curate (for example, outside the
frequency-tracking range).

Out of Range X > Value The measured value exceeds the
measuring range.

Table 8-3 Metered Values

IEC 61850 Device Display/
DIGSI

Description
Validity
Good Invalid Questionable
X Value The metered value is invalid.

X --- The metered value was not calcu-
lated.

X ≈ Value The metered value has no refer-
ence.

Indication Columns
The following table shows the meaning of the individual columns in the log:
Indication Column Meaning
Time stamp Time stamp of the indication in device time using the local time

zone of the device or the query time for the motor log
Relative time Relative time to a reference entry
Error number Number of the error that occurred in the device. This number incre-

ments continuously.
Entry number Entry identification of buffer entries. This identification displays the

sequence of buffer entries.
Indication number Number of the indication that occurred in the device. This number

increments continuously and is necessary for an analysis by
Siemens.

Indication Indication text
Function structure Path of the signal with the signal name
Name Signal name
Value Current state of the command. Also pay attention to the value

quality to check whether the value is up to date.
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Indication Column Meaning
Quality The quality of the value shows the source of the value and whether

the value is up to date.
Cause Additional information such as the cause and validity
Number DIGSI address of the signal
Motor startup time Time of motor starting
Starting current Current needed by the motor to start up
Starting voltage Voltage needed by the motor to start up
Start duration Time needed by the motor to start up

Spontaneous Indication Display in DIGSI 5

With DIGSI 5 you have the possibility of displaying all currently transmitted indications of the selected device
in a special indication window.

Procedure

• Call up the spontaneous indications of your selected device in the navigation window under Online
access.

• Click Indications in the path:
Online access → Interface → Device → Indications

• The raising indications appear immediately without you having to wait for a cyclical update or initiate the
manual update.

[sc_spnmld, 2, en_US]

Figure 8-8 Displaying Spontaneous Device Indications in DIGSI 5

Spontaneous Fault Display on the On-Site Operation Panel

After a fault, the most important data of the last fault can be displayed automatically on the device display
without further operational measures. In SIPROTEC 5 devices, protected objects and even circuit breakers
can be freely created and configured depending on the application (even several instances). In DIGSI 5,
several spontaneous fault displays can be configured, depending on the application, with each individual one
being assigned a particular circuit breaker. These displays remain stored in the device until they are manually
confirmed or released by LED reset.

Configuration of a Spontaneous Fault Display with DIGSI 5

• To reach the Fault-display configuration of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Display pages → Fault-display configuration

8.4.5

8.4.6
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• In the main window, all configured circuit breakers are displayed. A list of a maximum of 6 configurable
display lines is offered for each circuit breaker. The activation of a spontaneous fault display occurs for
each circuit breaker by selection via checkmark in the column Display.

• With the parameter (_:139) Fault-display (under Device → Parameter → Device settings) you
determine whether spontaneous fault displays should be shown for each pickup or only pickups with the
trip command.

[sc_konstf, 2, en_US]

Figure 8-9 Configuration of the Spontaneous Fault Display on the Device

For every display line the following display options can be selected:

Table 8-4 Overview of Display Options

Displayed Information Explanation
Pickup indication Display of the first function stage picked up in a fault, as needed with auxiliary

information (phases, ground, direction)
PU time Display of the entire pickup duration of the fault
Operate indication Display of the first function stage triggered in a fault, as needed with auxiliary

information (phases)
Trip time Display of the operate time related to the beginning of the fault (pickup start)
Fault distance Display of the measured fault-location distance
Operate result indication Display of the control or switching device triggered in a fault, with auxiliary

information (phases) where necessary

Acknowledgment of the Spontaneous Fault Display on the Device
After faults, the last occurred fault is always displayed to you. In cases where more than one circuit breaker
is configured, several stored fault displays can be present after faults, with the latest being displayed. These
displays remain stored in the device until manual acknowledgment or release by LED reset.

[sc_stfanz, 1, en_US]

Figure 8-10 Spontaneous Fault Display on the Device
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Method 1: Manual acknowledgment

• Press the softkey button Quit in the base bar of the display. The display is irretrievably closed. Repeat this
step until no further spontaneous fault displays appear.

• After completion of all confirmations the last display view is showed before the faults.
Method 2: Acknowledgment via LED reset

• An LED reset (device) causes the reset of all stored LEDs and binary output contacts of the device and also
to the confirmation of all fault displays stored in the display.

You can find more details on the topic of LED reset in chapter 8.4.7 Stored Indications in the SIPROTEC 5
Device

Stored Indications in the SIPROTEC 5 Device

In your SIPROTEC 5 device, you can also configure indications as stored. This type of configuration can be
used for LEDs as well as for output contacts. The configured output (LED or contact) is activated until it is
acknowledged. Acknowledgment occurs via:

• On-site operation panel

• DIGSI 5

• Binary input

• Protocol of substation automation technology

Configuration of Stored Indications with DIGSI 5
In the Information Routing of each device set up in DIGSI 5, you can route binary signals, among others, to
LEDs and output contacts.

• To do this, proceed in the project tree to:
Project → Device → Information routing

• Right-click the routing field of your binary indication in the desired LED or binary output column in the
routing range of the targets.

You are offered the following options:

Table 8-5 Overview of Routing Options

Routing Options LEDs BOs BIs Description
H (active) X The signal is routed as active with voltage.
L (active) X The signal is routed as active without voltage.
V (unlatched) X X The signal is routed as unlatched. Activation and reset of

the output (LED, BO) occurs automatically via the binary-
signal value.

G (latched) X X The binary signal is latched when the output (LED) is acti-
vated. To reset, a targeted confirmation must occur.

8.4.7
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Routing Options LEDs BOs BIs Description
NT (conditioned latching) X Fault indications are stored during control of the output

(LED) as a function of the parameter (_:91:139)
Fault-display. In the event of a new fault, the previ-
ously stored states are reset.

• If the fault gets terminated via a trip command from
the assigned circuit breaker, the status of an indica-
tion remains as latched with the setting option with
trip. Without a trip command, the status is displayed
before the fault (if necessary, the status of the last
fault) is restored.

• With the setting option with pickup the current
indication image of a pickup gets stored. The image
comprises all indications of functions that are effective
in the event of tripping on the same circuit breaker,
like the picked up function.

The following applies to the busbar protection:

• If the fault gets terminated via a trip command, the
status of an indication remains as latched with the
setting option with trip.
This occurs separately for the following tripping cases:
– Trippings caused by busbar protection (busbar

differential protection, busbar tripping following
a circuit-breaker failure protection trip in the bay
or busbar tripping due to external tripping)

– Trippings caused by functions within the corre-
sponding bay (for example, end-fault protection,
circuit-breaker failure protection trip repeat or
overcurrent protection)

• With the setting option with pickup, the current
indication image is saved using the same rules as with
the setting with trip but together with the pickup
of the protection function.

TL (stored only with tripping) X Routing option TL (tripping stored) is only possible for the
switching object circuit breaker.
The output is saved with protection tripping. The contact
remains activated until acknowledged.
Control commands are not affected. A control command
is pending above the parameterized command period until
feedback has been successfully received.
Note:
You can realize the functionality of the Lockout (ANSI 86)
by storing the output relay with the routing option TL.

Acknowledgment of Stored Indications 

Acknowledgment on the On-Site Operation Panel
Acknowledgment via LED Reset key
Operating the key first causes the activation of all LEDs (LED test) when pressed, and when released, the
resetting of all stored indications. Stored LEDs, output contacts, and spontaneous fault displays are reset.

8.4.8
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Acknowledgment via the operating menu

• Log on to the device.

• To reach the reset functions from the main menu, use the navigation buttons of the on-site operation
panel.

• Select on the device display:
Main menu → Device functions → Reset functions

You will be offered different Reset functions.

Figure 8-11 Reset Functions on the On-Site Operation Panel (Example)

Detailed overview of the Reset functions:
Res. Binary Outputs

• Log on to the device.

• Use Res. binary outputs to reset stored output contacts.

• Actuate the softkey Start in the base bar.
The device display will then briefly display the indication Cmd. exec. Succeeded.
Res. LED not in Grp.

• Log on to the device.

• Use Res. LED not in Grp. to reset stored LEDs that are not assigned to a special function group.

• Actuate the softkey Start in the base bar.
The device display will then briefly display the indication Order successfully saved.
Depending on the device configuration, other protection function groups are displayed to you as submenus
for which separately corresponding, stored LEDs can be reset. Proceed with the other function groups as
shown in the following example.
Line 1 or VI3ph 1 (examples)

• Go to the submenu of the selected function group (examples).

• Use Reset LEDs to reset stored LEDs in the selected function group.

• Actuate the softkey Start in the base bar.
The device display will then briefly display the indication Order successfully saved.

Figure 8-12 Reset Functions on the On-Site Operation Panel (for Example, Line FG)

Acknowledgment of Stored Indications via Binary Inputs
Acknowledgment by binary input >LED-Reset switches on all LEDs (LED Test). After signal dropout, all stored
indications, stored LEDs, output contacts, and spontaneous fault displays are reset.
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Acknowledgment of Stored Indications with DIGSI 5
You can acknowledge stored indications via DIGSI 5 in online mode.

• For this, go to the project tree.

• Select:
Online access → Interface → Device → Device information

• Select the Device information tab.

[scquiled-140912-01, 2, en_US]

Figure 8-13 LED Reset via DIGSI 5

• Click the LED reset button.
Stored LEDs, output contacts, and spontaneous fault displays are reset on the assigned device.

Acknowledgment of Stored Indications via Log
You can also initiate acknowledgment of stored indications by communicating through connected substation
automation technology. This can occur in conformance to standards (IEC 61850, IEC 60870-5-103) or via
configuration (mapping) of the LED reset input signal for any protocol. Stored LEDs, output contacts, and
spontaneous fault displays are reset.

ii NOTE
As long as there are no active unstored indications at the output contacts and configured LEDs, the
acknowledgment of stored indications resets the LEDs and output contacts.

Application Mode/Test Mode and Influence of Indications on Substation
Automation Technology

With the controllable Application mode = Test or Test/Relay blk., you switch on or off the test
mode for the entire device.

If the test mode of the device or of individual functions is switched on, the SIPROTEC 5 device marks
indications sent to substation automation technology station control system with an additional test bit. This
test bit makes it possible to determine that an indication was set during a test.

8.4.9
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Logs

General

Indications are saved in logs inside the device and are available for later analyses. Different logs allow
categorization of indication logging based on operating states (for example, operational and fault logs) and
based on fields of application.

Table 8-6 Log Overview

Log Logging
Operational log Operational indications
Fault log Fault indications
Switching-device log Switching operation and circuit-breaker statistics
Ground-fault log Ground-fault indications
Setting-history log Setting changes
User-defined log User-defined indication scope
Security log Access with safety relevance
Device-diagnosis log Error of the device (software, hardware) and the connection circuits
Communication log Status of communication interfaces
Motor-starting log Information on the motor starting
Communication-supervision log Communication supervision (GOOSE)

Log Management
Logs have a ring structure and are automatically managed. If the maximum capacity of a log is exhausted, the
oldest entries disappear before the newest entries. If the maximum capacity of the fault or ground-fault log
is reached, the number of the last fault is output via the signal Fault recording buffer is full. You can route
this signal in the information routing. If indications in the information routing of DIGSI 5 are routed to a log,
then they are also saved. During a supply-voltage failure, recorded data are securely held by means of battery
buffering or storage in the flash memory. You can read and analyze the log from the device with DIGSI 5. The
device display and the navigation allow you to read and evaluate the logs on site using keys.

Configurability of Logs
The indication capacity to be recorded in configurable logs (for example, ground-fault log) is laid down in
columns of the information routing (matrix) of DIGSI 5 specifically defined for this purpose.

Procedure
To reach the information routing of your SIPROTEC 5 device, use the project-tree window. Access is only
through the project:

• Open the information routing.
Project → Device → Information routing

• Select the appropriate routing column.
Destination → Logs → Column Ground-fault log (G)

The routing of the selected indication is done via right click.

• Select one of the options in the list box shown:
– Routed (X)
– Unrouted

8.5

8.5.1
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[sc_infpuf, 2, en_US]

Figure 8-14 Indication Configuration in DIGSI 5 (Example: Ground-Fault Log, Column G)

For non-configurable logs (for example, setting-history logs) scope and type of logged indications are
described separately (see following chapter about logs).

Operational Log

Operational indications are information that the device generates during operation. This includes information
about:

• State of device functions

• Measured data

• Power-system data
Exceeding or dropping below limiting values is output as an operational indication. Short circuits in the
network are indicated as an operational indication Fault with sequential fault number. For detailed informa-
tion about the recording of system incidents, refer to the description of the fault log (chapter 8.5.3 Fault Log).
Up to 2000 indications can be stored in the operational log.

Reading from the PC with DIGSI 5

• To reach the operational log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process Data → Log → Operational log

• The status of the operational log last loaded from the device is shown to you. To update (synchronization
with the device), click the button Read log entries in the headline of the indication list (Figure 8-15 a)).
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[sc_betrmd, 1, en_US]

Figure 8-15 Reading the Operational Log with DIGSI 5

Reading on the Device via the On-Site Operation Panel

• To reach the operational log via the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Indications → Operational log

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

• Using the Info softkey, you can retrieve auxiliary information on the entry depending on the context.

Operation in the Operating State
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[sc_operlog1, 2, en_US]

Figure 8-16 On-Site Display of an Indication List (Example: Operational Indications)

Deletability
The operational log of your SIPROTEC 5 device can be deleted. This is done usually after testing or commis-
sioning the device. To know more about this, read chapter 8.5.13 Saving and Deleting the Logs.

Configurability
The indication scope of the operational log is configured in a specifically defined column of the information
routing (matrix) of DIGSI 5:
Target → Log → Operational log column
Selected application templates and functions from the library bring with them a predefined set of operational
indications which you can adjust individually at any time.

Fault Log

Fault indications are events which arise during a fault. They are logged in the fault log with real-time stamp
and relative-time stamp (reference point: fault occurrence) . Faults are numbered consecutively in rising order.
With fault recording engaged, a corresponding fault record with the same number exists for every fault logged
in the fault log. A maximum of 128 fault logs can be stored. A maximum of 1000 indications can be recorded
in each fault log.

Fault Definition
In general, a fault is started by the raising pickup of a protection function and ends with the cleared pickup
after the trip command.
When using an automatic reclosing function, the complete reclosing cycle (successful or unsuccessful) is
preferably integrated into the fault. If evolving faults appear within reclosing cycles, the entire clearing
process is logged under one fault number even in multiple pickup cycles. Without automatic reclosing function
every pickup is also recorded as its own fault.
User-defined configuration of a fault is also possible.

ii NOTE
The definition of the fault is done through settings of the fault recording (see Device manual). Events are
logged in the fault log even when fault recording is switched off.

Apart from the recording of fault indications in the fault log, spontaneous display of fault indications of the
last fault on the device display is also done. You will find details about this in chapter 8.4.6 Spontaneous Fault
Display on the On-Site Operation Panel.

8.5.3

Operation in the Operating State
8.5 Logs

SIPROTEC 5, Operation, Manual 181
C53000-G5040-C003-L, Edition 03.2023



Deletability
The fault log of your SIPROTEC 5 device can be deleted. For more details about this, refer to chapter
8.5.13 Saving and Deleting the Logs.

Reading on the Device through the On-Site Operation Panel

• To reach the fault log from the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Indications → Fault logs

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[sc_faullg, 1, en_US]

Figure 8-17 Reading the Fault Log on the On-Site Operation Panel of the Device

Configurability
The indication scope of the fault log is configured in a specifically defined column of the information routing
(matrix) of DIGSI 5:
Target → Log → Fault log column
Selected application templates and functions from the library already bring a predefined set of operational
indications with them which you can adjust individually at any time.
The operational measured values and the measured values of the fundamental components and symmetrical
components (see Device Manual) are calculated every 9 cycles (at 50 Hz, this is every 180 ms). However, this
can mean that the data are not synchronized with the sampled values of the analog channels. The recording
of these measured values can be used to analyze the slowly changing processes.

Switching-Device Log

Statistic values and position changes for switching devices such as circuit breakers and disconnectors are
logged in the switching-device log. Up to 2000 indications can be stored in the switching-device log.

Reading from the PC with DIGSI 5

• To reach the switching-device log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process data → Logs → Switch. device log

The statuses of the switching-device log last loaded from the device is shown to you.

• To update (synchronization with the device) click the button Read log entries in the headline of the
indication list (Figure 8-18).
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[sc_switch_device_log, 1, en_US]

Figure 8-18 Reading the Switching-Device Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach the switching-device log from the main menu, use the navigation keys on the on-site operation
panel.
Main menu → Indications → Switch. device log

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[sc_switch_device_log1, 1, en_US]

Figure 8-19 Reading the Switching-Device Log on the On-Site Operation Panel of the Device

Deletability
The switching-device log of your SIPROTEC 5 device can be deleted. Read details about this in chapter
8.5.13 Saving and Deleting the Logs.

Configuring a Switching-Device Log
The indication scope of the switching-device log is configured in a specifically defined column of the informa-
tion routing (matrix) of DIGSI 5:
Target → Log → Column Switching-device log
Selected application templates and functions from the library already bring a predefined set of switching-
device indications with them which you can adjust individually at any time. Specific statistic measured values
for the circuit breaker are prerouted and cannot be removed.

Ground-Fault Log

Ground-fault indications are events which arise during a ground fault. They are logged in the ground-fault
log with real-time stamp and relative-time stamp (reference point: ground-fault occurrence). Ground faults

8.5.5
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are numbered consecutively in rising order. A maximum of 10 ground-fault logs are stored, and for each
ground-fault log it is guaranteed that at least 100 indications are recorded.
The following functions can start the logging of a ground fault with the raising ground-fault indication:

• Directional sensitive ground-fault protection for deleted and isolated systems (67Ns)

• Sensitive ground current protection with I0 (50Ns/51Ns)

• Intermittent ground-fault protection
The logging ends with the clearing ground-fault indication.

Reading from the PC with DIGSI 5

• To reach the ground-fault log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process data → Logs → Ground-fault log

The status of the device-diagnosis log last loaded from the ground-fault log is shown to you.

• To update (synchronization with the device) click the button Read log entries in the headline of the
indication list (Figure 8-20 a)).

[sc_grflmd, 1, en_US]

Figure 8-20 Reading the Ground-Fault Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach the ground-fault log from the main menu, use the navigation keys of the on-site operation
panel.
Main menu → Indications → Ground-fault indication

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.
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Figure 8-21 Reading the Ground-Fault Log on the On-Site Operation Panel of the Device

Deletability
The ground-fault log of your SIPROTEC 5 device can be deleted. Read details about this in chapter
8.5.13 Saving and Deleting the Logs.

Configurability
The indication scope of the ground-fault log is configured in a specifically defined column of the information
routing (matrix) of DIGSI 5:
Target → Log → Column Ground-fault log
Selected application templates and functions from the library already bring a predefined set of operational
indications with them which you can adjust individually at any time.

Setting-History Log

All individual setting changes and the downloaded files of entire parameter sets are recorded in the log for
setting changes. This enables you to determine setting changes made are associated with events logged (for
example faults). On the other hand, it is possible to obtain verification with fault analyses, for example, that
the current status of all settings truly corresponds to their status at the time of the fault. Up to 200 indications
can be stored in the setting-history log.

Reading from the PC with DIGSI 5

• To reach the log for setting changes of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process data → Log → Setting changes

The status of the setting-history log last loaded from the device is shown to you.

• To update (synchronization with the device), click the Read log entries button in the headline of the
indication list (Figure 8-22).

8.5.6
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Figure 8-22 Reading the Setting-History Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach the setting-history log from the main menu, use the navigation keys of the on-site operation
panel.
Main menu → Indications → Setting changes

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[sc_hislog, 1, en_US]

Figure 8-23 Reading the Setting-History Log on the On-Site Operation Panel of the Device

Indication Categories in the Setting-History Log
For this log, there is selected information that is stored in case of successful as well as unsuccessful setting
changes. The following list gives you an overview of this information.

Table 8-7 Overview of Indication Types

Displayed Information Explanation
Selection edit+ Selection of settings group to be edited
Cancelation+ Cancelling of all changes successful
SG activation+ SG activation via command successful
SG activation- SG activation via command failed
Set+ Parameter value was changed
Confirmation+ Confirmation of change successful
Confirmation- Confirmation of change failed
DCF uploaded DCF loaded into device
SG 1 Settings group 1

Operation in the Operating State
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Displayed Information Explanation
SG 2 Settings group 2
SG 3 Settings group 3
SG 4 Settings group 4
SG 5 Settings group 5
SG 6 Settings group 6
SG 7 Settings group 7
SG 8 Settings group 8

ii NOTE

• The logged indications are preconfigured and cannot be changed!

• The log, which is organized as a ring buffer, cannot be deleted by the user!

• If you want to archive security-relevant information of the device without loss of information, you
must regularly read this log.

• You cannot route additional indication objects to the setting-history log.

User Log

With the user-defined log (up to 2), you have the possibility of individual indication logging parallel to the
operational log. This is helpful, for example, in special monitoring tasks but also in the classification into
different areas of responsibility of the logs. Up to 200 indications can be stored in the user-defined log.

Reading from the PC with DIGSI 5

• To reach the user-defined log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process Data → Log → User log 1/2

The status of the user-defined log last loaded from the device is shown to you.

• To update (synchronization with the device), click the Read log entries button in the headline of the
indication list (Figure 8-24 a)).

[sc_application_md, 2, en_US]

Figure 8-24 Reading the User-Defined Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach user-specific logs from the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Indications → User-defined log 1/2

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

• Using the Info softkey, you can retrieve auxiliary information on the entry depending on the context.

8.5.7
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Figure 8-25 Reading the User-Defined Log on the On-Site Operation Panel of the Device

Deletability
The user-defined log of your SIPROTEC 5 device can be deleted. You will find details about this in chapter
8.5.13 Saving and Deleting the Logs.

Configuration of a User-Defined Log
The indication capacity of a created user-defined log can be configured freely in the associated column of the
information routing (matrix) of DIGSI 5:
Target → Log → U1 or U2

[sc_diu1u2, 1, en_US]

Figure 8-26 Indication Configuration in DIGSI 5 (Example: User-Defined Log U1/2)
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Security Log

Access to areas of the device with restricted access rights is recorded in the security log. Unsuccessful and
unauthorized access attempts are also recorded. Up to 2048 indications can be stored in the security log.

Reading from the PC with DIGSI 5

• To reach the security log of your SIPROTEC 5 device, use the project-tree window. The device must be in
Online access.
Project → Online access → Device → Device Information → Logs tab → Security logs

The state of the security log last loaded from the device is displayed.

• Before this, refresh the contents by clicking the update arrows in the headline.

[sc_secmld, 2, en_US]

Figure 8-27 Reading the Security Indications with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach the security log from the main menu, use the navigation keys of the on-site operation panel.
Main menu → Test & Diagnosis → Logs → Security log

• You can navigate on the on-site operation panel using the navigation keys (top/bottom) inside the
displayed indication list.

[sc_seclog, 1, en_US]

Figure 8-28 Reading the Security Log on the On-Site Operation Panel of the Device
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ii NOTE

• The logged indications are preconfigured and cannot be changed!

• This log, which is organized as a ring buffer, cannot be deleted by the user!

• If you want to archive security-relevant information of the device without loss of information, you
must regularly read this log.

Device-Diagnosis Log

Concrete take-action instructions are logged and displayed in the device-diagnosis log for the following items:

• Required maintenance (for example, battery supervision)

• Identified hardware defects

• Compatibility problems
Up to 500 indications can be stored in the device-diagnosis log. In normal operation of the device, it is
sufficient for diagnostic purposes to follow the entries of the operational log. This specific significance is
assumed by the device-diagnosis log when the device is no longer ready for operation due to hardware defect
or compatibility problems and the fallback system is active.

Reading from the PC with DIGSI 5 in Normal Operation

• To reach the device-diagnosis log of your SIPROTEC 5 device, use the project-tree window.
Project → Online access → Device → Device information → Logs tab → Device-diagnosis log

The status of the device-diagnosis log last loaded from the device is shown to you.

• Before this, refresh the contents by clicking the update arrows in the headline.

[sc_devdia, 1, en_US]

Figure 8-29 Reading the Device-Diagnosis Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel in Normal Operation

• To reach the diagnosis log from the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Test & Diagnosis → Logs → Device diagnosis

• You can navigate on the on-site operation panel using the navigation keys (top/bottom) inside the
displayed indication list.
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Figure 8-30 Reading the Device-Diagnosis Log on the On-Site Operation Panel of the Device

ii NOTE

• The device-diagnosis log cannot be deleted!

• The logged indications are preconfigured and cannot be changed!

Communication Log

The logging of the respective status such as ensuing faults, test and diagnosis operation, and communication
capacity utilizations is done for all hardware-based configured communication interfaces. Up to 500 indica-
tions can be stored in the communication log. Logging occurs separately for each communication port of the
configured communication modules.

Reading from the PC with DIGSI 5

• Use the project-tree window to reach the communication logs of your SIPROTEC 5 device.
Online access → Device → Test suite → Communication module

• Then select:
J:Onboard Ethernet → Communication log

The communication log is shown to you in the state last loaded from the device.

• Before this, refresh the contents by clicking the update arrows in the headline.

8.5.10
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Figure 8-31 Reading the Communication Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach the communication log from the main menu, use the navigation keys on the on-site operation
panel.
Main Menu → Test & Diagnosis → Logs → Communication logs

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[sc_commlg, 1, en_US]

Figure 8-32 Reading the Communication Log on the On-Site Operation Panel of the Device

Deletability
The communication logs of your SIPROTEC 5 device can be deleted. Read details about this in chapter
8.5.13 Saving and Deleting the Logs.
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Configurability
The communication logs are not freely configurable. The entries are preconfigured.

Communication-Supervision Log

The communication-supervision log is used to log communication events.
The following events are currently logged:

• Status for each GOOSE subscription (if configured)
A log is kept of whether the GOOSE subscription has received valid messages or not.

• Aggregated status for all GOOSE subscriptions
The status is TRUE if at least one GOOSE subscription does not receive any valid message.

• Subscriber in simulation mode
GOOSE messages are processed with a simulation flag. The status is TRUE if at least one GOOSE subscrip-
tion processes simulated messages.

Reading from the PC with DIGSI 5

• To reach the communication-supervision log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process data → Logs → Com supervision log

The status of the communication-supervision log last loaded from the device is shown.

• To update (synchronization with the device), click the button Read log entries in the headline of the
indication list.

[sc_comsuperv, 1, en_US]

Figure 8-33 Reading the Communication-Supervision Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach the communication-supervision log from the main menu, use the navigation keys on the on-site
operation panel.
Main menu → Logs → Com supervision log

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.
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Figure 8-34 Reading the Communication-Supervision Log on the On-Site Operation Panel of the Device

Deletability
The communication-supervision log of your SIPROTEC 5 device can be deleted. Read details about this in
chapter 8.5.13 Saving and Deleting the Logs.

Configurability
The communication-supervision log cannot be freely configured. The entries are preconfigured.

Motor-Starting Log

The motor-starting log records the starting current, starting voltage and the start duration each time a motor
starts. The motor-starting current and the motor-starting voltage are displayed as primary values. Up to 200
indications can be stored in the motor-starting log.
Measurement of the motor statistics starts when the motor state changes to Start. Measurement of the
motor starting time ends as soon as the motor state changes to Standstill or Running. The motor state is
obtained from the Motor-state detection function.
No entry is recorded in the motor-starting log if the motor state changes to Start and the current drops
below the motor starting current within 500 ms.

Table 8-8 Motor-Starting Log

Measured Values Primary
Start duration Motor starting time s
Starting current Motor-starting current (primary) A (or kA)
Starting voltage Motor-starting voltage (primary) V (or kV)

Reading from the PC with DIGSI 5

• Use the project-tree window to reach the motor-starting log of your SIPROTEC 5 device.
Project → Device → Process data → Logs → Motor-starting log

The state of the motor-starting log last loaded from the device is shown to you.

• To update (synchronization with the device), click the Read log entries button in the headline of the
indication list (Figure 8-35).
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Figure 8-35 Reading the Motor-Starting Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

• To reach the motor-starting log from the main menu, use the navigation keys of the on-site operation
panel.
Main Menu → Indications → Motor-starting log

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[ScMotLog-280618, 1, en_US]

Figure 8-36 Reading the Motor-Starting Log on the On-Site Operation Panel of the Device

Deletability
The motor-starting log of your SIPROTEC 5 device can be deleted. Read details about this in chapter
8.5.13 Saving and Deleting the Logs.

Configurability
The motor-starting log is only present in the Motor function group. There is no column for the motor-starting
log in the DIGSI information routing. The entries in the motor-starting log are preconfigured and cannot be
changed.
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Saving and Deleting the Logs

Deleting the logs of the device in the operating state is unnecessary. If storage capacity is no longer sufficient
for new indications, the oldest indications are automatically overwritten with new incoming events. In order
for the memory to contain information about the new faults in the future, for example, after a revision of the
system, a deletion of the log makes sense. Resetting the logs is done separately for the various logs.

ii NOTE
Before you delete the content of a log on your SIPROTEC 5 device, save the log with DIGSI 5 on the hard
disk drive of your PC.

ii NOTE
Not all logs of your SIPROTEC 5 device can be deleted. These limitations apply especially to logs with
relevance for security and after-sales (security log, device-diagnosis log, setting-history log).

ii NOTE
If you delete any files directly from the fault log or fault record, the error number for new fault records
continues incrementing up to the maximum number 2^32. It does not reset to 0.
If you initialize flash partitioning of the fault log and fault record, the error number for new fault records
resets to 0.

ii NOTE
If the device executes an initial start, for example after an update of the device software, the following logs
are automatically deleted:

• Operational log

• Fault log

• Switching-device log

• Ground-fault log

• Setting-history log

• User-defined log

• Motor-starting log

• Communication-supervision log
Back up the deletable logs using DIGSI 5.

ii NOTE
If a ground fault is currently active, the ground-fault log cannot be deleted.

Deleting Logs on the On-Site Operation Panel

• To reach the selected log from the main menu, use the navigation keys of the on-site operation panel
(example operational log):
Main menu → Logs → Operational log

8.5.13
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Figure 8-37 Deleting the Operational Log on the On-Site Operation Panel

• You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

• The option to delete the entire log is offered to you in the footer of the display at the bottom left. Use the
softkeys below under the display to activate the command prompts. Confirm the request to Delete.

• After being requested, enter the password and confirm with Enter.

• After being requested, confirm the Deletion of all entries with Ok.

Deleting Logs from the PC with DIGSI 5

• To reach the selected log of your SIPROTEC 5 device, use the project-tree window (for example opera-
tional log).
Project → Device → Process data → Logs → Operational log

Operation in the Operating State
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Edit Measured and Metered Values

Overview of Measured and Metered Values

The SIPROTEC 5 devices have numerous measured and metered values. The following Table 8-9 gives you an
overview of the scope and sequencing principle. Measured and metered values will be referred to hereafter as
measured values.
Please refer to the Device manual of your SIPROTEC 5 device for detailed information and setting instructions.

Table 8-9 Overview of Measured Values

Measured / Metered
Values

Description

Operational measured
values

RMS value calculation and power calculation by definition, convertible to
primary, secondary or percentage values

• Phase currents IA, IB, IC
• Ground current IN, INS (sensitive)

• Phase-to-ground voltages VA, VB, VC

• Phase-to-phase voltages VAB, VBC, VCA

• Residual voltage VNG

• Frequency f
• Powers P, Q, S (3-phase and phase-specific)
• Power factor λ

Fundamental and symmet-
rical components

Calculation of indicator quantities via Fourier filter or according to the trans-
formation rule

• Phase currents IA, IB, IC
• Ground current IN, INS (sensitive)

• Phase-to-ground voltages VA, VB, VC

• Phase-to-phase voltages VAB, VBC, VCA

• Residual voltage VNG

• Symmetrical components 3I0, I1, I2, V0, V1, V2

Protection-specific Meas-
ured values

Measured values that are especially calculated for individual protection func-
tions such as

• Distance protection (reactances and resistances of conductor loops)
• Differential protection (differential and restraint current conductor)
• etc.

Average values Average values can be formed on the following basis:

• Operational measured values
• Symmetrical components
The time slot for average-value generation and the output interval are param-
eterizable.

8.6

8.6.1

Operation in the Operating State
8.6 Edit Measured and Metered Values

198 SIPROTEC 5, Operation, Manual
C53000-G5040-C003-L, Edition 03.2023



Measured / Metered
Values

Description

Minimum and maximum
values

The minimum and maximum values can be formed on the following basis:

• Operational measured values
• Symmetrical components
• Selected measured values (for example of average values)
The display of minimum and maximum values contains the time of their
occurrence. The calculation is stabilized against smaller value fluctuations in
currents and voltages.

Energy values These metered values are determined for active and reactive energy. Restore
time, restore interval and counting mode are adjustable. Restoration can be
initiated via a binary input.
The following metered values are available:

• Active energy Wp+ (export), Wp- (import)
• Reactive energy Wq+ (export), Wq- (import)

Statistical values The following statistical values are formed:

• Number of initiated switching operations of the circuit breaker (opera-
tion counter); the contactor trips and switch actuations by the control
are counted.

• Number of initiated switching operations of the circuit breaker, sepa-
rated by circuit-breaker pole

• Sum of total primary breaking currents
• Sum of the primary breaking currents, separately for each breaker pole

User-defined measured
values

These metered values can be determined for any metered amounts received
via a binary input.

• The unit and significance of a pulse, restore time, restore interval, and
meter mode can be set.

• Restoration can be initiated via a binary input

Reading Measured Values and Metered Values

You can read measured and metered values on the device display or with DIGSI 5. You can find these values in
the respective function groups such as the Line function group. Take note that the scope of measured values
is determined by the type and number of assigned measuring points. If only one measuring point, for example
3-phase current, is assigned to the function group, then all measured values linked to the voltage (voltage,
power, energy) are omitted. These measured values are hidden automatically.
In the following, you will find an example how to reach the individual measured or metered values.

8.6.2
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Reading Measured Values on the Device
You can read the measured values in the function group Line 1 as follows:

• In the main menu of the device display, switch to
Main menu → Measured values → Line 1
The following measured-value group is displayed for you, and you can find the available measured and
metered values in Table 8-9.
– Operational measured values
– Fundamental component/symmetrical components
– Functional measured values (protection-specific measured values)
– Minimum/maximum/mean values
– Energy
– User-defined measured values

You can read the measured values in the function group Circuit Breaker 1 as follows:

• In the main menu of the device display, switch to
Main menu → Measured values → Circuit breaker 1
The following measured-value group is displayed for you, and you can find the available measured and
metered values in Table 8-9.
– Fundamental component/symmetrical components
– Functional measured values (protection-specific measured values)
– Statistics
– User-defined measured values

Reading Measured Values with DIGSI 5
You can read the measured values of the individual function groups with DIGSI 5.

• Establish an online connection to the device with DIGSI 5.

• Select the desired device from the Online access.

• Open the menu item Measurements.

• Double-click the respective function group and the measured value view appears in the working area.

• Select the respective tab of the desired measured value group.
The ordering of the measured-value groups follows the ordering principle in Table 8-9.
Figure 8-38 shows you an example of a measured-value view. You can select whether the measured values
are shown to you as primary, secondary, or percentage values. Furthermore, you have the possibility of saving
the measured values.
If you want to save the measured values, proceed as follows:

• Click the Snapshot button in the menu bar.
You can now read the saved measured values in the offline folder of the project tree as required.

• To do this, click device.

• Open the menu item Process Data.

• Double-click the desired function group on Measured value-snapshot.
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Figure 8-38 Example of the Measured-Value View for the Function Group Line 1

Setting and Resetting Energy Values

Setting and resetting energy values on the device:
² To set and reset on the device use the Measured values menu.

² In the corresponding function group, mark the Energy measured values.

² You can reset the energy values using the right context-sensitive Reset key on the display.

² When you open the energy values, you see the current values displayed as primary values.

² You can set each measured value to the desired value via the right context-sensitive Change key.
The input value is converted to the data format according to IEC 61850. Because of the associated
quantization, the resulting display value can differ from the input. In addition, the input value is rounded
to 6 digits. The display is limited to 6 digits. Therefore please note that, in case of small pulse weighting,
minor changes to large metered values can not be reflected in the display.

² Set the new value and activate acceptance with Enter.
Setting and resetting energy values with DIGSI 5:
² Start the online mode with DIGSI 5.

² Click (in the project-tree bottom left) the Measured values menu item.

² Double-click the Line function group and the measured-value window appears in the operating range.

² If you open the Energy tab in the measured-value window, you are shown the current meter readings of
the four-quadrant meter (see Figure 8-39).

² If you click the Reset button, you can reset the current meter readings to 0.
Alternatively, you can set the meter to a value:

8.6.3
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² Enter the desired value in the Current value column. The input value is converted to the data format
according to IEC 61850. Because of the associated quantization, the resulting display value can differ
from the input. In addition, the input value is rounded to 6 digits. The display is limited to 6 digits.
Therefore please note that, in case of small pulse weighting, minor changes to large metered values can
not be reflected in the display.

² To transfer the value to the device, click the Set button.

[scnrgwer-080413-01.tif, 1, en_US]

Figure 8-39 Overview of Energy Values

Setting and Resetting User-Defined Metered Values

Setting and resetting metered values on the device:
² To set and reset, open the Measured values menu on the device.

² Switch to the corresponding function group (for example, Line) in the User-defined values menu in
which the metered values have been arranged.

² Select the metered value.

² Reset the metered values if needed. Use the context-sensitive Reset key on the on-site operation panel.

² If you select one level lower, you are brought to the metered values.

² You can set the metered value to the desired value via the context-sensitive Change key. The input value
is converted to the data format according to IEC 61850. Because of the associated quantization, the
resulting display value can differ from the input. In addition, the input value is rounded to 6 digits. The
display is limited to 6 digits. Therefore please note that, in case of small pulse weighting, minor changes
to large metered values can not be reflected in the display.

² Set the new value and activate acceptance with Enter.
Setting and resetting metered values with DIGSI 5:
² Start the online mode with DIGSI 5.

² Click (in the project tree bottom left) the Measured values menu item.

² Double-click the function group (for example, Line) and the measured-value window appears in the
operating range.

² If you open the User-def. values tab in the measured-values window, the corresponding values can be
viewed.

² If you click the Reset button, you can reset the current meter readings to 0.
Alternatively, you can set the meter to a value.

8.6.4
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² Enter the desired value in the Current value column. The input value is converted to the data format
according to IEC 61850. Because of the associated quantization, the resulting display value can differ
from the input. In addition, the input value is rounded to 6 digits. The display is limited to 6 digits.
Therefore please note that, in case of small pulse weighting, minor changes to large metered values can
not be reflected in the display.

² To transfer the value to the device, click the Set button.

Resetting Min./Max./Average Values

Resetting minimum/maximum/average values on the device:
² To reset, open the Measured values menu on the device.

² Switch to the corresponding function group and to the Minimum/maximum/average values.

² You can reset the minimum/maximum/average values using the context-sensitive right Reset key.
Resetting minimum/maximum/average values with DIGSI 5:
² Start the online mode with DIGSI 5.

² Click (in the project tree bottom left) the Measured values menu item.

² Double-click the selected function group and the measured-value window appears in the operating
range.

² If you open the Min/Max/Average values tab in the measured-value window, you are shown the current
minimum/maximum/average values.

² If you click the Reset button, you can reset the current values to 0.

Setting and Resetting Statistical Values

Setting and resetting statistical values on the device:
² To set and reset, open the Measured Values menu on the device.

² Switch to the Circuit Breaker function group.

² You can reset the values if you select Statistical Values on the display via the context-sensitive Reset
key.

² If you select one level lower, you are brought to the statistical values. The measured values are displayed
in primary values.

² You can set the statistical values to the desired value via the right context-sensitive Change key. The
input value is converted to the data format according to IEC 61850. In addition, the input value is
rounded to 6 digits. The display is limited to 6 digits. Therefore please note that, in case of small pulse
weighting, minor changes to large metered values can not be reflected in the display.

² Set the new value and activate acceptance with Enter.
Setting and resetting statistical values with DIGSI 5:
² Start the online mode with DIGSI 5.

² Click (in the project tree bottom left) the Measured values menu item.

² Double-click the Circuit breaker function group and the measured-value window appears in the oper-
ating range.

² If you open the Statistics tab in the measured-values window, you are shown the current statistical
values (see Figure 8-40).

² You can reset the current values to 0 by clicking the Reset button.
Alternatively, you can set a value:

8.6.5

8.6.6
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² Enter the desired value in the Current value column. The input value is converted to the data format
according to IEC 61850. In addition, the input value is rounded to 6 digits. The display is limited to 6
digits. Therefore please note that, in case of small pulse weighting, minor changes to large metered
values can not be reflected in the display.

² To transfer the value to the device, click the Set button.

[scubstwe-080413-01.tif, 1, en_US]

Figure 8-40 Overview of Statistical Values
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Fault Recording

General

Fault data relates to events or records that are recorded during a device fault. Sampled values of analog
measurement inputs and calculated measured values of the device are recorded in the fault recording. A fault
record can also used for recording binary events as traces. Fault events are logged with time stamp in the
fault log. A corresponding fault exists in the fault log for each recorded fault record. The unique assignment is
formed by the time stamp and the fault defined with an automatically incrementing number.
After a fault the most important data of the fault is spontaneously shown on your device display. You can
select whether the spontaneous fault display is updated with each fault or only in case of faults with tripping
(no Trip – no Flag). Spontaneous fault displays such as LEDs fall back again in case of pickup without tripping.

ii NOTE
Events are always logged in the fault log.

The control settings of the fault recording are described in the Device manual. The starting condition,
recording length, and the storage criterion are selected with these parameters.
You can rename the signals in the DIGSI information routing matrix. You can change the order of the binary
signals and measured-value channels to be recorded in DIGSI under Signal sequence. For further information,
you will find help in DIGSI 5 version V07.50 and higher (ordering number: C53000-D5000-C001-D). The
following chapter describes the readout and editing of fault records.

Fault Definition
A fault is started by the incoming pickup of a protection function and ends after the trip command with the
cleared pickup.
When using an automatic reclosing function, the full reclosing cycle (successful or not) is integrated in the
fault. If evolving faults appear within reclosing cycles, the entire clearing process is logged under one fault
number even in multiple pickup cycles. Without automatic reclosing function every pickup is also recorded as
its own fault.
User-defined fault configuration and initiation by an external starting signal are also possible.

ii NOTE

• Define the extent of the fault recordings using the control settings of the Fault recording function.

• Logging of events in the fault log always occurs.

Reading Fault Records

You can read out the fault record recorded in the device via the communication interfaces. You can do this
from a PC with DIGSI 5 or by way of standard (IEC 61850, IEC 60870-5-103) from a central controller upon
request. The fault records read out via DIGSI 5 are saved on the PC in the COMTRADE format. You can analyze
the fault records with the analytical software SIGRA.

Procedure

• Use the project-tree window to reach the fault records of your SIPROTEC 5 device.
Project → Device → Records

The fault records that have been loaded from the device to date are displayed with time stamps and fault
numbers.

• To read all fault records stored in the device, click the Read records button in the headline of the
indication list.

8.7
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ii NOTE

• Take note that when accessing via online access points the fault records read replace all fault records
previously shown in the window. If you wish to save special fault records, then export the fault
records (see chapter 8.5.13 Saving and Deleting the Logs).

• When accessing via a device created in the project, older fault records no longer in the device remain
kept. If you wish to delete no longer needed fault records, read chapter 8.5.13 Saving and Deleting
the Logs).

[scaslstr-080413-01.tif, 1, en_US]

Figure 8-41 Reading Fault Records with DIGSI 5

Displaying Fault Records

Procedure

• To be able to display and analyze a fault record, you must open the fault record of your choice in the list
of read fault records by double-clicking.

After opening, the fault record is automatically displayed on the COMTRADE Viewer. You can select between
primary and secondary values. If you wish to do expanded analyses of fault records using the options of
the COMTRADE viewer, you can optionally press the Open record with SIGRA button to start the analytical
software SIGRA. You must have the analytical software SIGRA installed on your PC.

8.7.3
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Figure 8-42 Displaying a Fault Record with the COMTRADE Viewer

Saving and Exporting Fault Records

For the analysis of important fault records you can save them as files on your DIGSI 5 PC. You have 2 export
options available in DIGSI 5.

Procedure

• Start the standard export of the fault record in COMTRADE format (CFG file) by pressing the Export
button in the headline of the display window (Figure 8-42 a)). The fault record is now available to SIGRA
and other analytical tools.

• Start the export of the fault record as a CSV file in tabular form by pressing the CSV button in the
headline of the display window (Figure 8-42 b)). You can, for example, open this file with Excel and
individually edit or analyze it.
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Deleting Fault Records

The recorded fault records are managed in a ring buffer in the device. So that new records can always be
created securely, the oldest records are deleted automatically when the maximum storage capacity is reached.
However, you can also delete targeted fault records. This differentiates whether you wish to delete the fault
records stored or selected in the device in a DIGSI 5 project.

Deleting Fault Records via the PC with DIGSI 5

• To delete the fault records stored in the device, click the Delete fault records button in the headline of
the display window (Figure 8-42 c)).

• You can delete selected fault records within a DIGSI 5 project. To do this, tag the respective fault records
and right-click with the mouse. Complete the delete action with the offered Delete option.

ii NOTE
Recorded events of corresponding faults in the fault log are also deleted with the fault records.

Recording a Test Fault Record

For test purposes, SIPROTEC 5 devices can record fault records of fixed length. You must manually initiate this
recording from the PC via DIGSI 5. The recording length of the test fault records is independent and is set to 1
second.

Procedure

• To start a test fault record, click the Start fault record button in the headline of the display window
(Figure 8-42 d)). Then read the current fault records to view and analyze them from your SIPROTEC 5
device.

Configuration of Fault-Record Channels

While the Fault Recording function contains the control settings for recording data, you must configure the
channels to be recorded with DIGSI 5 in the configuration matrix. Every application template contains a preset
configuration of channels to be recorded that you can adjust individually.

Fault-Record Channels
The following values are available for fault-record channels:

• Sampled values of analog measuring inputs (currents and voltages)

• Internal measured values of measured value preprocessing

• Internal function and operational measured values

• Binary status signals (internal or external)
Fault-record channels are configured in the information routing of DIGSI 5 (matrix). The Recorder column is
provided especially for this purpose.

8.7.5

8.7.6

8.7.7

Operation in the Operating State
8.7 Fault Recording

208 SIPROTEC 5, Operation, Manual
C53000-G5040-C003-L, Edition 03.2023
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Figure 8-43 Configuration of Fault-Record Channels with DIGSI 5

ii NOTE
The sampled values of analog measuring inputs (currents and voltages) are not freely configurable in the
fault record. The values are specified automatically by the routing of measuring points to the analog input
modules of the device.

ii NOTE
The maximum recording length of an individual fault record and the sum of fault records stored in the
device are affected by the following factors:

• Sampling rate setting

• Number of fault-record channels

• Type of fault-record channels
The Fault Recording chapter in the device manual gives an overview of attainable recording times.

Configuration of the Start Criterion

The start criterion for recording a fault record and the duration of a fault record are determined by the control
settings in the Fault Recording function. Read the Fault Recording chapter in the Device manual of your
SIPROTEC 5 device.

Start Criterion
A start criterion is the fault which is formed by the pickups of protection functions and which also takes
account of a reclosing cycle duration during the respective parameter setting.

• You can configure the start criterion for each parameter setting using your own user definitions. A
Recorder column especially provided for this purpose is then displayed in the information routing of
DIGSI 5 (matrix).
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[scusrrec-051016-01, 1, en_US]

Figure 8-44 User-Defined Configuration of the Start Criterion for Fault Recording

• You can also set parameters for the start criterion via an external start signal in the Fault recorder
function. >External start). With this you can, for example, initiate recording of a fault record using
an external protection device without internal fault recording in case of pickup.

• A test fault record can also be initiated manually and directly via the on-site operation panel of the device
(for example, via function key) or via DIGSI 5. For this, a freely configurable starting signal (>Manual
start) is available.

[scmnstrt-051016-01, 1, en_US]

Figure 8-45 Manual Start via DIGSI 5

Fault recording can also be initiated via communication. This can happen via the standards IEC 61850 and
IEC 60870-5-103 through a connected substation automation technology system.
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Change Device Settings

Date and Time Synchronization

The integrated date and time synchronization of your SIPROTEC 5 device allows you to assign the precise time
of events to an internally maintained device time. Events in the logs are stamped with the device time. These
time stamps are also transmitted during transmission to substation automation technology or via a protection
interface. You can synchronize the device time using external time sources. You can also take local time zones
and daylight-saving time arrangements into consideration.

Setting Time and Date

You can set the date and time of your SIPROTEC 5 device through the on-site operation panel as well as the
DIGSI 5.

Setting via DIGSI 5
Date and time are internal device quantities. DIGSI 5 access is via online access in the project-tree window.
Here you will see the status of configured time sources and the current device time.
Online access → Interface → Device → Device information → Time information

• To be able to enter your local device time and the date, go to the Device time section and select the Edit
time button.

[scztinfo-030311-01.tif, 1, en_US]

Figure 8-46 Time Information in DIGSI 5

• After finishing the input, press the Set time button to transfer it to the device.

• The display for modified values for date, time, and their cyclical updates will confirm the successful
transfer.

ii NOTE
The Edit time button is inactive until data have been queried from the online device for the first time.

Settings on the Device Using the On-Site Operation Panel
To reach the settings for date and time from the main menu, use the navigation keys on the on-site operation
panel.

• Select Main menu → Device functions → Date & Time.

8.8
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Figure 8-47 Date and Time Setting

• From the Date format menu item, select a display option.

• To change the format, press the Change softkey.

• Enter the change and then confirm the entry by selecting the Ok softkey.
The Date and Time menu items show you the current values with ongoing update.

• To change Date or Time, select the desired menu item and press the Change softkey.

• Enter the changes and then confirm the entry by selecting the Ok softkey.

Setting Time Keeping Parameters

Input the time keeping settings of your SIPROTEC 5 device preferably using DIGSI 5. You have access here
to all possible settings. You can only access some of the settings using the on-site operation panel while the
device is being operated.

Settings Using DIGSI 5
To reach the time settings of your SIPROTEC 5 device, use the project-tree window.

• Select
Project → Device → Parameter → Time settings

• Select the desired date format.

• Configure up to 2 external timers (time source, latency, time zone) and the time by which failures should
be logged.

First decide whether your PC settings should be accepted or whether you wish to enter the settings manually.

• Enter the settings for your local time zone and daylight saving time. The settings include the local time
zone (relative to GMT) as well as the daylight saving time options (activation, start, end, and offset of
daylight saving time).

For application and setting information, refer to the chapter System Functions in the Device manual.
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[ScZtkonf-040718, 1, en_US]

Figure 8-48 Time Settings via DIGSI 5

Settings on the Device Using the On-Site Operation Panel
You can only access some of the settings using the on-site operation while the device is being operated.
To reach the settings for time synchronization from the main menu, use the navigation keys on the on-site
operation panel.

• Select Main menu → Parameter → General → Time sync.

[sctimsyc-080413-01.tif, 1, en_US]

Figure 8-49 Time-Synchronization Settings

• Configure up to 2 external time sources. There are port and channel numbers in communication inter-
faces for every configured time source. This depends on the configured hardware of your SIPROTEC 5
device.

• Select the time-zone arrangement (UTC or local) for each time source.

• Select the time by which time synchronization failures should be logged.
For each change in the settings, select the desired menu item and press the Change softkey.

• Enter the changes and then confirm the entry by selecting the Ok softkey.
For application and setting information, refer to the chapter System Functions in the Device manual.
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ii NOTE
Make sure that the settings for the time sources coincide with the actual hardware configuration of your
SIPROTEC 5 device. In any event, incorrect settings cause the status indications of time sources to pick up.

Status and Monitoring of Time Keeping

Time Information in DIGSI 5
The compact overview of the status of time synchronization in your SIPROTEC 5 device will give you support
information about the DIGSI 5 especially during commissioning. You reach the overview in the project-tree
window via Online access.
Online access → Interface → Device → Device information → Time information

[scztinfo-030311-01.tif, 1, en_US]

Figure 8-50 Time Information in DIGSI 5

For every time source, you see the following:

• Last received time (with date)

• Receipt time of the last received time telegram

• Configured type of timer

• Indication of timer outage or failure

• Whether the device time is currently synchronized from the time source
The lower section displays the device time, which is continuously updated. If the internal device time and the
infeed time source were synchronous at the time of telegram receipt, both displayed times are identical.

ii NOTE
All indicated times (even of time sources) take account of settings for local time (zone and daylight saving
time of the device) in the form of a numerical offset to UTC (universal time).

Time Information on the On-Site Operation Panel
To reach the settings for date and time from the main menu, use the navigation keys on the on-site operation
panel.
Main menu → Device functions → Date & Time

8.8.4
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[scdttime-080413-01.tif, 1, en_US]

Figure 8-51 Date and Time Setting

The menu items Date & Time show the current values, which are permanently updated. You can also change
entries here.

Time-Synchronization Indications
Internal time synchronization is monitored cyclically. Important synchronization processes, the status of time
sources and errors detected are reported and entered in the operational log. For this purpose, see the list of
indications for internal date and time synchronization in the System Functions Device manual.

ii NOTE
In case of a missing or discharged battery, the device starts without active external time synchronization
with the device time 2011-01-01 00:00:00 (UTC).

Setting the Contrast of the Device Display

You can enter the contrast setting only on the device via the navigation keys on the on-site operation panel.

Procedure

• Open the contrast menu by pressing the Left + Right navigation keys simultaneously.

• If prompted, change the contrast intensity +/- using the Right/Left navigation keys.

• You can restore the basic setting by simultaneously pressing the Up + Down navigation keys.

• Then confirm the setting changes with Enter.

[sckontra-080413-01.tif, 1, en_US]

Figure 8-52 Contrast Setting of the Device Display

Changing the Language on the Device

If the Language of the operation panel was configured in DIGSI 5, you can select between the national
language and US English on the device at any time.

8.8.5

8.8.6
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• To reach the setting dialog for the language selection, press the function key <F9>.

• Use the up/down navigation keys to select the languages.

• Finally, confirm the setting changes with Ok.

Changing the Units System on the On-Site Operation Panel

• To reach the settings dialog for selecting the units, select the Localization menu in Device functions.

• To select the units system, press the Change softkey.

• Use the Up/Down navigation keys to select the units system.

• Finally, confirm the setting changes with Ok.

[scchgun1-050413-01.tif, 1, en_US]

Figure 8-53 Units System of the Country

[scchgun2-050413-01.tif, 1, en_US]

Figure 8-54 Switching the Units System

Changing the Device Language on the PC in DIGSI 5

• To reach device information of your SIPROTEC 5 device in the menu, use the project-tree window. You
can reach the device optionally via online access or via the project in which it must be created:
Online access → Interface → Device → Device settings
Project → Device → Settings→ Device settings

• In the project-tree window, click Device settings.

• Select the language via the Operation-panel language parameter.
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[scsprums-040613-01.tif, 1, en_US]

Figure 8-55 Language Change with DIGSI 5

• The setting is accepted in the device through Load configuration in devices.

• When prompted, enter the confirmation ID and finally click Ok.
The operation panel language changes automatically after it is downloaded from the PC to the device.

Changing Confirmation IDs

Using confirmation IDs provides a simple level of operational security. This prevents actions on the device that
may be caused by human error or oversight. Several groups of control or change operations on the device may
require different confirmation IDs, which you can configure individually in DIGSI.

Changing Confirmation IDs on the PC in DIGSI 5
To reach the menu for the confirmation IDs of your SIPROTEC 5 device, use the project tree window.
Project → Device → Security and protection
The confirmation IDs for 4 different access types will appear in the main window.

• Activate or deactivate a confirmation ID by setting or removing a check mark in the Active column.

• To change a confirmation ID, click the change button in the Action column. The change window opens.

• Enter the new confirmation ID (comprising 6 digits from 0 to 9) twice, and then confirm it with OK. The
confirmation IDs are set ex factory as default (see table Table 8-13.)

[sc_security_password_confirmationID, 2, en_US]

Figure 8-56 Window for Activating Confirmation IDs
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Figure 8-57 Window for Changing Confirmation IDs

Table 8-10 Default Setting of Confirmation IDs

Operating Range Default Setting
Read access 1111113

Set/operate 222222
Switching (operation) 333333
Switching (unlocked) 444444
Switching authority 666666

Setting Function Settings

Enter the function settings of your SIPROTEC 5 device preferably using the DIGSI 5. You have access here to all
possible settings. Using the on-site operation panel you can make individual setting changes while the device
is in operation.

Offline Settings Using DIGSI 5
To reach the function parameter settings of your SIPROTEC 5 device, use the project-tree window.

• Select Project → Device → Parameters → Function group → Function → Function block
The settings of the selected function block are displayed in the main window.
If multiple settings groups (see chapter 8.8.9 Settings Group Switching) have been activated, first ensure that
you are making your changes in the correct settings group. You can change this in the header of the main
window if necessary. In another column of the main window, you can compare the setting values with those
in another settings group.

• To change a setting value, click the setting arrows of the parameter concerned.

• For selection settings, select a value from the displayed list of possible settings.

• For decimal parameters, you can change the setting value incrementally using the setting arrows, or
enter the setting value directly via your PC keyboard. Setting values that are not permitted are indicated
by a red background color and red exclamation marks in the affected areas of the project-tree window.
DIGSI 5 cannot load invalid setting values into the device.

8.8.8

3 This confirmation ID is automatically used internally for read operations; user details are not required for this non-modifiable
confirmation ID.
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Figure 8-58 Setting Function Settings in DIGSI 5

• When you are finished changing your settings, load the entire device configuration into the device.

• To do so, click with the right mouse button the Load configuration to device context menu.

• To load the setting changes for multiple devices via the network, press the project-specific Load configu-
ration to device button in the project-tree window.

[scladknf-040613-01.tif, 1, en_US]

Figure 8-59 Loading Function Settings in the Device
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Online Settings via DIGSI 5
You should always use the online setting if you want to change individual function settings of a device in
operation. To reach the function settings of your SIPROTEC 5 device, use the project tree window.

• Select Online access → Interface → Device → Settings

Settings on the Device Using the On-Site Operation Panel
Using the on-site operation panel you can access function settings while the device is in operation. To reach
the function settings from the main menu, use the navigation keys on the on-site operation panel.
If multiple settings groups (see chapter 8.8.9 Settings Group Switching) have been activated, first ensure that
you are making your changes in the correct settings group. You can change this as necessary.

• To do this, select sSettings → General → Change group settings in the main menu
When the correct settings group is selected, proceed as follows:

• Select Main menu → Settings → Function group → Function → Function block
The active settings of the selected function are displayed in the device display.

• To select the parameter to be changed use the navigation keys or the number keys for direct selection
according to the right sidebar.

[scaswfnk-080413-02.tif, 1, en_US]

Figure 8-60 Changing and Selecting Function Settings on the On-Site Operation Panel (Example)

• To change a parameter setting, click Change in the base bar dialog.

• If you have not entered the confirmation ID in advance, you will be prompted to enter the confirmation
ID.

• Use the number keys to enter the confirmation ID and confirm with Ok.

• For selection settings, use the navigation keys to select a value from the displayed list of possible
settings.

• For decimal parameters, you can input the setting value directly using the number keys within the
displayed setting range.

• Confirm your settings using Ok or Enter. Setting values that are not permitted are declined.

• To activate all changes made, press the left navigation key until you are prompted in the base bar to
confirm or cancel the changes.

• Confirm your changes using Ok.
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Figure 8-61 Confirming Taking Over of Function Settings on the On-Site Operation Panel

Settings Group Switching

For different applications, you can save the respective function settings in so-called Settings groups and, if
necessary, activate them quickly.
You can save up to 8 different settings groups in the device. In the process, only one settings group is active at
any given time. During operation, you can switch between settings groups. The source of the switchover can
be selected via a parameter.
You can switchover the settings groups via the following alternatives:

• Via the on-site operation panel directly on the device

• Via an online DIGSI connection to the device

• Via binary inputs

• Via communication connection to a substation automation technology
The communication protocols IEC 60870-5-103, IEC 60870-5-104, IEC 61850, DNP, or Modbus TCP can
be used for the switchover of the settings groups.

A settings group includes all switchable settings of the device. Except for a few exceptions (for example,
general device settings such as rated frequency), all device settings can be switched.
This section assumes multiple configured settings groups, and only describes the switchover process. The
function and their setting parameters are described in the chapter Settings Group Switching in the Device
manual.

Settings Group Switching via DIGSI 5
Use the project-tree window to initiate settings group switching on your SIPROTEC 5 device. Settings group
switching can be initiated both via the project (offline) and via the online access point.

ii NOTE
Bear in mind that the switchover of the settings group in the project is done by loading the DCF into the
device. This causes an automatic device restart (reset). If you make other functional changes at the same
time, a device restart can also occur in online mode or at the on-site operation panel. Switchover without
interrupting device operation may be performed only with online access.

Settings group switching via the project (offline)

• Select: Project → Device → Settings → Device settings → Active settings group

• Select the desired settings group and then load the DCF into the device.
For settings group switching via the online access point

• Select: Online access → Interface → Device → Settings → Device settings → Active settings group

• Select the desired settings group and then load the change into the device.

8.8.9
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Settings Group Switching at the Device Using the On-Site Operation Panel
Use the navigation keys of the on-site operation panel to initiate settings group switching on your SIPROTEC 5
device.

• Select Main menu → Settings → General → Change group

• Using the navigation keys, go to the Activat. of settings group setting and click Change in the base bar
dialog.

• If you have not entered the confirmation ID in advance, you will be prompted to enter the confirmation
ID.

• Use the number keys to enter the confirmation ID and confirm with Ok.

[scesakpa-080413-01.tif, 1, en_US]

Figure 8-62 Setting the Active Settings Group on the On-Site Operation Panel

• Use the navigation keys to select the settings group to be activated from the displayed list of possible
settings.

• Confirm your settings using Ok.

• To activate settings group switching, press the left navigation key until you are requested to confirm or
cancel in the base bar.

• Confirm your changes using Ok.

[scbstubn-080413-01.tif, 1, en_US]

Figure 8-63 Confirming Taking Over of Changes on the On-Site Operation Panel

Settings Group Switching via Binary Inputs
For settings group switching via binary inputs on your SIPROTEC 5 device, you first have to set the Settings
group activation setting to via binary input.
You must also have configured the binary input signals that are necessary for the settings group switching on
the contacts of your device. You will find these in DIGSI 5 under:
Project → Device → Information routing → General → >PG Selection Bit 3/Bit 2/Bit 1
100 ms after one of the 3 signals is changed (stabilization time), the signal image present will lead to a
switchover to the corresponding settings group. The following table shows the possible binary codes (BCD)
and associated settings groups (PG). From the table, you can also determine which input signals you have to
route depending on the number of settings groups.
Example: To ramp up the device, the parameters Number of settings groups = 4 (PG 4) → >PG Selection
Bit 1, and >PG Selection Bit 2 must have been routed to binary inputs.
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Table 8-11 Binary Codes of the Signal Inputs and Associated Settings Groups

BCD Code via Binary Inputs SG 1 SG 2 SG 3 SG 4 SG 5 SG 6 SG 7 SG 8
>PG selection bit 3 0 0 0 0 1 1 1 1
>PG selection bit 2 0 0 1 1 0 0 1 1
>PG selection bit 1 0 1 0 1 0 1 0 1

Settings Group Switching via Control
When using the Control function for switching, the settings groups can be switched via a communication
connection from the substation automation technology or via a CFC chart.
The communication protocols IEC 60870-5-103, IEC 60870-5-104, IEC 61850, DNP, or Modbus TCP can be
used for the switchover of the settings groups via a communication connection.
To use a CFC chart for switching, you must create a new CFC chart in DIGSI 5. Create the CFC chart in the DIGSI
5 project tree under Name of the device → Charts → Add new chart. Link the signals that control settings
group switching in the CFC chart.

ii NOTE
The device starts in this mode after a DCF upload (offline mode), using the active settings group 1. The
device is informed about a settings group change via the substation automation technology only. As long
as the substation automation technology command is pending, protection runs using the settings from
active settings group 1.
If the Control mode is changed in online mode (settings changes via DIGSI 5 or the on-site operation
panel), the device continues to run with the last active settings group. If a substation automation tech-
nology command for a settings group change is sent or the mode for settings group switching is changed,
this state ends. In the case of a device warm start, the device starts in the mode of the most recently active
settings group.

Operation in the Operating State
8.8 Change Device Settings

SIPROTEC 5, Operation, Manual 223
C53000-G5040-C003-L, Edition 03.2023



Control System on Site

General

You can execute switching device control via a connected substation automation system and through DIGSI 5.
You can also control the device directly via the keyboard. The large graphic display is best suited for this
purpose but control is also possible with the small display.
Operation of switching devices is subject to different safety tests such as switching authority and switchgear
interlocking protection-function test. You will find a detailed description of these functions in the Device
manual in the chapter Control Functions.

Menu Structure

If you go to the main menu of the device and select the Control menu item, you get the following submenu:

[scstemen-090413-01.tif, 1, en_US]

Figure 8-64 Control Menu on the Device Display

Table 8-12 Subitems of the Control Menu with Meaning

Menu Item Submenu Meaning
Equipment Display Display of current state of all switching devices.

Control Display of current state of all switching devices. You have the
possibility to transmit a switching command.

Acq.blk./man.update Display of current state of all switching devices. If acquisition
blocking is placed for the switching device, you have the
option of a manual update.
Acq.blk. (appears after selecting Change): allows you to
place acquisition blocking for a switching device. Entry of the
confirmation ID is necessary.

Status You are notified about the status of the individual switching
devices with respect to acquisition blocking, manual update.

Other Display As for the Equipment item, but for user-defined objects of
type DPC (double command), SPC (single command), and PLC
(marker).

Control
Acq.blk./man.update
Status

8.9
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Menu Item Submenu Meaning
Interlocking One line for every

switching device
Display of interlocking status of the switching devices with
the letters S, D, P, and B.

• S = Check of switching authority
• D = Check of double-activation blocking
• P = Check whether position is reached
• B = Check of blocking by protection

Switching
authority

Switching authority =
Local

Display of current switching authority. If the device does not
have a key switch, a change dialog is displayed and you can
enter the change via the device keyboard. If the device has a
key switch, the Switching authority menu bar is static and a
change can be made only via the key switch.

Switching mode Switching mode = Inter-
locked

Display of current switching mode. If the device does not
have a key switch, a change dialog is displayed and you can
enter the change via the device keyboard. If the device has
a key switch, the Switching mode menu bar is static and a
change can be made only via the key switch.

Switching Authority

The switching authority ensures that simultaneous control can be done only from one command source.
For example, you must prevent a switching command from being executed by the control center during
field work. To do this, you must set the switching authority to Local. SIPROTEC 5 recognizes the following
switching authorities:

• Local

• Remote/station

• Remote/control center
The Remote/station switching authority level was redefined in IEC 61850. You can deactivate the switching
authority in the device. Full support for this level is ensured only in devices with the IEC 61850 protocol.
The Remote/control center switching authority is normally used as the remote switching authority. You
can change the switching authority from Local to Remote Using the top key switch. You can also set this
switchover in devices without the key switch after entering the confirmation ID.

Switching Mode

Changing the Switching Mode

! DANGER
Danger due to hazardous voltages during the operation of electric devices
Noncompliance with the safety notes will result in death or severe injuries.

² Only electrically qualified personnel may work on these devices. The electrically qualified personnel
must be thoroughly familiar with pertinent safety regulations and precautionary measures as well as
the warnings in this manual.

If you perform non-interlocked switching, for example, in the commissioning phase, you can change the
switching mode during operation.
You can set the switching mode using the key switch. Non-interlocked switching is permitted in the horizontal
key position (Interlocking OFF). Only interlocked switching is allowed in the vertical key position.

8.9.3
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Proceed as follows for devices without a key switch:
² Select the menu item Commands in the main menu.

² Go to the menu item Switching mode.

² Select Interlocked or Non-interlocked and confirm with Ok.

² You can set this switchover after entering the confirmation ID.

Control with Graphic Display

Devices with a graphic display can depict a single-line diagram of the field in the control display, see
Figure 8-65. You can create the control display with the Display Editor of DIGSI 5. The display becomes active
directly after activation. You can reach the display at any time by pressing the yellow <Ctrl>key.

[scabzstb-280211-01.tif, 1, en_US]

Figure 8-65 Control Display (Example)

Selecting Switching Device
From this control display, you can select the individual switching devices using the navigation keys. After the
position has been switched, the feedback is shown directly in the control display. A separate default display
(single line without control capability) is not present but can be created.
Refer to the notes in chapter 5.3 Displays for Indication and Control.

Initiating Command

• Select the switching device to be controlled using the navigation keys.

• Then enter the new target position ON or OFF with the corresponding control key (green <I> for ON, red
<O> for OFF).

• Confirm the query with the softkey marked Ok in the display.
If the switching operation is permissible, it is executed, otherwise you receive a notification about the cause of
rejection.
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[scauswqa-090413-01.tif, 1, en_US]

Figure 8-66 Selecting a Switching Device in the Control Diagram

You can also initiate a control action via the navigation keys after selecting a switching device.
To do so, select Open or Close in the menu and confirm with Ok.

[scsteuvo-090413-01.tif, 1, en_US]

Figure 8-67 Initiating Control Action

Control with Small Display

For devices with the small display, you can control from the switching device list, in the same way as for
devices with the large display. A single-line representation of the feeder is impossible here.

• Select the list of all switching devices in Commands/Equipment and then the switching device to be
controlled in the Control menu item.

The currently recorded position is shown to you.

• You now control via the right context-sensitive key (labeled Switch).

• Then select the target position (off or on).

• Confirm the query of the confirmation ID.
After entering the confirmation ID for on-site control, the switching command is output while considering the
interlocks (switchgear-interlocking protection conditions, switching authority, etc.).
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Figure 8-68 Control from the List on the Small Display

Acquisition Blocking and Manual Updating

During commissioning, maintenance, or testing, a brief interruption of the connection between the logical
signals and binary inputs may be useful. It allows you to manually update the status of a switching device that
is not providing feedback correctly. Before this can take place, you must first set acquisition blocking.
To set the acquisition blocking, proceed as follows:

• Using the navigation keys, move in the main menu of the device display to
Commands→Equipment→Aq.blkman. update.

• Select the appropriate device (for example, a circuit breaker) from among the several switching devices
using the navigation keys.

• Press the Change softkey.

• Enter the confirmation ID (not relevant for active role-based access control (RBAC) in the device).

• Confirm the process with the softkey marked OK in the display.
After entering the confirmation ID (only with the RBAC inactive), acquisition blocking is switched on.

[sc_detection, 1, en_US]

Figure 8-69 Activating the Acquisition Blocking

Manual updating of the switching device is possible from within the same menu.

• Select Manual update (Figure 8-70) using the navigation keys.

• Select the switching device setting to be manually updated using the navigation keys (for example, off,
Figure 8-71).

• Confirm the process with the softkey marked Ok in the display.

8.9.7
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[sc_status, 1, en_US]

Figure 8-70 Activating Manual Update

[sc_statu2, 1, en_US]

Figure 8-71 Selecting Position

The manually updated position of the switching device will be displayed.

[sc_statu3, 1, en_US]

Figure 8-72 Position of the Switching Device

ii NOTE
For security reasons, manual updating is possible only directly through the on-site operation panel of the
device and not through DIGSI 5.

ii NOTE
Setting acquisition blocking and the subsequent manual updating are also possible via the IEC 61850
system interface.

You can set acquisition blocking also via a binary input. If you want to put in the feeder or the switching
device in revision, you can set the acquisition blocking with an external toggle switch for one or more
switching devices. For this purpose, every switching device in the Switch function block (circuit breaker or
disconnector switch) has the input signal >Acquisition blocking. This signal can also be set from the
CFC.
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[sc_beerfa, 1, en_US]

Figure 8-73 Input Signals >Acquisition Block and >Release Acquisition Block & Manual
Updating on the Switching Device

ii NOTE
Interlockings are carried out with the status changes of the switching device. Remove acquisition blocking
again manually. Otherwise, position changes of the switching device are not detected and interlockings are
ineffective.

If the acquisition blocking and the manually updated position are set using the operation panel of the device
or the system interface IEC 61850, these are retained until the acquisition blocking is manually deactivated.
When you initially start the device, the acquisition blocking is deactivated.
Except for a restart, the acquisition blocking and the manually updated position are retained.
If the acquisition blocking is activated via the input signal >Acquisition blocking, it is retained as long as
the binary input is active.
To set the acquisition blocking of a switching device, the following sources are possible:

• Operation panel of the device

• System interface IEC 61850

• Input signal >Acquisition blocking
All sources undergo OR operations, that is, the acquisition blocking remains set until all the sources are
deactivated.
After deactivation of the acquisition blocking, the actual position of the switching device is adopted and
displayed in the operation panel of the device.

ii NOTE
When the acquisition blocking is activated or the switching device updated manually while the entire
device or the switching device is in application mode, these states are not saved. The acquisition blocking
and the manual updating are not retained after a restart.

The acquisition blocking and the manual update for the circuit breaker, the disconnector, and the tap changer
are reset by way of the >Reset AcqBlk&Subst binary input. Setting acquisition blocking and manual
update is blocked with the input activated.

Status Display

You reach the following display through the Status menu item:
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[scstatus-090413-01.tif, 1, en_US]

Figure 8-74 Status Display of Switching Devices

The meaning of the status columns is as follows:
AB = Acquisition blocking active (acquisition blocking for the switching device is set)
MU = Manual update (switching device was manually updated)
CH = Chatter blocking active (Chatter blocking has been activated and is still set)

Setting a Marker

In order to be able to set a marker manually with a device operation, you must activate a cross in the Control
Menu column in the DIGSI 5 information matrix (see Figure 8-75).

[scrangma-090413-01.tif, 1, en_US]

Figure 8-75 Routing of a Marker to the Operating Menu

The marker appears in a list, for example, under
Commands → Additional → Display or → Status.
At this point you can observe or vary the current status.

ii NOTE
To change the state of a marker (from On to Off or vice versa), you need to enter the confirmation ID for
control.

Assignment of Authorizations with Confirmation ID

Security against human error or unintentional mistakes is promoted by using confirmation IDs.
Figure 8-76 shows an example of a device without a key switch. For devices with key switches, the confirma-
tion IDs are not required for non-interlocked switching and for the switching authority. These are replaced by
the corresponding key switches for non-interlocked control and for local switching authority.
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Figure 8-76 Assignment of Confirmation IDs

Table 8-13 Confirmation IDs

Name Description
Settings / operation Confirmation to change settings on the device display and DIGSI 5
Fct.Key/PB operation Access to process data is possible with the help of push-buttons and func-

tion keys. The confirmation ID of Settings / operation is requested.
Switching (process) To prevent unintentional switching of combined protection and control

devices, this general confirmation for switching on site is available. Release
for manual placement of markers

Switching (unlocked) Only in devices without key switch confirmation for unlocked switching
(only effective in devices with parameterized switchgear interlocking
protection conditions)

Switching authority Only in devices without key switch release of On-site switching authority,
and hence of control on the device display

Switching (without synchro-
check)

Authorization for unsynchronized switching of a circuit breaker (only in
devices with activated synchrocheck)

Control with Function Keys

8 of 9 function keys can also be used for control. Function key <F9> is hardcoded for language switching.
Using a function key you can initiate a switching sequence, for example, to switch on a feeder.

• You reach the function keys by pressing the blue <Fn> key and the corresponding digit from <1> to <9>
in the numerical keypad.

• Define your switching sequence using the CFC editor.

• Link a single command (type SPC) in the information routing matrix with the desired function key.

• Connect this single command with a SPC_INFO block that starts the switching sequence.

8.9.11
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Overview
This chapter contains information about the commissioning of the SIPROTEC 5 device. Test functions inte-
grated in the device support you during testing, simplify testing processes and reduce testing times. You will
get an overview of the numerous possibilities of initial startup in chapter 9.3 Initial Startup.
The secondary test described in chapter 9.4 Secondary Tests is used for checking:

• Correct setting of functions

• Routing of logical signals to the binary inputs and outputs

• Interfaces and many more
Chapter 9.5 Primary Tests deals with the primary test and contains information about the test method.
Information specific to protection functions can be found in the device manual.
The following chapter gives you an overview of the test functions integrated in the device. You can find the
offline testing options during engineering in the DIGSI 5 online help.

9.1
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Test Suite Integrated in the Device

Test Functions

After you complete the initial startup (see chapter 9.3 Initial Startup), you can access the test functions
integrated in the device. To do this, establish connection to the online device. In the project tree, open the
Folder Test Suite. Underneath you will find the individual test points that are explained to you in the following
chapters. The following figure shows the project tree.

[scproans-110413-01.tif, 1, en_US]

Figure 9-1 Project Tree

If you have activated a connection password for the device, you must enter it in the corresponding dialog.
After correct password entry, the connection between DIGSI 5 and device is established. In case of wrong
input, the connection is not established.
If you have configured a confirmation ID with DIGSI 5, this is queried when you access the individual test
functions. Enter here the corresponding 6-digit number.
You will find details for configuring the password in the Security Manual.
If the connection between DIGSI 5 and the device is interrupted during a test function, re-establish the
connection to the device. Then do a reset on the device with DIGSI 5. If no connection can be established,
then do the reset directly on the device through the on-site operation panel. After successful reset, the device
is now in a normal operating state 9.3.3 Initializing device and verifying basic status.

ii NOTE
The device must be set in another mode for most tests. If the tests occur in a system in operation, ensure
that the running operation is interrupted.

After successful tests, bring the device back to the previous mode in the following manner:

• Confirm the link Show device mode in the upper right of the work window.

9.2

9.2.1
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[scgemoaz-210611-01.tif, 1, en_US]

Figure 9-2 Top Rail in the Working Window

• Select the previous mode in the working area Device information under Device mode .

• Click the Restart button.

Testing Current and Voltage Inputs

If you click in the project tree according to Figure 9-1 on the menu item Analog inputs, a visualization of the
current values of the measuring points that exist in the device will appear in an editor. On the left side you
will see the phasor diagram for 3-phase analog inputs (absolute value and phase). To the right the measured
values are displayed as numerical values. The primarily measured values for voltage and current are shown as
indicators of absolute value and phase. The reference is the voltage in phase A of measuring point 1. If no
voltage is connected, the current in phase A of measuring point 1 serves as the reference. All indicated phasor
values refer to the reference quantities.
You can identify and verify the following errors with measured-value control:

• Turner in the analog wiring

• Vector group

• Direction between current and voltage
Devices connected via effective connections can also represent analog measuring points of remote ends as
phasors. In this case, the phasors of measuring points of up to 6 remote ends are shown. For example, the
stability of a line differential protection can thus be verified.

[sctstane-140211-01.tif, 1, en_US]

Figure 9-3 Example of a Check of Analog Inputs
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Test sequence:

• Feed the test quantities to the terminals (for example exchange terminals in the control cabinet) using
multiphase test equipment. Siemens recommends a test with the rated values and the infeed of current
and voltage in phase. The test functions from 10 % of the rated quantity.

• Check the measuring result in the DIGSI 5 operating program (absolute value and phase). Make use
of the phasor diagram as well as the indicated measured values. Check phase displacement between
voltage and current as well.

• In the event of implausibility, first check the proper connection of the test equipment and the angle
between voltage and current set in it. Then check the wiring to the device, as well as the settings (for
example under Power-system data).

Figure 9-3 shows you the result of a successful test on a device which has 4 voltage and current inputs.

ii NOTE
To check the wiring between device and connected transformers, Siemens recommends that this test be
done on the plant with primary measured signals. This allows you to check the correct connection of
secondary circuit completely.

ii NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.

Testing Protection Functions

The purpose of this test is to verify the correct setting of protection functions and the routing of signals. To
do this, you can feed the test signals with test equipment. Digital test equipment offers you multiple test
programs and test sequences.

ii NOTE
Simulation mode is indicated by flashing of the top line of the device display.

ii NOTE
If you only want to select a graphical representation of a protection function, all available and active
protection functions of your SIPROTEC 5 device are checked.

Simple tests can also be done via simulation mode on the device and DIGSI 5 interaction. To do this, use
DIGSI 5 to generate test sequences which are then executed in the device without the need for external test
equipment and which simulate the change in values on the inputs.

• Click the Test sequences folder in the project tree.

• Open this folder by double-clicking.
Under the Create test sequence menu item create your test sequence which, for example, consists of 3 steps:
the pre-fault, the short circuit and the post-fault. You can save the created sequence and use it for other tests.
You will also find the stored sequence under the Test sequences folder. Sequences can be copied between
devices that have the same measuring points.
Figure 9-4 shows you the editor for creating test sequences. You can enter a name (for example, pre-fault,
post-fault) for every test step. You can set the duration of the current test sequence, as well as the duration
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of a ramp. You can define amount and phase angle for each phase of a measuring point. You can select the
frequency in 3 phases for each measuring point.
Additionally you can define a ramp for each phase via amplitude, phase or frequency via the ramp functions.
You can still define 3 various harmonic superimpositions per phase. This allows the setting of ramps within
one test step. If additional binary inputs are effective, you can adjust that in the section below. Using a hook
tag which binary input is active during the test step. If a voltage (corresponds logically to 1) is present, the
binary input is active.

[scprfsqu-150211-01.tif, 1, en_US]

Figure 9-4 Creating a Test Sequence

You can a use created test sequence, for example, for a protection function test. Start a test sequence in the
protection function test editor in DIGSI 5. You can also start a test sequence through a binary input of the
device. By starting through a binary input you can play back test sequences in several devices simultaneously.
You lay down the start criterion for the device using DIGSI 5 Figure 9-5. The test quantities are fed as sampled
values directly into the functions of the device by bypassing the analog and binary inputs. Before starting a
sequence DIGSI 5 switches the device to a simulation mode that activates the internal signal generator.
To check a protection function systematically, click again in the project tree the Test button and open
the Protection function test menu item. You are offered the existing protection functions and you can
select which protection function is tested. The characteristic curve of the protection function appears in the
operating range (see Figure 9-5). The measured values are displayed in color in the characteristic curve and
the list of spontaneous indications is updated simultaneously. Feeding through a test sequence is done in this
simulation mode where the protection functions work with the calculated sampled values of the sequence.
Switching to an internal sequence is done in DIGSI 5. The designated sequence is selected (it must first have
been configured offline), loaded into the device and its progress activated.
A SIPROTEC 5 device has numerous protection and supervision functions that work in parallel. For the tests
switch some or only the function to be tested. For this purpose, a test aid that greatly simplifies the test for
you was set up in SIPROTEC 5.
The protection functions have indirectly the same setting as when you switch the mode to Test in the
function. In this state, the protection function is active. In addition, a test bit is generated and transmitted
with every indication. In the Test setting the routed relay in the device is not activated and the circuit breaker
is thereby not actuated.
Upon exiting of the test mode, the execution of an authorized test period or the conscious switching to
the normal operating state (Process mode) leads to the deactivation of the temporary settings. The original
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setting then becomes active. You can also make us of this test menu to have a quick overview of available and
enabled protection functions.

[scprscfk-160413-01.tif, 1, en_US]

Figure 9-5 Testing a Protection Function (Example, Overvoltage Protection)

ii NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.

Creating Signals for Communication Interfaces

The test editor serves to set signals or states in the device that are then output via the communication
interfaces.

Testing Switching Devices

During a primary test the device in combination with DIGSI 5 offers the possibility of checking switching
devices. Click again the Test button and open the Control functions menu item. The existing switching
devices appear in the operating range. You can set the switching state and read in the status again. To do
this, activate the respective switching device and execute the desired actions. The spontaneous indications log
the behavior of the switching device (see Figure 9-6). You can verify the interlocking conditions by opening or
closing disconnectors or grounding switches. This takes place via the binary feedbacks on the device. Induce
unauthorized circuit states and check whether the interlocking logic stored in a CFC plan works correctly in the
device.

9.2.4

9.2.5

Commissioning
9.2 Test Suite Integrated in the Device

SIPROTEC 5, Operation, Manual 239
C53000-G5040-C003-L, Edition 03.2023



! WARNING
Warning of danger due to unauthorized switching states
Noncompliance with safety notes means that death, serious injuries, or considerable material
damage can occur.

² Primary tests may be done only by personnel who are skilled electricians and who are familiar with
the startup of protection systems, with the operation of the system and with safety regulations and
provisions (switching, grounding, etc.).

Apart from circuit breakers and disconnectors, you can also increment transformer tap switch higher or lower
and check arc-suppression coils.

ii NOTE
This switching function is used exclusively for testing. Operational switching operations are performed with
the on-site device control or with a connected substation automation technology.

[scschver-150211-01.tif, 1, en_US]

Figure 9-6 Checking Switching Devices and Interlocking Conditions

² If special confirmation IDs are activated for this test, these must be entered prior to the test. This applies,
in particular, to non-interlocked switching. For this purpose, the switching authority must be on Remote
and DIGSI 5 must be authorized to carry out switching operations.

ii NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.
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Circuit-Breaker Test

² To test circuit breakers, go to Test suite and open the Circuit-breaker test menu item. The existing
circuit breakers then appear in the operating range (see Figure 9-7).

² You can bypass the interlock of the circuit breaker. You can activate the circuit breaker 3-pole or every
circuit-breaker pole separately depending on the type of the circuit breaker. The feedbacks from the
circuit breaker are shown to you in the bottom part of the window. DIGSI 5 shows you the available test
sequences. Before execution of the test, a confirmation ID is queried.

[sclsscpr-110413-01.tif, 1, en_US]

Figure 9-7 Circuit-Breaker Test

ii NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.

Device Information and Diagnostics

In online operation, if you open the Device Information table in the project tree, you get a lot of information
about the device. The table appearing in the working area shows different tabs with corresponding informa-
tion about the device. Figure 9-8 gives you an overview of the numerous possibilities.

9.2.6
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[scgerinf-100413-01.tif, 1, en_US]

Figure 9-8 Device Information Worksheet

• Device information:
General information about the device such as device name, MLFB number, product code and serial
number is indicated here. If the device communicates via Ethernet, you can at this point select the IP
address of the device through which DIGSI 5 communicates with the device (this setting is only available
in offline mode). You can furthermore set the device language here, as well as the operating modes
(process mode, commissioning mode).

• Resource consumption:
The 1st area shows you the state of the device load offline. If it is green, the parameterization can be
loaded into the device and real-time behavior ensured. If the lamp is red, functionality must be reduced.
The number of used function points is shown in the 2nd area. If the allowed number is exceeded,
replacements must be bought for device-related function points. To reorder, use the configurator and
follow the menu instructions there.
In the 3rd area, you are shown the capacity utilization of the operational diagram (Continuous Function
Chart, or CFC for short).

• Log
– Device diagnosis log:

Monitoring indications are entered in this buffer. If, for example, a device fault is present, the
required information is entered in plain text. Every result is time-stamped. Plain text means that you
receive the necessary information about, say, erroneous modules and the type of error. At the same
time, an operation recommendation such as replacement of the expansion module is given.

– Safety indications:
This buffer contains time-stamped logs indicating when the device was accessed using DIGSI 5.
Rejected access, e.g. if you entered the password incorrectly 3 times, is registered. You cannot
delete this buffer. This buffer is organized as a ring buffer. Selected indications can be transmitted
to a systems control and can be archived there. This guarantees a long-term buffer for accessing the
device as required in cybersecurity recommendations such as NERC-CIP (see chapter 11.1 Security
Design).
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• Time Information:
In this setting sheet, you can open diagnoses for the 1st and 2nd timer and query their synchronization
status. In addition, it gives information about the internal device time. This can also be set via this menu
for test purposes. If a high-precision second pulse is available, its status is also shown here 8.8.3 Setting
Time Keeping Parameters.

• Diagnostic Information:
Here detailed information on the individual hardware and software components are stored.

ii NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.
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Initial Startup

Establishing readiness for operation

It is assumed that you have gone through steps in chapters 1 to 4. Check the connection of the auxiliary
power supply. SIPROTEC 5 devices have 2 power-supply unit designs (type 1: DC 24 V to 48 V and type 2:
DC 60 V to 250 V as well as AC 110 V to 250 V). You can also read the rated voltage range from the name
plate. After successful testing of your voltage source, switch it on. The SIPROTEC 5 device is now in system
startup mode. The LEDs RUN (green) and ERROR (red) light up simultaneously. In addition, some LEDs on the
base module start flashing. If the RUN LED is continuously on and the ERROR LED is continuously off, the
device has started up.
Figure 9-9 and Figure 9-10 show the default state of the SIPROTEC 5 device display using the transformer
differential protection as an example. Figure 9-11 shows the default state of a SIPROTEC 5 Compact display.

[scligrdi-210113-01.tif, 1, --_--]

Figure 9-9 Factory setting of large display

[sclikldi-210113-01.tif, 1, --_--]

Figure 9-10 Factory setting of small display

[scligrdicc-050221_b, 1, --_--]

Figure 9-11 Factory Setting for the SIPROTEC 5 Compact Display
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Afterwards you can initialize the device by loading the parameterization. Before going to the
chapter 9.3.3 Initializing device and verifying basic status, read the information in the chapter 9.3.2 Using a
Project with DIGSI 5.

ii NOTE
If you find another default display after device startup, then someone before you has initialized the
device. You can now load your parameterization to the device. In the DIGSI 5 project tree, use the Load
Configuration in Device menu item.

Using a Project with DIGSI 5

All settings of the device are created with the DIGSI 5 operating program. The engineering department is
responsible for editing. In the respective project (see chapter 6 Using DIGSI 5) you will find the devices with
the project-specific settings. Familiarize yourself with the project and the device settings before you execute
the next steps.
Take the following procedure as your guide:
² Install the DIGSI 5 operating program on your PC/laptop. For commissioning, Siemens recommends the

DIGSI 5 variant Premium.

² Accept the project from the engineering department and save it.

² Open the project and the devices in it.

² Check whether inconsistencies are shown. DIGSI 5 constantly performs a consistency check. If inconsis-
tencies are detected, the corresponding position in the operating program is marked. If this is the case,
clarify the cause.

² Look into device-specific parameterization. Use the sequence described below as your guide.
Procedure for checking device parameterization:
² Check whether the parameterized hardware coincides with the existing devices. In the project, click

Devices and networks.

² If you communicate via Ethernet, check the correct setting of the IP addresses simultaneously. You can
also do these checks under Device.

² If the project is an IEC 61850 system, go to menu item IEC 61850 GOOSE Communication to familiarize
yourself with the respective circuitry. If you use circuiting you can view the static reports on the systems
control.

² Create an overview of the settings or the routing in the individual menu items. Siemens recommends
doing this when opening the device in DIGSI.

Initializing device and verifying basic status

SIPROTEC 5 devices are initialized via the front USB interface. Alternatively, you can initialize
SIPROTEC 5 devices via port J. If you connect port J to a network, you must change the default IP address.
² Connect the device to the corresponding USB interface of your computer.

² In the DIGSI 5 operating program right-click on the device to be initialized.

² Click on the Load Configuration in Device menu item.
DIGSI 5 then accepts the connection to the device and loads the complete parameterization into the device.
This process takes some time.

9.3.2
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[scstartsc-270814-01, 1, --_--]

Figure 9-12 Display during Transmission

Once the transmission is completed, the device executes a reset and is in the startup mode. Once this status is
finished, the display image appears and the green LED (Run) lights up. The red LED (Error) must be off.
The display image contains information about the basic device type, for example, transformer protection, the
firmware version (FW), and the loaded parameterization version. In SIPROTEC 5, this is called Configuration
(CFG).
If a display image is adjusted in the parameterization, then the device switches to this display state after
several seconds. The set display image, for example, the measured-value display, should appear.
If you wish verify the loaded parameterization randomly, you can execute a check through the on-site
operation panel. Log in and follow the menu. Read the user instructions in chapter 5 Using On-Site Operation
Panel.
Alternatively, you can also verify the parameterization with DIGSI 5. To do this, activate the online mode and
establish connection to the device. Then open the settings comparison between the online device and the
offline device in the project.
During the initialization, the serial number of the device is transferred to the offline project. Alternatively you
can also enter the serial number by hand in the offline device.

Testing Readiness for Operation

By carrying out the points in chapter 9.3.3 Initializing device and verifying basic status, the device is ready for
operation. If devices are built into cabinets, additional wiring and communication connections are necessary.
Subsequent checks can be made in preparation for the secondary test. To do this, you can make use of
numerous test aids available in the device, which are described in chapter 9.2 Test Suite Integrated in the
Device.
Siemens recommends the following procedure in this order:
² Testing binary inputs and outputs

Check that the connection from the transmission terminal to the device is correct and the binary inputs
and outputs as well.

² Testing voltage and current inputs
Using multi-phase test equipment, apply the corresponding test quantities and check the results. To do
this, make use of the testing options in the device (see chapter 9.2.2 Testing Current and Voltage Inputs.)
You can also check the measured values directly on the device by calling up the operational measured
values in the respective function group.
You can also read the operating measured values in the operating software DIGSI 5. Under Online Access
Points, open the assigned device. Under the menu item Measurement, you will find a clear presentation
of the operational measured values in the respective function group.
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² Checking communication interfaces
You can also set the state of signals transferred via communication interfaces. This action allows you to
check, for example, the connection to the systems control. In the communication diagnosis, you will find
helpful information, for example, about data traffic on a communication interface.

² Checking time synchronization
The device is synchronized by a maximum of 2 independent time sources. In online mode, first click in
the project tree on Device information then on the tab Time information. The delivered specific values
(UTC) of the 1st and 2nd time source (if available) are shown. The internal time of the device which
results from the time information of the active time source is likewise shown.
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Secondary Tests

Scope of Inspection and Methodology

The secondary test objectives are:

• Checking the transformer burdens, checking the transformer data of the main current and voltage
transformer

• Checking the routing of signals to the most varied targets (binary inputs (BI), binary outputs (BO), LEDs,
and interfaces)

• Checking function charts (CFC) in the device

• Checking the interactions between devices, for example, exchange of information or measured values via
interface

• Checking the correct setting of protection functions and the interaction of protection functions (for
example, circuit-breaker failure protection, automatic reclosing)

• Checking communication with a systems control
You can proceed in different ways depending on problem definition and test objective. To simplify the inspec-
tion effort, the application of test programs of digital test equipment is recommended. During a secondary
test, you do not have to go through all characteristic-curve points. That is the subject matter of an acceptance
test. Focus on characteristic values. These are pickup values, operate times, and the interaction between
functions as well as devices.
In this test you can also make use of integrated test functions and hence reduce the expense on test tech-
nology. Pickup values and the reaction of the protection function can be checked easily with the sequencer
(see chapter 9.2.3 Testing Protection Functions).

! WARNING
Warning of danger from secondary tests
Noncompliance with safety notes can result in death, serious injuries, or considerable material
damage.

² Secondary tests must only be carried out by personnel who are qualified electricians and are familiar
with the commissioning of protection systems, the operation of the system, and with safety regula-
tions and provisions (switching, grounding, etc.).

² Make sure that there are no connections to the primary system during the secondary test.

In the secondary test it is assumed that there are still no connections to the primary system. But if you do this
in the primary system, special safety conditions must be followed.
² Consider that no other measurands are locked in, unless otherwise indicated.

² Consider that the trip and close commands to the circuit breakers are interrupted, unless otherwise
indicated.

² Take note of the general instructions in chapter 9.5 Primary Tests.

Recommendation for Testing of Functions 

Only general recommendations are given in this manual. Please refer to the respective Device manual for the
function-specific instructions to be followed. Remember also that a deviation from the expected functionality
can have its cause in an erroneous test sequence.

9.4

9.4.1
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Testing of Protection Functions

• Before checking, familiarize yourself first with the measuring principle of the protection function in the
Device manual and consider the test recommendations given in the Device manual.

• Perform the tests using multi-phase test equipment since numerous protection functions require a
3-phase system.

• You can test most protection functions using stationary signals. Some protection functions require
transient signals. Typical examples are the testing of protection reaction on power swings (power-swing
blocking in distance protection and out-of-step protection) and the transient effect on transformers. They
generate transient test files with a dynamic network calculation program or these test files are provided
by special test programs.

• If setting values are offered only in percent or per unit, remember that the setting values refer only
to rated quantities of the protected object. Secondary test quantities must be converted using the
transformer ratio.

• Perform the tests successively. Activate only the function that you wish to test. Make use of DIGSI 5
support (see chapter 9.2.3 Testing Protection Functions).

• Since protection functions can be assigned to different protection function groups, check the interaction
between function groups as well. If you have created your own application template or modified the
delivered template, Siemens recommends that you check the interaction. The application templates
provided with the device have been tested.

• Check the reaction of the protection functions via the indications in the corresponding logs. The indica-
tions in the spontaneous indication log (available in online mode), which are shown at the moment of
occurrence, are a good tool. Testing using the fault record (binary signal traces in relation to the input
variables) is also advisable for transient processes.

• Check the correct routing of signals of the protection function.

• Check individual protection functions in the test editor using signals from test equipment or the internal
signal generator (sequences). Examine the test sequence in the characteristic curve of the protection
function and its spontaneous indications.

Checking Function Charts (CFC)

• Created logics (function charts) must be tested. A working relationship with the engineering department
is necessary for this purpose. Familiarize yourself first with the objective of the function chart. DIGSI 5
offers you a tracing function during offline operation. This allows you to verify the correct logical
sequence by loading the function chart with test sequences and following the reaction in the function
chart. Switchgear interlockings and other logic can be tested easily with it.

• If the logic reacts to transient changes, you must perform dynamic tests. To do this, generate the neces-
sary test sequences and load them into the device. You can then provide inputs or outputs for tracing
in the function chart. The exact temporal sequence of signals is then logged in a fault record during the
progress of the test sequence. This can be analyzed, for example, using SIGRA and the runtimes and time
differences analyzed. This is a very good way of checking and simultaneously documenting behavior over
time (file export in PDF format).

Checking Control Functions

• Switching of switching devices requires that the switchgear interlockings are properly executed and
that the correct signals are fed to the logic. Perform the corresponding tests. Check the switchgear
interlocking by simulating the corresponding input variables and checking the reaction on the output.

• If you perform on-site control with the device, check the on-site control diagram in devices with large
display. Select the respective switching device and check the different switching operations. Check the
reaction on the outputs.

• In devices with small display, select the switching device (selection via text) and execute the switching
operation as well.
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• Since measured values are also displayed apart from switching devices in the display diagram, check the
proper assignment of measured values by feeding and changing the test quantities.

• Tap changer position commands and control commands for arc-suppression coils can be checked via
DIGSI 5. Check the corresponding relay outputs and feedbacks via binary inputs or communication
interfaces.

Testing Interfaces in the Compound System

Besides binary inputs and outputs, communication between devices occurs via serial communication inter-
faces. Test instructions are hereinafter given for the following applications:

Protection Communication Between Devices
A typical application is communication between line differential protection devices. The main protection
function is differential protection which requires a functioning data connection between devices. Please refer
to the Device manual for checking the Differential protection function.
A 2nd application is communication between devices by transferring binary signal and measured values (for
example, remotely from the opposite end). You generate test signals with the communication test by setting
signals to be transmitted systematically in the transmitter and checking their receipt. Please refer to the
chapter Protection Interface in the Device manual for the necessary test items.

GOOSE Communication Between Devices
GOOSE communication is possible only with the IEC 61850 protocol. Check whether the interfaces and
switches are parameterized properly. Familiarize yourself with the information that is to be transmitted
via GOOSE (Generic Object Oriented Substation Event). Using external test programs such as the GOOSE
Inspector, you can automatically check all GOOSE connections configured in the SCD file. In the event of
missing connections, check the GOOSE parameterization of the transmitting device.

Communication Between Device and Control Center
Various protocols are available to you for communicating with a control center (station or network control
center). Besides DNP3 and IEC 60870-5-103, the IEC 61850 protocol has emerged as the leading protocol.
The test requires the exchange of parameterizations between the protection device and the systems and
control device. Test telegrams for the communication interfaces can be created using the editor described in
9.2.4 Creating Signals for Communication Interfaces. When setting states in the device, the corresponding
telegrams are sent via all existing systems and control protocols.
The test sequencer can be another test source (see chapter 9.2.3 Testing Protection Functions). You can bring
a protection function systematically towards pickup and release using the test sequencer. A fault record is
also simultaneously created during the process. In the systems control, check, for example, that the correct
indications are coming and the fault record was correctly received. In case of a longer sequence you can
also verify the measured values. In addition, check communication in the direction of the device. If switching
commands are controlled by the systems control, check proper execution.

9.4.3
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Primary Tests

Testing System Integration

A requirement for the primary test is that prior tests (chapter 9.3 Initial Startup and 9.4 Secondary Tests) have
been completed successfully. Take note of the following before starting the test:

General Notes

! DANGER
Danger due to hazardous voltages during the operation of electric devices
Noncompliance with the safety notes will result in death or severe injuries.

² Only electrically qualified personnel may work on these devices. The electrically qualified personnel
must be thoroughly familiar with pertinent safety regulations and precautionary measures as well as
the warnings in this manual.

! WARNING
Warning of hazards due to improper primary tests
Noncompliance with the safety notes can result in death, serious injuries, or considerable material
damage.

² Primary trials may be performed only by qualified electricians who are familiar with the commis-
sioning of protection systems, the operation of the system and safety regulations and provisions
(switching, grounding, etc.).

You must perform switching operations for the commissioning. The described tests require that they can be
done without danger. They have not been conceived for operational checks.
You must follow pertinent safety regulations (VDE 105-100/A1, BGV A3/VBG 4).
Before starting work you must take note of the 5 safety regulations:

• Isolate from the power supply

• Safeguard against reclosing

• Establish zero potential

• Ground and short-circuit

• Cover or cordon off neighboring live parts

9.5

9.5.1
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! CAUTION
You must ground the device at the protective grounding terminal before making the connections. There
may be hazardous voltages in all switching components linked to the power supply and to measurand or
test quantities. There may be hazardous voltages in the device (capacitor storage of the current supply)
even after disconnecting the supply voltage.
Noncompliance with the safety notes will result in death or severe injuries.

² To reach the defined initial conditions after switching off the auxiliary voltage, wait at least 10 s
before restarting the auxiliary voltage.

² Do not exceed the limiting values indicated under Technical Data of the Device manuals, even during
testing and commissioning.

! DANGER
Hazardous voltages during breaks in secondary circuits of current transformers
Noncompliance with the safety notes will result in death or severe injuries.

² Short-circuit the secondary connections of the current transformer before the electrical lines to the
device are disconnected.

² If there is a test switch which short-circuits the current-transformer secondary line automatically, it
is sufficient to set this switch to the Test position, provided you checked the short-circuiting device
beforehand.

NOTICE
Pay attention when wiring the safety cabinet to the system
Noncompliance with the safety notes will result in material damage.

² Before the 1st test, wire the safety cabinet to the system. You must check the wiring of the connec-
tions to the primary system.

² Test all connections, including the polarity of transformers. In voltage transformers with broken-delta
winding make sure that they are not short-circuited.

² Activate the auxiliary voltage of the device.

² Establish an online connection to the device. You can verify the signals at the binary inputs under the
Test suite → Wiring menu item.

² Compare the entries under Binary inputs, Binary outputs and LEDs with the system status.

² Check whether signaling contacts are connected to the correct binary input.

² Check the proper functioning of the voltage-transformer circuit breaker and the wiring on the corre-
sponding binary input.

² Check the correct wiring of blocking and release inputs.

² Click the Binary outputs menu item and check the status of the entries. Apart from those in closed
circuits, the contacts are open.

² To check the connection to the switching device, activate a specific binary output. Proceed very carefully
here.
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ii NOTE
Before you perform this test, make sure that the respective system part is isolated and a switching opera-
tion can be executed safely.

² Check the feedback once you have activated the switching device.

² In the menu, go to Test-suite → Analog inputs and check the voltage and current inputs. The relevant
measurands must have the value 0 in the de-energized switch position.

² Using test equipment parallel to the transformers, feed stationary test quantities.

² Check the measured values. Take note of the absolute value and phase as well as the correct phase
sequence.

ii NOTE
If additional signals such as from a substation automation technology are coupled, perform the corre-
sponding tests (see chapter 9.4 Secondary Tests).

Methodical Procedure for Primary Tests of Functions

The scope of primary tests depends on the type of system. To check proper system integration, various
primary tests are performed in power plant systems. The generator delivers the necessary test quantities
based on the operating mode. Refer to the Device manual for generator protection for details.
The scope of inspection is much smaller in power system protection applications. It boils down to a direction
check in the broadest sense. Differential protection tends towards overfunction if there is a sensitive setting
and a wiring error. Each function can be switched to a special mode to avoid unnecessary activation of the
circuit breakers. It is ready to function but the trip command is not switched further (see Function descriptions
in the Device manual). In the desired function, switch the Mode parameter to Test. The trip signal is supplied
with a test bit. The tripping contacts in the device are not activated so the circuit breaker is not actuated by the
protection.
If you enter this setting for the differential protection, make sure that at least one overcurrent protection
is active as backup protection. Once all preparatory measures are complete, you can begin with the actual
primary test.
² First check that you can produce a non-critical switch position and that you have a specific power flow.

The possible load current must be greater than 10 % of the rated load. Avoid a maximum load.

² Activate the circuit breaker (for example, with a synchrocheck).

² Check the measured values.

² In online mode, open the Editor Test suite → Analog inputs.

² Check the phasor values of the measuring points in terms of plausibility (amount, phase and phase
sequence).

² Check the phase displacement of the current and voltage phasors with each other.

² Check the operational measured values per function group.

² Check the direction indirectly via the measured values for active and reactive power (Operational indica-
tions tab.) If the power flow is to the protected object (for example, line) and an ohmic inductive load
is assumed, the active and reactive power must assume positive values. The size of the measured values
determines the current load. If 2 protection devices are connected, both must show the same value.

² Click the Fund. comp./sym. comp. tab.

² You can verify the direction of rotation using positive-sequence and negative-sequence system quanti-
ties. The negative-sequence system quantities must be 0.

² If deviations arise during the tests, check the selected settings (for example, current transformer neutral
point, phase sequence, etc.) and the interface in a 2nd step.

9.5.2

Commissioning
9.5 Primary Tests

SIPROTEC 5, Operation, Manual 253
C53000-G5040-C003-L, Edition 03.2023



ii NOTE
Using wiring modifications, switch the primary system to the de-energized state.

You can do tests specific to protection functions via the operational measured values.
² To do this, click the Functional meas. values tab. In a differential protection function, the differential

currents must be 0 and the corresponding restraint current available.

² Click Test suite → Protection functions.

² In the function group, select the protection function and you will get a graphic display. Apart from the set
characteristics, you see the functions relevant to protection.

To be 100 % sure about the direction setting in a directional overcurrent protection, make use of the test
functionality integrated in the protection function.
² Activate the binary input signal >Direction test, and the protection function switches to test mode.

² Analyze the indication behavior of the protection function according to the selected setting.

² Deactivate the test mode by terminating the binary input signal again.
With active protection you can continue the testing of the switching devices.
² Check the on and off switching of the circuit breaker.

² With the circuit breaker switched off, check the activation of disconnectors and the corresponding
interlocking mechanisms.

Testing Measured Values During Operation

Checking the operational measured values for plausibility is a simplified test of components of the primary
system (transformer, wiring) and of secondary equipment (measured-value acquisition including measured-
value processing). You can set a default display in the device display that also contains the measured values.
Several measured-value windows are preadjustable and can be further switched if needed. Check these
measured values for plausibility.
² If you wish to check measured values more precisely, follow the device menu and navigate to the

corresponding measured values.

² Alternatively, you can set parameters for a function key so that directly jumping to the desired menu is
possible.

Online operation with DIGSI 5 provides a good complete overview. You will find the relevant measured values
in Measurements for the respective function group. If there is a communication connection to systems
control, measured values that the operational crew can verify are also transmitted here.

9.5.3
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Execute Checks

General Information

No special maintenance is required for SIPROTEC 5 devices. The only maintenance measure is to replace
batteries.

ii NOTE
Only use an insulated tool for opening and closing the battery cover, as well as for removing and inserting
the battery.

ii NOTE
To avoid data loss, Siemens recommends replacing the device battery with the device supply voltage
switched on.

All measurement and signal-processing circuits are designed full-static. All input modules are also static, and
the binary outputs are equipped with protective covers.
Since the device is mainly self-monitoring, hardware and software errors are automatically forwarded. This
action minimizes any downtime of the device. It also eliminates the need for frequent maintenance inspec-
tions.

Repeat test
A routine test of characteristics or pickup values is unnecessary since this is part of the continuously monitored
firmware programs. As long as you make no changes in the pickup values or characteristics, a test is not
necessary.
Use the specified maintenance intervals to check and maintain the system and check the protection and
control devices. The primary purpose of maintenance is to check the interfaces of the SIPROTEC 5 device, that
is, the coupling to the system.
If you discover a failure, follow the instructions in the corresponding chapters for failure search or call the
Siemens hotline.

Protection-Function Test

General

ii NOTE
When performing a protection-function test, make sure that it does not lead to any undesired tripping.
Likewise no information must be transmitted to a higher-level systems control where the operator may
incorrectly interpret it.

² Make sure that the green RUN LED on the front cover lights up and not the red ERROR LED. This is
how the device indicates that it is properly functioning and that no failures have been observed during
self-monitoring.

² Make sure that the LEDs on the front cover present a plausible image of the actual state of the device.
If, for example, the tripping of a protection function is saved as an LED display, the device has fault
indications and a fault record for this purpose.

² Press the LED test key. All LEDs apart from the red ERROR LED light up. Stored LED displays are reset and
only those states currently indicated by the device are shown.

10.1

10.1.1
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² Read the operational measured values and compare them to the actual measurands to control the analog
inputs. To do this, enter a reference quantity into the device using secondary test equipment. This is how
you check the proper operation of the analog section of devices.

² Read the operational indications. You can do this directly on the device or following a clearly arranged
procedure using the DIGSI 5. Make sure that they do not contain inputs about failures of the device, of
measurands or other implausible information.

² If the protection equipment has picked up or disabled an error, you can verify this through the fault
record and the fault log. This is how the protection equipment demonstrates its correct operation in the
operating state. Additional protection-function tests can be omitted.

ii NOTE
The system operator is responsible for further protection-function tests within maintenance intervals.
Check protection functions using secondary test equipment or the integrated test sequencer (see chapter
9 Commissioning).
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Error Search and Correction

Troubleshooting

Procedure
If the device indicated an error, then Siemens recommends that you proceed as follows:
If no LED on the operation panel of the device lights up, then verify as follows:
² Check whether the auxiliary voltage on the corresponding connections has an adequate amount and

correct polarity. You will find information about this in the overview plans in the appendix of the Device
manual.

² If the device shows a failure via the red ErrorLED, look for the cause of the failure in the operational log.
You can do this directly on the device or with DIGSI 5.

² If the Fallback Mode display appears in the device display, then reinitialize the device through DIGSI 5.
Look for the cause in the device-diagnosis log first. If a connection to the network cannot be established,
initialization takes place via the USB interface on the device together with DIGSI 5.

² If the confirmation ID is queried, enter it for the device initialization.
The display first disappears in the device display. After successful initialization, the LEDs again indicate normal
operation and the default display goes back into the display. If the device-specific setting values were saved in
the PC during commissioning, they are again loaded into the device.
The device is ready for operation.

Additional Support
If these measures do not lead to the desired result, the Support team will help you.
² Keep the device serial number to hand for the Support team.

² Read the version of the installed firmware.

² Read the device-diagnosis log of your SIPROTEC 5 device with DIGSI 5 so that the support employee has
all the necessary information.

If a Support worker is on site, he has the option of configuring the device with special software for further
analysis of an existing problem. A signed start-up file is loaded onto the device by the employee. For this,
a firmware version of the ≥ V07.50 device is required. When correction of defects is complete, the correct
configuration is established and the device continues to run normally.

Read the Device Data via the Operation Panel

² With a device ready for operation, select Main menu → Test & Diagnosis → Device information.

[scdevinf-080413-01.tif, 1, en_US]

Figure 10-1 Reading Device Information
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Reading the Device Data Using DIGSI 5

² Select the device in the project tree.

² Double-click Device information in the project tree.
In the Device information tab, you can find the data on your SIPROTEC 5 device.

[scgerdia-230816-01, 1, en_US]

Figure 10-2 Reading Device Information

² Click the Log tab.

² Read other logs such as the Device diagnosis log.

Measures for Error Correction

Limit work on the hardware to the necessary extent.

ii NOTE
Defective modules can be replaced only by experienced persons. Never open modules yourself.

The following software measures are possible:

• Initializing the system

• If, for example, you would like to set a supervision function so that it becomes more insensitive since it is
responding sporadically in the operating state, change the parameterization.

ii NOTE
If these measures do not lead to the desired result, avoid further measures during operation.

Fallback Mode

If an error is detected in the device that cannot automatically be cleared (hardware components, software or
parameters), the device switches automatically into fallback mode. This can appear in system start or during
operation of the device. The fallback mode allows you a minimum procedure with error diagnosis and error
correction.
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ii NOTE
Ensure that the protection and control functions are deactivated in fallback mode.

Fallback mode is evident from the termination of the life contact, the Error LED, and the Fallback mode
header in the device display. In this mode, the outputs of the device are brought to their initial state. Access to
the hardware is impossible. A limited operating menu is available for further actions.

Fallback Mode
You can select various information areas and have them displayed in the Fallback mode. The reason for the
fallback is shown in the lower part of the display as an indication (1 in Figure 10-3). When selecting the
softkey <More> on the right-hand side, a list of entries is displayed that was generated during the diagnosis
of the device (2 in Figure 10-3). Use the navigation keys to select the relevant entry or use the softkey
<Details> to open the currently selected entry. Precise information about the fallback will be displayed (3 in
Figure 10-3).

[scfbmenudet-030914-01, 1, en_US]

Figure 10-3 Start Menu of Fallback Mode

The menu items are summarized and briefly presented in the following sections.

Fallback Mode Submenus
You can use the navigation keys to select the individual menu items and branch them into the submenus.
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[scmbfb5ein-030914-01, 1, en_US]

Figure 10-4 Structure of the Fallback Submenu

• Device information
The menu item Device information provides data about the SIPROTEC 5 device, for example, device
name, serial number, device type, and product key.

• Hardware/software information
The HW/SW information menu item offers you additional information about the hardware and software
of the device (see Structure of the HW/SW Information Menu Item, Page 261).

• Log
Information about the entries in the logs is available via the Logs menu item. This entry provides you
with all the information from the diagnostics, security, and system start memory and you can display the
history.

• Actions
By selecting the menu item Actions and clicking Restart Device, you can restart the device.

• IP configuration
During operation or commissioning, the IP Configuration menu offers you system information, for
example the MAC or IP address of the device.
With the softkey <Change>, you can change the IP address, Subnet mask, and Default Gateway
IP Addr in the submenus of the IP-configuration entries.

Structure of the HW/SW Information Menu Item
At this point, the submenu items HW/SW Informat. are explained in more detail.
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[schwswfb-020914-01, 3, en_US]

Figure 10-5 Menu Items for HW/SW Information

• Mainboard
This menu item informs you about the board type and the details concerning the version of the main-
board.

• Communication
The menu item Communication displays information about the assignment of the communication ports
and their hardware information, for example, slot, version, and board type.

• I/O modules
A list of the input/output modules being used can be found under the menu item I/O Modules. You
can select each individual printed circuit board assembly and, for example, have the slot or the terminal
position displayed.
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• Transformer modules
If using transformer modules, this menu item displays all available information about these modules (for
example, slot, board type or serial number)

Fatal Error, the Device Goes into the Fallback Mode
Certain fatal device errors lead to the device falling immediately into the fallback mode. Fatal device errors are
errors that cannot be resolved by a restart of the device. An indication displays the type of error. From this,
you can derive additional steps (for example, contacting the repair department). The device goes permanently
out of operation, a failure is avoided. In fallback mode, minimal operation of the device via the on-site
operation panel and DIGSI 5 is possible. In this way, you can still read information from the diagnostic log, for
example.
Life contact is terminated in fallback mode
Red error LED is activated in fallback mode

Group-Warning Indication
Pickup of the following supervisions with entry of the device into the fallback mode does not allow output of
normal supervision indications. The entry of the device into the fallback mode thus also does not lead to the
activation of the group warning indication.

Error Indications

If the SIPROTEC 5 device is outside a normal operating mode (for example, device is in commissioning mode
or in simulation mode), this is shown by an indication. By default this indication is prerouted to LED 16 and
makes the red LED flash.
If you have exited one of the modes incorrectly (for example, by pulling out the DIGSI 5 PC), the red LED
flashes and after 4 hours the Device Ready indication will go.
This function is realized in the SIPROTEC 5 device via a predefined CFC chart. This means that you can change
this behavior in case of doubt. To do this, change or delete the CFC chart.

Overview of Errors
For each error indication on the on-site operation panel, a specific error code is issued additionally (see
Figure 10-3 (2)). This error code is helpful for further analysis by the repair service.
Device-Diagnostic Log
Memory failure (recoverable): Reset initiated.
PCB link failure (non recoverable):

• Check the module configuration and interconnection.
• If the failure remains, contact the repair service.
Binary-output failure at module 1-12:
Contact the repair service.
Hardware failure at module 1-12:
Contact the repair service.
Wrong module 1-12 detected:
Synchronize the hardware configuration of the device with DIGSI.
Wrong plug-in module detected at position E/F/M/N/P:
Synchronize the hardware configuration of the device with DIGSI.
Hardware failure at measuring-transducer module position E/F/M/N/P:
Contact the repair service.
A faulty display configuration was detected:
Synchronize the hardware configuration of the device with DIGSI.
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Device-Diagnostic Log
Offset failure at a measuring input:

• Check for the affected module in the operational log.
• If the failure remains, contact the repair service.
A wrong display type was detected.
Contact the repair service.
CPU failure at base module:
Contact the repair service.
Communication-configuration failure:

• Reload the DIGSI device configuration.
• Update the device firmware or the DIGSI device configuration.
Port E/F/M/N/P: Communication module with incompatible firmware version detected.
Firmware update required.
Clock failure:

• Check time setting first.
• Change the battery if necessary.
• If the failure remains, contact the repair service.
A current terminal is missing.
Check your hardware and the connections!
FPGA hardware failure at the base module:
Contact the repair service.
The device is low on memory. Reduce the number of allocated functions, stages, and/or setting groups in the
configuration.
Configuration error:
The version of one or more functions is incompatible to the used firmware. Load a suitable DIGSI device
configuration.
Failed reading significant feature
Unknown significant feature
Failed reading bay type
Wrong hardware configuration:
Synchronize the hardware configuration of the device with DIGSI.
Unknown bay type
Failed reading disconnector type
Unknown disconnector type
Maximum number of feeder bays exceeded
Maximum number of coupler bays exceeded
Maximum number of coupler bays with 1 CT exceeded
Maximum number of coupler bays with 2 CT exceeded
Maximum number of coupler bays without CT exceeded
Maximum number of bus section bays exceeded
Maximum number of bus zones exceeded
Maximum number of bus zones without measuring system exceeded
Maximum number of disconnectors exceeded
Maximum number of busbar disconnectors exceeded
Maximum number of line disconnectors to busbar exceeded
Maximum number of line disconnectors exceeded
Maximum number of transfer bus disconnectors exceeded
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Device-Diagnostic Log
Maximum number of sectionalizing disconnectors exceeded
Maximum number of level 2 disconnectors exceeded
Maximum number of load breaking switches exceeded
Maximum number of bays exceeded
Auxiliary power-supply failure:
Check the external power supply.
Either 1 busbar disconnector or 1 line disconnector allowed
Maximum number of Busbar DC & Transferbus DC exceeded
Undefined bay type
Undefined disconnector type
At least one Feeder is necessary
Failure of device configuration:
Check the logs for reasons and upload valid configuration into device.
The voltage measured values indicate a failure.
There is no CFC logic available or a negative ID of measuring point is selected for Function block Voltage
measuring-point selection (1ph).
The voltage measured values indicate a failure.
There is no CFC logic available or a negative ID of measuring point is selected for Function block Voltage
measuring-point selection (3ph).
A non-existing voltage measuring point ID is selected for Function block Voltage measuring-point selection
(1ph). Please check your CFC logic.
A non-existing voltage measuring point ID is selected for Function block Voltage measuring-point selection
(3ph). Please check your CFC logic.
Failure in data structure:
Contact the repair service.
Firmware-version failure:

• Update the device firmware.
• If the failure remains, contact the repair service.
Bus link failure:

• Check the connection of the modules.
• Update the device firmware.
• If the failure remains, contact the repair service.
The IEC 61850 protocol could not be started up successfully. Too many protection functions might be
configured leading to a memory leakage problem for protocol data. Protocol health set to alarm. Reduce the
amount of configured protection functions.
Error instantiating a GOOSE control block for subscription. Too many protection functions might be config-
ured leading to a memory leakage problem for protocol data. Protocol health set to alarm. Reduce the
amount of configured protection functions.
Internal power supply failure:
Contact the repair service.
Module update failure:

• Check the module interconnection and carry out the update again.
• If the failure remains, contact the repair service.
Hardware failure:
Contact the repair service.
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Device-Diagnostic Log
A failure could not be solved automatically:

• Check the previous entries of device-diagnosis log.
• If the failure remains, contact the repair service.
Signature failure:
Contact the repair service.
A failure occurred during the device startup:

• Check the previous entries of device-diagnosis log.
• If the failure remains, contact the repair service.
The device firmware could not be started:

• Carry out the update again.
• If the failure remains, contact the repair service.
Internal memory failure: .

• Stored data may be lost.
• Upload the firmware and the configuration again.
• If the failure remains, contact the repair service.
Data transfer time-out:

• Check the connections and repeat the upload.
• If the failure remains, contact the repair service.
Forced Fallback mode by local user.
Arc protection:

• The device hardware does not fit to the DIGSI configuration.
• Correct the configuration in DIGSI 5 and transfer a valid configuration to the device.
The maximum number of sampled measured value channels (SAV) is exceeded.
PQ Flicker does not support more than one Meas. point V-3ph. Route only one Meas. point V-3ph to function
group or remove PQ Flicker
PQ Flicker does not support the selected rated frequency. Use 50 Hz or 60 Hz.
PQ Flicker does not support selected connection type. Change the connection type of the voltage trans-
former.
Device-configuration failure:
The number of signals in a GOOSE dataset/application is too big. Reduce the number of signals in the related
dataset and upload a valid configuration.
Battery failure:
Change the device battery. To avoid data loss, Siemens recommends replacing the device battery with the
device supply voltage switched on.
Function-point violation:
No adequate number of function points. Upload a valid configuration or contact your local sales organization.
Measurement calibration failure:

• Check the affected module in the operational log.
• If the failure remains, contact the repair service.
CPU program-sequence failure:
If the failure remains, contact the repair service.
Time-synchronization masters failed:

• Check the external master clocks first.
• Check the external wiring.
• If the failure remains, contact the repair service.
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Device-Diagnostic Log
CPU overload failure:
If the failure remains, contact the repair service.
CFC failure:
Check your CFC chart in DIGSI for reasons and reload the configuration.
PCB link failure (sporadic):

• Check the module configuration and interconnection.
• If the failure remains, contact the repair service.
The connection to the detached operation panel is disturbed. Check the connection.
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Replace and Return Defective Device

Backup Module

If you cannot correct a defect reported by the device, you can replace this device with a backup device. If
the error is on the base module, only the base module is replaced. Expansion modules belonging to the
device remain at the installation location and are connected to the backup base module. If the error is on an
expansion module, only this expansion module is exchanged.
The backup module must be of the same type as the defective module to be replaced. If you replace the
defective base module, the backup base module is configured with available project data from DIGSI.

Replacing a Device

ii NOTE
If the device comprises a base module and expansion modules, you can exchange the base module as well
as the expansion modules individually for the respective replacement modules.

• Take the device out of operation.

• Remove the wired terminal blocks from the module to be exchanged or alternatively all lines from the
device.

• Remove the device (see chapter 3.1.1 Fitting the Devices).

• If needed, remove the defective base module from the expansion modules.

Installing a Replacement Module

• If needed, assemble the replacement base module with the expansion modules.

• Assemble the device (see chapter 3.1.1 Fitting the Devices.)

• Put the device back into operation (see chapter 9.3.1 Establishing readiness for operation.)

Returning a Device

ii NOTE
If the wired terminals of the defective base module are to remain in the system, fit the defective base
module with the terminals of the replacement module or order replacement terminals.

• Ensure that the devices are either shipped with the original current and voltage terminals or, alternatively
– if the wired terminals are to remain in the system – with the designated transport safety devices.
If there are green single-row voltage terminals, it is irrelevant in terms of transport whether or not they
are plugged in. They do not require any alternative transport safety device.

• Protect the optical interfaces on the communication or arc-protection modules against the ingress of
dust. Use, for example, the protective caps provided in the delivery condition.

• Pack the defective module (base module and expansion module) or the complete device (see chapter
1.1 Unpacking, Repacking, Returning and Storing).

• Return all of the defective module to your Siemens sales partner.

ii NOTE
If the base module is incomplete, for example if terminals are missing, it cannot be taken back.
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Update Firmware and Configuration

General

You can use DIGSI 5 for updating both the configuration and the firmware. No additional tool is necessary for
updating the firmware of the device or the firmware of the communication module. In order to carry out an
update, you must first import the new DIGSI device driver (DDD) into DIGSI 5. You can then update the device
firmware and the configuration. When updating the firmware, use a connection with at least 1 Mbit/s.

Importing and Managing Device Drivers

If you wish to use new functions or if the manufacturer provides an improved version of the firmware, a
firmware update is necessary. The files for the firmware update are digitally signed. This prevents you from
loading the device with any faulty files or firmware that is not suitable for the device.
If you have installed new communication modules in the SIPROTEC 5 device, check the firmware version of the
individual components. You can find up-to-date device drivers and communication protocols (*.DDD, DIGSI
Device Driver) in the Siemens download area.
DIGSI 5 device drivers contain both the firmware and the configuration data.
Siemens recommends performing the firmware update on the device locally. If you wish to start the firmware
update remotely, use a data circuit with a transmission rate of at least 1 Mbit/s.

Step 1

• Download the device drivers or protocol drivers necessary for updating your SIPROTEC 5 device from the
Siemens download area.
http://www.siemens.com/siprotec

• Click the Downloads link on the menu bar.

• Open the overview of download products with the > Enter link.

• Click the link for SIPROTEC 5 and DIGSI 5.

Step 2

• In the SIPROTEC 5 and DIGSI 5 Downloads download area, select the device (for example: 7SL87).

• Select the item Firmware and Device Drivers.

• Select the desired Version (for example: V7.3x).

• Click the device driver link.

• Save the file to any location on your DIGSI 5 PC, for example, C:\temp.

• Select the appropriate protocol driver.

• Save the file to any location on your DIGSI 5 PC, for example, C:\temp.

Step 3

• Start DIGSI 5 on your PC.

• Select the previously saved device driver file (DDD for device and protocol) in DIGSI 5 via the menu item
Tools → Import device drivers.

• In the open window, highlight the devices and/or protocols to be updated.

• Click the Import button.
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[scdddcom-260716-01, 1, en_US]

Figure 10-6 Selecting the Device Drivers

If the process has been completed without errors, the following dialog will appear:

[scsucddd-260716-01, 1, en_US]

Figure 10-7 Import Status

• Click the OK button.
DIGSI 5 will be restarted. You can open an overview of the installed device drivers by using the DIGSI 5
Tools menu with Manage device drivers.
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[scgetrvw-250716-01, 1, en_US]

Figure 10-8 Manage Device Drivers

Concluding Firmware Update

ii NOTE
Before doing a firmware update of your SIPROTEC 5 device or the communication modules, back up the
data and the configuration of the device using DIGSI 5 via Connect device and retrieve data!

ii NOTE
The device will not carry out any functions during the update.
The update can take several minutes and the device can reboot several times. Do not shut off the device
under any conditions during the update.

Proceed as follows to complete the firmware update:

• Click the device in the project tree.

• Open the context menu.

• Select the menu item Load firmware to device.
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[scausfiw-011116-01, 2, en_US]

Figure 10-9 Context Menu for Firmware Update

As an alternative, you can update the firmware for all the devices on the network at the same time.

• To do this, double-click in the project tree the menu item Load firmware to devices.

[scmulaus-260716-01, 2, en_US]

Figure 10-10 Menu Item in the Project Tree

The following dialog allows you to select the devices to be updated and their firmware components.
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[scfwupsd-280716-01, 3, en_US]

Figure 10-11 Selecting Firmware Update

• Click the Update button to see the version differences.

• Enter the passwords based on the access protection in use.

• Select the device or the communication module that must be updated.

• Select the desired version in the Scheduled version column.

• Click the Update device(s) button.

• Confirm the subsequent dialog with Yes if you would like to continue with the firmware update.

[sc_fw_req, 1, en_US]

Figure 10-12 Firmware-Update Prompt

The firmware update is performed.

[sc_transferfw, 1, en_US]

Figure 10-13 Firmware Transmissions

After the successful transmission of data to the device, the firmware update starts automatically on the
SIPROTEC 5 device.

Maintenance, On-the-Spot Assistance and Test
10.4 Update Firmware and Configuration

SIPROTEC 5, Operation, Manual 273
C53000-G5040-C003-L, Edition 03.2023



[scfwdvlo-280716-01, 1, en_US]

Figure 10-14 Status of Firmware Update

After the firmware update of the device and the communication modules, all firmware components of the
device have been updated.
You can find more information on this in Structure of the HW/SW Information Menu Item, Page 261.

Special Features when Handling Protocols

The firmware for the communication modules consists of the basic firmware and all available protocols. The
communication drivers depend on the device firmware and must be updated together with this firmware.
When you set parameters for a protocol in DIGSI 5 and when you load the configuration into the device, the
protocol firmware is loaded automatically in the device if necessary.

Upgrading Project Devices

To be able to use the extended functionality after a firmware update, you must perform an upgrade of the
project devices. Proceed as follows:

ii NOTE
Before doing an update, back up the configuration of your SIPROTEC 5 device using DIGSI 5 via Connect
device and retrieve data!

• Start DIGSI 5 on your PC.

• In the project tree, select Upgrade project devices.

[scupgpar-041016-01, 3, en_US]

Figure 10-15 Menu Item in the Project Tree
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• Select one or more devices.

• Mark the configuration or communication version that you wish to update.

• Select the desired version in the Scheduled version column.

[scupgcnf-290716-01, 2, en_US]

Figure 10-16 Version Selection

• To start the update, click the Update device(s) button.
DIGSI 5 starts updating.

[scaktolf-290716-01, 2, en_US]

Figure 10-17 Upgrade Progress

Once the procedure has completed, the following dialog appears:

[sc_aktfin-081019, 1, en_US]

Figure 10-18 Upgrade Finished

The Upgrade status column shows the history of the upgrade.

[sc_aktstatus-081019, 1, en_US]

Figure 10-19 Versions and Update Status
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Loading the Updated Configuration
Finally, you must load the updated configuration in the devices. There are 2 possibilities to do this.
To update multiple devices, proceed as follows:

• In the project tree, select the Load configuration in devices menu item.

• Select the devices that are to be updated.

[sc_upgpa3-041119, 1, en_US]

Figure 10-20 Loading Configuration

• As needed, enter a confirmation ID or additional passwords in the columns provided.

• Click Update device(s).
If the data has been successfully transferred, the devices restart.
- or -
To update a device, proceed as follows:

• Select the device in the project tree.

• Open the context menu.

• Select the Load configuration to device menu item.
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[sc_upgpa2-040718, 2, en_US]

Figure 10-21 Transmitting Configuration

Subsequently the dialog for the confirmation query appears.

• Enter the confirmation ID.

• Click Ok to confirm.
If the data was successfully transmitted, the device is restarted.
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Test and Diagnostics

Establishing Test Mode

Safety Instructions

! DANGER
Danger due to the execution of test functions
Noncompliance with safety instructions will result in death, serious injury, or significant material
damage.

² The execution of test functions requires a high degree of qualification and precise know-how of
system conditions.

Procedure
DIGSI 5 offers the possibility to start different test and diagnostic functions for a SIPROTEC 5 device in the
Online operating mode. Chapter 9.2.1 Test Functions contains a description of the test functions offered by
the device together with DIGSI 5.
Activate the test functions using the menu bar and the different functions that you can reach via the list view
of the device.
² Open the device in Online operating mode.

² Open Test suite in the project tree.

[sc_tstsut-040718, 1, en_US]

Figure 10-22 Test Suite

All subordinate test options appear in the data window. Select the desired test editor and start the test.
If configured, enter the confirmation ID. In some test functions the device switches to an operating mode
that first requires a system start of the device. Confirm this with DIGSI 5. The selected test function is then
available.

10.5

10.5.1
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10.5 Test and Diagnostics

278 SIPROTEC 5, Operation, Manual
C53000-G5040-C003-L, Edition 03.2023



ii NOTE
Depending on the device layout, not all test functions are always available. The execution of test functions
is protected by a confirmation ID.

Switching the Simulation Mode On and Off

Procedure
If the simulation mode is switched on, indications transmitted via communication interfaces are labeled with
an additional test bit, provided this is supported by the protocol. With this test bit, you can determine whether
an indication is generated in a test, and all or individual functions of the device are in simulation mode. In this
way, the reactions necessary in process mode due to an indication can be suppressed in other devices that
receive these indications.

• If you have activated a confirmation ID or access control, these are requested by DIGSI 5 before the start
of simulation mode.

• You can activate the simulation mode via DIGSI 5. All functions go into the test mode.

• You can bring selected functions into the test state. DIGSI 5 offers test sequences for this purpose.
The test suite shows you all the protection functions in the device with the current states. The state of
a function is tested systematically there, using a test sequence. An activated simulation mode is marked
with a check mark in the menu item.

[sc_setsfk-040718, 1, en_US]

Figure 10-23 Simulation Mode

Switching Block Monitoring Direction On and Off

Procedure
If block monitoring direction is switched on, no indications are output via the system interface(s) of a
SIPROTEC 5 device. Block monitoring direction can be switched on or off depending on the current state.

• Select block monitoring direction via the on-site operation panel.

• Enter the confirmation ID so that block monitoring direction can be activated.

10.5.2

10.5.3

Maintenance, On-the-Spot Assistance and Test
10.5 Test and Diagnostics
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[scblkdir-080413-01.tif, 1, en_US]

Figure 10-24 Block Monitoring Direction at the Device

• Activate block monitoring direction via a binary input.

• Activate block monitoring direction via DIGSI 5.

[scmemspr-081015, 2, en_US]

Figure 10-25 Block Monitoring Direction via DIGSI 5

When switching block monitoring direction on or off, an indication is output in the left area of the status bar.
Bar segments inform you as well about progress of the procedure.

ii NOTE
The settings via the on-site operation, like the binary inputs, have no effect for the DNP3 protocol.
The >Block monitoring dir. signal is supported by the IEC 60870-5-103 protocol only.

Maintenance, On-the-Spot Assistance and Test
10.5 Test and Diagnostics
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Security Design
Due to the increasing integration of bay units in Ethernet-based communication network, you must secure the
communication against internal failures and attacks from outside. The specifications published by the North
American Electric Reliability Council for critical infrastructure protection - NERC-CIP, for short - and the white
paper published by the German Association of Energy and Water Management (BDEW) contain requirements
for the safe operation of devices in critical communications infrastructure. These requirements are addressed
to manufacturers and operators.
Security must be incorporated into the design of devices right from the start. This is implemented consistently
in SIPROTEC 5. Measures in the hardware ensure the secure use of signed files. These are provided to protect
the firmware files and data records of the device. Secure storage of key material on the device makes secure
communication between DIGSI 5 and the device possible. The following items give you a high level of security
when integrating the SIPROTEC 5 device in the network:

• Protection against attacks from the network

• Multi-stage safety concept in the operating state

• Logging of authorized and unauthorized access

• Logging of safety-critical actions
You can switch off unused Ethernet services. If, for example, the RSTP redundancy log is not being used, you
can switch it off using DIGSI 5. This gives a potential attacker no open interfaces and only utilized services are
activated in a network.

[sc_protocol settings, 2, en_US]

Figure 11-1 Switching off Unused Ethernet Protocols Using DIGSI 5

11.1

Security Settings in the Device
11.1 Security Design
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Multi-Level Security Concept
DIGSI 5 offers many useful functions for the configuration and testing of your SIPROTEC 5 devices. Constant
password prompts are not sensible during this phase. During operation, however, the focus is on the reading
of data. Reconfiguration and switching are safety-critical operations. These operations lead to failures in
operation if they are carried out inadvertently or without authorization. After completion of commissioning,
you can activate a multi-level security concept in the device.
Before DIGSI 5 can communicate with the SIPROTEC 5 device via its Ethernet services, the device carries out
secure authentication. Only DIGSI 5 has the authorization for communication with the device. In addition,
a connection password that meets the strict rules of NERC-CIP can be configured. The password is securely
stored in the device. The password must contain upper-case and lower-case letters, digits, and special charac-
ters and must be at least 8 to 24 characters long. It is queried before connection is established. A connection
to the SIPROTEC 5 device cannot be established until the correct password has been entered. You now have
read access.
All write-access rights to the SIPROTEC 5 device such as, for example, changing setting values or switching are
protected by other security prompts, the confirmation IDs. If changes are done via the integrated operation,
these confirmation IDs are queried on the on-site operation panel. The confirmation ID contains only numbers
that you must enter at the on-site operation panel or in DIGSI 5.

ii NOTE
The confirmation IDs are only needed if the role-based access control (RBAC) is not activated in the
SIPROTEC 5 device.

The 3-level security concept consists of secure authentication, the connection password, and other confirma-
tion IDs. This concept provides the highest possible degree of access protection during operation. Even remote
access to devices is protected. You can also use an Ethernet module exclusively for the communication with
DIGSI 5. Access by a substation control network with the unsecured IEC 61850 protocol and remote access
with DIGSI 5 are then carried out via completely separate networks. Even though the SIPROTEC 5 device
communicates with DIGSI 5 via an Ethernet module, communication between DIGSI 5 and the device is
encrypted using tap-proof technology.
Wrong password entries are identified and logged. An alarm can be triggered via a telecontrol connection.
Safety-critical operations are also logged and cannot be deleted in the device. If files on the PC were manipu-
lated by malware (for example, viruses), they cannot be loaded into the device.

ii NOTE
You can find more information about the security settings of the device in the Security Manual (C53000-
H5000-C081).

11.2

Security Settings in the Device
11.2 Multi-Level Security Concept
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Glossary

Chatter blocking
A rapidly intermittent input (for example, due to a relay contact fault) is disconnected after a configurable
supervision time and can thus not generate any further signal changes. The function prevents overloading of
the system when a fault occurs.

Continuous Function Chart
The Continuous Function Chart (CFC) is a programming language. It is used for programmable logic control-
lers. The programming language Continuous Function Chart is not defined in the standard IEC 61131-3, but
represents a common extension of IEC programming environments. CFC is a graphic programming language.
Function blocks are linked to one another. This represents an essential difference from conventional program-
ming languages, where sequences of commands are entered.

Control display
The control display becomes visible for devices with a large display after pressing the CTRL key. The diagram
contains the switching devices to be controlled in the feeder, with status representation. The control display
serves for the bushing of the switching operations. Defining this display is part of the project engineering.

Data window
The right section of the project window visualizes the content of the section selected in the navigation
window. The data window contains for example, indications or measured values of the information lists or the
function selection for parameterization of the device.

DIGSI
Configuration software for SIPROTEC

Double command
Double commands (DPC – Double Point Control) are process outputs which represent 4 process states at 2
outputs: 2 defined states (for example ON/OFF) and 2 undefined states (for example disturbed positions).

DPC
IEC 61850 data type: Double Point Control - double command

Drag and drop
Copying, moving, and linkin function, used in graphic user interfaces. Objects are selected with the mouse,
held and moved from one data area to another.

Function group
Functions are brought together into function groups (FG). The assignment of functions to current and/or
voltage transformers (assignment of functions to measuring points), the information exchange between the
function groups via interfaces as well as the generation of group indications are important for this bringing
together.
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General Interrogation
The state of all process inputs, of the status, and of the fault image are scanned on system startup. This
information is used to update the system-side process image. Likewise, the current process state can be
interrogated after data loss with a general interrogation (GI).

Generic Object-Oriented Substation Event
GOOSE. Protocol of IEC 61850 for communication between bay units.

GOOSE
Generic Object-Oriented Substation Event

Ground
The conductive ground whose electric potential can be set equal to 0 at every point. In the area of grounding
conductors, the ground can have a potential diverging from 0. The term reference ground is also used for this
situation.

Grounding
The grounding is the entirety of all means and measures for grounding.

IEC
International Electrotechnical Commission - International Electrotechnical Standardization Body

IP
Internet Protocol

List view
The right area of the project window displays the names and icons of the objects which are within a container
selected in the tree view. As the visualization is in the form of a list, this area is also referred to as list view.

Metered value
Metered values are a processing function, used to determine the total number of discrete similar events
(counter pulses), for example, as integral over a time span. In the power utility field, electrical energy is often
recorded as a metered value (energy import/delivery, energy transport).

Navigation window
The left area of the project window displays the names and icons of all containers of a project in the form of a
folder tree structure.

Offline
If there is no communication connection between a PC program (for example, configuration program) and a
runtime application (for example, a PC application), the PC program is offline. The PC program executes in
Offline mode.

Online
If there is a communication connection between a PC program (for example configuration program) and a
runtime application (for example a PC application), the PC program is online. The PC program executes in
Online mode.

Parameterization
Comprehensive term for all setting work on the device. You can set parameters for the protection functions
with DIGSI 5 or sometimes also directly on the device.

Glossary
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Parameter set
The parameter set is the entirety of all parameters that can be set for a SIPROTEC device.

PB Client
Process-Bus client. The sampled measured values subscriber is designated as a process-bus client.

Project
Content-wise, a project is the image of a real energy supply system. Graphically, a project is represented as a
number of objects which are integrated in a hierarchical structure. Physically, a project consists of a number of
directories and files containing project data.

RSTP
Rapid-Spanning Tree Protocol

SCD
Substation Configuration Description

Single command
Single commands (SPC – Single Point Control) are process outputs which represent 2 process states (for
instance on/off) at one output.

SIPROTEC
The registered trademark SIPROTEC designates the product family of Siemens protection devices and fault
recorders.

SIPROTEC 5 device
This object type represents a real SIPROTEC device with all the contained setting values and process data.

SPC
IEC 61850 data type: Single Point Control

SPS
IEC 61850 data type: Single Point Status

SPS
Programmable Logic Controller

TCP
Transmission Control Protocol

Time stamp
A time stamp is a value in a defined format. The time stamp assigns a point in time to an event, for example,
in a log file. Time stamps ensure that events can be found again.

UTC
Universal Time Coordinated

Glossary
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Index

A

Acknowledgment
Spontaneous fault display 173
Stored indication 175

Acquisition blocking   228
Activating the battery   20
Adding a device to a project   162
Alarms   137
As-delivered condition   99
Assembly dimensions

Flush-mounting device 36, 67
Surface-mounted devices with integrated on-site
operation panel 50
Surface-mounted version 69
Surface-mounted version of the non-modular
device 57

Assembly Dimensions
Surface-mounted devices with detached on-site
operation panel 61

Authorizations with confirmation ID   231

B

Backup module   268
Battery disposal   17
Battery fault   256
Browser-based user interface   118, 118
Button

Acquisition Blocking 133
Alarms 148
Binary inputs 144
Binary outputs 144
Certificates 149
Date & Time 132
Device 127
DiagLogs 149
Display Pages 137
Fault Recorder 145
Favorite settings 128
Function modes 148
Functional values 142
LEDs 145
Logs 138
Operational measured values 141
Runtime data 139

Settings 128
Statistics 143
Support 151

C

Change Units System   215
Changing confirmation IDs   217
Changing data online   115
Check measured values   254
Checking interfaces   250
Checking readiness for

operation 244
Checking the Rated Data   19
Circuit-breaker test   241
Commissioning mode   99
Communication log   191
Communication with control center   250
Communication-supervision log   193
Confirmation ID   122
Connecting a device   21
Connecting a Device   48, 71
Control device functions   158
Control with

graphic display 226
Small display 227

Control with Function Keys   232
Correction of errors   259

D

Data transmission   113
Date and Time   211
Device diagnosis   241
Device identification via project tree   161
Device information   261
Device mode   99
Device replacement   268
Device-diagnosis log   190
Diagnostic Information   241
DIGSI 5 operating software   108
Display Elements   82

Base Module 82
Expansion Module 82, 89
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Displays   91
Drilling pattern

Flush-mounting device 36, 67
Surface-mounted devices with detached on-site
operation panel 61
Surface-mounted devices with integrated on-site
operation panel 50
Surface-mounted version 69
Surface-mounted version of the non-modular
device 57

E

Electrical inspection   20
Energy Values

setting 201
Energy vVlues

resetting 201
Error indications   263
Establishing a connection to devices   161
Establishing connection via

Ethernet 113
USB 113

F

Fallback Mode   259
Fault definition   205
Fault display

Configuration 172
Spontaneous 172

Fault log   181
Fault recording   205
Fault records

Displaying 206
recording 208
retrieving 116

Fault Records
deleting 208
reading 205
saving and exporting 207

Fault-record channels
Configuration 208
Start criterion 209

Firmware update   269
Flush-mounting device

Fitting 46, 70
Flush-Mounting Device

Extension 24
Function settings   218

G

GOOSE communication   250
Ground-fault log   183
Grounding a Device   48, 71

H

Hardware/software information   261

I

Importing, managing device drivers   269
Incoming inspection   19
Indication display

Spontaneous 172
Indications   166

Displays 169
Read out 166
Reading 166
Reading with DIGSI 168

Initial Startup   234
Initializing a device   112
IP configuration   261

L

Language Selection   215
Lockout   175
Log   178

Configuring 178
Deleting 196
Management 178
Saving 196

M

Maintenance   256
Manual updating   228
Measured values    198
Menu dialogs   97
Menu structure   94
Menu Tree   95
Metered Values   198
Min./Max./Mean Average

resetting 203
Motor-starting log   194
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Notification windows   97

O

Offline area   110, 110
Offline operation   163
On-site operation panel   80

Installing 65
Online area   110
Online mode   110
Online operation   160
Operating Concept   80
Operational log   179
Operator Controls   82

Base Module 82
Compact Device 83
Expansion Module 82, 89

P

Packing   16
Plug-in modules

Fasteners 74
Install 74
Removing 75

Plug-In Modules
Replacement 77

Primary tests   253
Project navigation   108
Protection communication   250
Protection-function test   256

Q

Quality attributes   171

R

Repeat test   256
Restart the device   124
Returning   16
Returning a device   268
Routing   101

S

Secondary Tests   248

Security   119
Security concept   283
Security design   282
Security log   189
Setting a Marker   231
Setting the Contrast   215
Setting-history log   185
Signed File   258
Simulation mode   99
Simulation Mode   237
Spontaneous fault displays   205
Statistical values

resetting 203
Statistical Values

setting 203
Stored indications   174
Storing   16
Surface mounting device with integrated on-site opera-
tion panel

Extension 27
Surface-mounted device with detached on-site operation
panel

Fitting 64
Surface-mounted device with integrated on-site opera-
tion panel

Expanding 28
Surface-mounting device with detached on-site opera-
tion panel

Extension 31
Surface-mounting device with integrated on-site opera-
tion panel

Fitting 58
Switching-device log   182
System control   224

T

Terminal screw
tightenig torque 48, 60, 66, 72

Test Suite   235
Testing

Current and voltage inputs 236
protection functions 237
switching devices 239

Testing of functions   248
Testing readiness for

Operation 246
Testing system integration   251
Timeout   121
Troubleshooting   258

U

Unpacking   16
Upgrade project devices   274

Index

SIPROTEC 5, Operation, Manual 293
C53000-G5040-C003-L, Edition 03.2023



Upgrading Project Devices   274
User Interface   125
User log   187
User-Defined Metered Values

resetting 202
setting 202

Using project   245

V

Verifying basic status   245
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